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General

Foreword

This user's manual introduces the functions and operations of DSS Professional (hereinafter referred
to as "the system" or "the platform").

Safety Instructions

The following signal words might appear in the manual.

Signal Words Meaning

Indicates a high potential hazard which, if not avoided, will result in
DANGER death or serious injury.

Indicates a medium or low potential hazard which, if not avoided,
WARNING could result in slight or moderate injury.

Indicates a potential risk which, if not avoided, could result in
A CAUTION property damage, data loss, reductions in performance, or

unpredictable results.

[::"‘.— TIPS Provides methods to help you solve a problem or save time.

m MOTE Provides additional information as a supplement to the text.

Privacy Protection Notice

As the device user or data controller, you might collect the personal data of others such as their face,
fingerprints, and license plate number. You need to be in compliance with your local privacy
protection laws and regulations to protect the legitimate rights and interests of other people by
implementing measures which include but are not limited: Providing clear and visible identification

to inform people of the existence of the surveillance area and provide required contact information.

About the Manual

The manual is for reference only. Slight differences might be found between the manual and the
product.

We are not liable for losses incurred due to operating the product in ways that are not in
compliance with the manual.

The manual will be updated according to the latest laws and regulations of related jurisdictions.
For detailed information, see the paper user’'s manual, use our CD-ROM, scan the QR code or visit
our official website. The manual is for reference only. Slight differences might be found between
the electronic version and the paper version.

All designs and software are subject to change without prior written notice. Product updates
might result in some differences appearing between the actual product and the manual. Please
contact customer service for the latest program and supplementary documentation.

There might be errors in the print or deviations in the description of the functions, operations
and technical data. If there is any doubt or dispute, we reserve the right of final explanation.
Upgrade the reader software or try other mainstream reader software if the manual (in PDF
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e All trademarks, registered trademarks and company names in the manual are properties of their
respective owners.

e Please visit our website, contact the supplier or customer service if any problems occur while
using the device.

e If there is any uncertainty or controversy, we reserve the right of final explanation.
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Important Safeguards and Warnings

This section introduces content covering the proper handling of the device, hazard prevention, and

prevention of property damage. Read carefully before using the device, and comply with the

guidelines when using it.

Transportation Requirements

A\

Pack the device with packaging provided by its manufacturer or packaging of the same quality
before transporting it.

Avoid heavy stress, violent vibration, and immersion during transportation.

Transport the device under allowed humidity and temperature conditions. Refer to the technical
parameters for requirements on the transporting temperature and humidity of the device.

Storage Requirements

A\

Store the device under allowed humidity and temperature conditions. Refer to the technical
parameters for requirements on the storing temperature and humidity of the device.
Avoid heavy stress, violent vibration, and immersion during storage.

Installation Requirements

A DANGER

Make sure that the power is off when you connect the cables, install or disassemble the device.
For devices with earthing systems, make sure they are grounded to avoid being damaged by
static electricity or induced voltage, and prevent electrocution from occurring.

All installation and operations must conform to local electrical safety regulations.

Use accessories suggested by the manufacturer, and installed by professionals.

Do not block the ventilator of the device, and install the device in a well-ventilated place.

Do not expose the device to heat sources or direct sunlight, such as radiator, heater, stove or
other heating equipment, which is to avoid the risk of fire.

Do not place the device in explosive, humid, dusty, extremely hot or cold sites with corrosive gas,
strong electromagnetic radiation or unstable illumination.

Avoid heavy stress, violent vibration, and immersion during installation.

A WARNING

Safe and stable power supply is a prerequisite for proper operation of the device.

Make sure that the ambient voltage is stable and meet the power supply requirements of the
device.

Prevent the power cord from being trampled or pressed, especially the plug, power socket and
the junction from the device.

For devices that can be powered by multiple supplies, do not connect them to two or more kinds
of power supplies; otherwise, the device might be damaged.
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Refer to the specific user's manual for the power requirements of single device.

A\

It is recommended to use the device with a lightning protector for better lightning-proof effect.

Operation Requirements

A\

A suitable operating environment is the foundation for the device to work properly. Confirm

whether the following conditions have been met before use.

Use the device under allowed humidity and temperature conditions. Refer to the technical
parameters for requirements on the operating temperature and humidity of the device.

Use the device on a stable base.

Do not let any liquid flow into the device to avoid damage to internal components. When liquid
flows into the device, immediately disconnect the power supply, unplug all cables connected to
it, and contact after-sales service.

Do not plug or unplug RS-232, RS-485 and other ports with the power on, otherwise, the ports
will be easily damaged.

Back up data in time during deployment and use, in an effort to avoid data loss caused by
abnormal operation. The company is not liable for data security.

The company is not responsible for damages to the device or other product problems caused by
excessive use or other improper use.

Maintenance Requirements.

A WARNING

Contact professionals for regular inspection and maintenance of the device. Do not disassemble
or dismantle the device without a professional present.
Use accessories suggested by the manufacturer, and maintain the device by professionals.
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1 Overview

1.1 Introduction

Dahua Security System (DSS) Professional is designed for centralized security management. It
enhances hardware performance and provides centralized video monitoring, access control, video
intercom, alarm controller, POS, radar and Al features, such as face recognition, automatic number
plate recognition, and video metadata.

Whether you are a small business with a few cameras, or a global business spread across the globe
with over 20,000 cameras, DSS Professional is the right solution for you. Even if your needs change in
the future, you can easily scale, upgrade or add functionalities to DSS Professional so that your needs
are met. Build your security management system on a solid foundation with DSS Professional.

1.2 Highlights

e Scalable design, easy to grow
With distributed deployment, you can easily expand the supported channels to 20,000 and
central storage capacity to 4 PB. The multi-site function allows you to incorporate multiple DSS
platforms into one, and conveniently show their information on one PC client. You can access live
and recorded videos, real-time and historical events, and more.

e Al-powered applications, proactive security
DSS Professional integrates various Al capabilities that devices have, such as face recognition,
automatic number plate recognition, and video metadata. You will be notified immediately when
the target you are interested in appears, allowing you or security personnel to take necessary
security measures.

e Highly available technology, more stable
With hot standby and N+M redundancy, DSS Professional ensures that your business will not be
interrupted by failed servers.

e Customized services, enhanced competitiveness
We offer services for you to build DSS Professional into your own platform, allowing it to fully suit
your needs and give you a competitive edge in the market.
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2 Installation and Deployment

DSS platform supports standalone deployment, distributed deployment, hot standby, and N+M
deployment, and LAN to WAN mapping.

Standalone Deployment

For projects with a small number of devices, only one DSS server is required.

Figure 2-1 Standalone deployment

Network
Cable

'\%>
DSS

IPC  PTZ Camera PTZ Camera NVR VTO Access Controller

Distributed Deployment

Suitable for medium to larger projects. Sub servers are used to share system load, so that more
devices can be accessed. The sub servers register to the main server, and the main server centrally
manages the sub servers.
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Figure 2-2 Distributed deployment
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Hot Standby

Used with systems that require high stability. The standby server takes over the system when the
active server malfunctions (such as with power-off and network disconnection). You can switch back

to the original active server after it recovers.

Figure 2-3 Hot standby

Network

. Sy, Cable
NS N
DSS Main Server DSS Standby Server
S -
'\/ n\/
DSS Sub Server DSS Sub Server

.. @8 .. .ol

IPC  PTZ Camera PTZ Camera NVR Access Controller IPC  PTZ Camera PTZ Camera NVR VTO Access Controller

N+M

Each sub server has a standby server to maintain stability. When a sub server malfunctions, the
system replaces it with an idle standby server. When the malfunctioning server normalizes, you can
manually switch back to it. If you do not manually switch them, the system will automatically make

the switch if the standby server malfunctions.
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IPC PTZ Camera PTZ Camera NVR

LAN to WAN Mapping

Perform port mapping when:

Access Controller

Figure 2-4 N+M

Network

'\> Cable

DSS Main Server

r\>

DSS Sub Server

. . ¥

IPC  PTZ Camera PTZ Camera NVR V1O

Access Controller

e The server of the platform and devices are on a local area network, and the DSS client in on the
internet. To make sure that the DSS client can access the platform server, you need to map the

platform IP to the Internet.

e The platform is on a local area network, and the devices are on the Internet. If you want to add
devices to the platform through automatic registration, you need to map the IP address and
ports of the platform to the Internet. For devices on the Internet, the platform can add them by

their IP addresses and ports.
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A\

The DSS Server configuration system does not differentiate service LAN ports and WAN ports. Make

sure that the WAN ports and LAN ports are the same.

2.1 Standalone Deployment

2.1.1 Server Requirements

Table 2-1 DSS Pro hardware requirements

configuration

e Hard drive type: 7200 RPM
Enterprise Class HDD 1 TB

e DSS installation directory space:
500 GB

Parameter Hardware Requirement Operating System
e (PU:Intel Xeon Silver 4214
2.2GHz
e RAM:16 GB e Win10-64 bit
e Network card: 4 x Ethernet port @ | ® Windows server 2008
Recommended .
1000 Mbps e Windows server 2012

e Windows server 2016
e Windows server 2019

Minimum
configuration

e CPU:Intel Xeon E-2224
3.4GHz/4core

e RAM:8GB

e Network card: 2 x Ethernet port @
1000 Mbps

e Hard drive type: 7200 RPM
Enterprise Class HDD 1 TB

e DSS installation directory space:
500 GB

Win10-64 bit

|

e Face recognition images, videos, and files cannot be stored on the system disk and DSS

installation disk. We recommend you store these files on network disks.

e For best performance, we recommend adding additional hard drives to store pictures.

2.1.2 Installing DSS

Prerequisites

o You have downloaded the DSS installer from the official website or received it from our sales or

technical support.

® You have prepared a server that meets the hardware requirements mentioned in "2.1.1 Server

Requirements", and the server IP address is configured.
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Procedure
Step1  Double-click the DSS installer &.

|

The name of the installer includes version number and date, confirm before installation.

Figure 2-5 Install DSS server

| have read and agree to the terms of the

Step2 Click Software License Agreement, and then read the agreement,
Step3  Select the check box to accept the agreement, and then click Next.

Figure 2-6 Select a server type

Select server type
e Main Sub

Step4  Select Main from the server type, and then click Next.
Step5 Click Browse, and then select the installation path.
If the Install button is gray, check whether your installation path and space required meet

the requirements. The total space required is displayed on the page.




@hua .
TechNoLoaY User's Manual

|

We do not recommend you install the DSS server on Disk C, because features such as face
recognition require higher disk performance.
Step6 Click Install.

A\

The installation process takes about 4 to 8 minutes. Do not cut off the power or close the
program.

Figure 2-7 Run the DSS server

DSS Express Server has been successfully installed.

Step7 Click Run when the installation finishes.

Figure 2-8 Select the network mode and network card

Config Wizard
step 1: Network Config
® Single NIC Dual NIC

Local IP

Ethernet

s

Step8  Select a network mode and the network card, and then click Next Step.

©=a
Dual NIC will be available if the server has two network cards. This is useful when you need
to access devices on two different network segments.

Step9 Enable or disable TLS1.0 as needed.
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|

TLS 1.0 has known security vulnerabilities. We strongly recommend you disable it to avoid
security risks. If it is disabled, the web page of DSS platform cannot be accessed through
the browser. You need to enable TLS 1.1 and TLS 1.2 in the browser settings to gain access
to the web page.

Step 10 Click Finish.

[

If the available RAM of the server is less than 4 GB, you can only use basic functions related
to video. Ifit is less than 2.5 GB, you cannot use any function.

Related Operations
e To uninstall the platform, log in to the server, go to ".\DSS\DSS Server\Uninstall", double-click
uninst.exe, and then follow the on-screen instructions to uninstall the program.
e To update the system, directly install the new program. The system supports in-place update.
Follow the steps above to install the program.

2.1.3 Configuring Server IP Address

Change the server IP address as you planned. Make sure that the server IP can access the devices in
your system. For details, see the manual of the server.

[

After changing the IP address of the server, you need to update it in the system services. See the
following section.

2.1.4 Managing System Services

View service status, start or stop services, and change service ports.

On the server, double-click !
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Figure 2-9 Service management page

]‘; DSS Server

Service Category

HRS(Plalluim Discuvery 5. Basic Service

REDIS(Dala Cache Sevice)  Basic Seivice
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Status Exception Info Operation
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Table 2-2 Interface description

No.

Function

Description

Service Management

to restart all services.
L]

When starting the platform, if the available memory of the
server does not reach 4 GB, only the basic video services can
be enabled. If the server has less than 2.5 GB of available
memory, no services are available.
e (lick
e C(lick

to stop all services.
to refresh services.

User's manual

User manual.

Language

Switch language.

Security Setting

TLS 1.0 has known security vulnerabilities. We strongly
recommend you disable it to avoid security risks. If it is disabled,
the web page of DSS platform cannot be accessed through the
browser. You need to enable TLS 1.1 and TLS 1.2 in the browser
settings to gain access to the web page.

1. Open Internet Explorer.

2. Click the Tools button at the upper-right corner, and then
select Internet Options.

3. Select the Advanced tab.
Go to the Settings > Security, and then select Use TLS 1.1
and Use TLS 1.2.

5. Click OK.
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No.

Function

Description

Setting

Configure the IP address of the server and IP mapping.

e Setup an IP address for the server so that the platform can
access the network and the devices in it. If the server has
two network cards, you can select Dual NIC mode,
configure two IP addresses, and then the platform will be
able to connect to two networks and access the devices on
each one.

e |[f the platform is in a local network and the devices are on
the internet, or you need to access the platform thatisin a
local network from the Internet, you need to map the IP
address of the platform to a WAN IP address or a domain
name. For details, see "2.5.2 Mapping IP or Domain Name".

About

Software version information.

Minimize

Minimize the page.

Close

Service Status

@l: Services are starting.

: Service is running abnormally
IEEEE: Services are stopping.
B Service is running normally
=R services have stopped.

10

Services

Displays each service and service status. Click to modify
service port number, and then the services will restart
automatically after modification.

11

Download DSS Client

Go to client download page of the DSS client.

2.1.5 Installing and Logging into DSS Client

Install the DSS client before licensing it.

2.1.5.1 Installing DSS Client

You can visit the system through the DSS Client for remote monitoring.

2.1.5.1.1 DSS Client Requirements

To install DSS Client, prepare a computer in accordance with the following requirements.

10
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Table 2-3 Hardware requirements

Parameters

Description

Recommended system
requirements

CPU: Intel Core i5, 64 bits 4 Core Processor
Memory: 8 GB and above

Graphics: NVIDIA® GeForce®GT 730
Network Card: 1000 Mbps

HDD: Make sure that at least 200GB is reserved for the
client.

2.1.5.1.2 Downloading and Installing DSS Client

Step1  Go to https://IP address of the platform in the browser

Step2 Click PC, and then Download.

If you save the program, go to Step3.

If you run the program, go to Step4.

Figure 2-10 Download DSS Client

DSS PC Client

An easy-to-use professional video
surveillance management software.

[N
—+ |+
Nojw

Select installation path.
Click Install.

N
—+ |+
D |[D
o

Double-click the DSS Client program.
Select the check box of | have read and agree to the DSS agreement and then click Next.

System displays the installation progress. It takes about 5 minutes to complete.

2.1.5.2 Logging in to DSS Client

Step1 Double-click |ﬂ13\ on the desktop.

Step2  Select alanguage and user type.

11
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|

If you want to log in using a domain user account, you must import domain users first. For
details, see the user's manualsee "3.3.3 Importing Domain User".
Step3  Enter the IP address and port number of the platform.

On the drop-down list, platforms that are in the same network as your computer will be
shown.

[

If you want to log in to the platform using its domain name, you must link its IP address to
a domain name first. For details, see the user's manualsee "2.5.2 Mapping IP or Domain
Name".

Figure 2-11 Automatically discovered platform

YDSS

Normal User

|

n Remember Password

Auto Login

Step4  Click anywhere else on the page to start initializing the platform.

For first-time login, you will be automatically directed to the initialization process.

If you are not logging in for the first time, enter the IP address, port number of the

platform, username, and password, and then click Login.

1) The default user is system. Enter and confirm the password, and then click Next.
The password must consist of 8 to 32 non-blank characters and contain at least two
types of characters: Uppercase, lowercase, number, and special character (excluding '
" &)

2) Select your security questions and enter their answers, and then click OK.
The client will automatically log in to the platform by using the password you just set.

12
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2.1.5.3 Homepage of DSS Client

Access Managem...

Figure 2-12 Homepage

DeepXplore

>

Management

Parking Lot Intelligent Analysis

Table 2-4 Parameter description

No.

Name

Function

Tab

Displays the names of all tabs that are opened.

13
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No. Name Function

e [ Enable or disable alarm audio.

e [l Displays number of alarms. Click the icon to go to Event
Center.

e C(lick E to view system messages, such as the information
of a device was edited or deleted. The permissions of a user
will determine what messages can be seen. For example, if
user A does not have the permission of device A, then user A
will not get the message when device A is deleted.

e C(lick to connect to other platforms as sites to your

. current platform. You can view certain resources from the
2 System settings . . .
sites. For details, see the user's manualsee "3.5 Connecting to
Multiple Sites".

o [ User information: Click the icon, and then you can log in
to the web page by clicking system IP address, change
password, lock client and log out.

o Click platform IP address to go to the Web page.

¢ Click Change Password to change user password.
¢ Click About to view version information.

¢ Click Sign Out to exit client.

e Click [A to lock client.

e The number of devices in total, offline and online.

3 Overview e The number of total, processed and pending events.

e The client network, CPU and RAM usage.

e Download videos.

e Check local pictures and videos.

e Settings for video, snapshot, video wall, alarm, security and

4 Management shortcut keys.

e View and manage logs.

e View user manual.

e Customize quick HTTP commands. For details, see the user's
manualsee "8.5 Quick Commands".

e [ Application options including monitoring center, access

L management, intelligent analysis and vehicle entrance
5 Applications
control.
e EX: Configuration options.
2.1.6 Licensing

Activate the platform with a trial or paid license the first time you log in to it. Otherwise you cannot

use it. You can upgrade your license for more features and increased capacity.

This section introduces license capacity, how to apply for a license, how to use the license to activate

the platform, and how to renew your license.

14
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2.1.6.1 Applying for a License

Alicense is used to confirm the features and number of channels you purchased. To get a formal
license, contact our sales personnel. To apply for a trial license, visit our website and find DSS Pro,
scroll to the bottom, click Apply, and then follow the instructions.

2.1.6.2 Activating License

LL]
The following images of the page might slightly differ from the actual pages.

2.1.6.2.1 Online Activation

Prerequisites
e You have received your license. If not, see "2.1.6.1 Applying for a License".
A license is used to confirm the features and number of channels you purchased. To get a formal
license, contact our sales personnel. To apply for a trial license, visit our website and find DSS Pro,
and then follow the application instructions.
e The platform server can access the Internet.

Procedure
Step1  Onthe Home page, click EX, and then in System Config, select License.

Step2 Click Online Activate License.
Step3  Select an activation method. Select Normal Active to complete the process. If you

upgraded the system from Express to DSS Pro, and DSS Express has a paid license, then
select Upgrade from Express instead.

Figure 2-13 Select a method
BDSS  atome

9 Online Activate License

DSS Express

Step4  Enteryour new Activation Code.
1. Enter the DSS Pro activation code that you received.
2. If you select Upgrade from Express, enter the original Express activation code or

15
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import the deactivation file.
e Enter the original activation code: Select Enter Activation Code, and then enter the
original activation code.
e Import the deactivation file: Select Import DSS Express Deactivation Code, click
E1 and then select the deactivation file.
Step5 Click Activate Now.
Step6  On the License page, view your license details.

2.1.6.2.2 Offline Activation

Prerequisites
You have received your license. If not, see "2.1.6.1 Applying for a License".
Alicense is used to confirm the features and number of channels you purchased. To get a formal
license, contact our sales personnel. To apply for a trial license, visit our website and find DSS Pro,

and then follow the application instructions.
Procedure

Step1  Onthe Home page, click EX, and then in System Config, select License.
Step2  Click Offline Activate License.

(¥4

—
F

w

Select an activation method. Select Normal Active to complete the process. If you
upgraded the system from Express to DSS Pro, and Express has a paid license, then select
Upgrade from Express instead.

16
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Figure 2-14 Select a method

9 Offline Activate License

@ Mormal Activate

Stepl.

Activation Code:

Failed to get activation code. Please select DS ress deactivation method.

Enter Activation Code he

Export offline license request file:

b page on an Internet-connect PC. Upload the license request file from Step 1.

&

Step4  Enter your new Activation Code.

1. Enter the DSS Pro activation code that you received.

2. If you select Upgrade from Express, enter the original Express activation code or
import the deactivation file.

e Enter the original activation code: Select Enter Activation Code, and then enter the
original activation code.
e Import the deactivation file: Select Import DSS Express Deactivation Code, click
] and then select the deactivation file.
Step5 Click Export to export the license request file.
Step6  Generate license file.

1) Move the request file to a computer with Internet access.

2) On that computer, open the system email that contains your license, and then click the
attached web page address or Click to go to DSS License Management to go to the
license management page.

3) Click Activate License.

4) Click Upload, select the license request file, and then when you are prompted

uploaded successfully, click Activate.

17
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The success page is displayed, where a download prompt is displayed asking you to
save the license activation file.

Figure 2-15 Upload license request file

Activate DSS License

2 DSS License Management

Request File:
L. Upload
The license request file can be exported in DSS software.

License Key:
0000063000400

5) On the success page, click Save to save the file, and then move the file back to the
computer where you exported the license request file.
6) On the Offline Activate License page, click Import, and then follow the on-screen
instructions to import the license activation file.
Step7 On the License page, view your license details.

2.2 Distributed Deployment

2.2.1 Installing Main Server

For details about how to install the main server, see "2.1 Standalone Deployment".

After sub server are deployed, log in to the main server, and then you can view the status of the sub
servers.

2.2.2 Installing Sub Server

This section introduces how to install sub servers and register them to the main server.

Prerequisites
e You have received the DSS installer from our sales or technical support.
e You have prepared a server that meets the requirements mentioned in "2.1.1 Server
Requirements”, and the server IP address is set.

18
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Procedure
Step 1

:

wnv N | N
—+ |+ |+ |+
m | | |D

te

g

Step 7

Step 8

Double-click the DSS installer $.

|

The name of the installer includes version number and date. Please confirm before
installation.

Click agreement, read through the agreement, and then accept it.

Select the agreement check box, and then click Next.

Select Sub for server type, and then click Next.

Click Browse, and then select the installation path.

If the Install button is gray, check whether your installation path and space meet the
requirements. The total space required is displayed on the page.

We recommend you do not install the platform into drive C because features such as face
recognition require higher disk performance.
Click Install.

A

The installation process takes about 5 to 10 minutes. Do not cut off the power or close the
program.
Click Run when the installation finishes.

Figure 2-16 Select network mode and network card

Config Wizard
Network Config
Dual NIC

Local IP

Ethernet

Select a network mode and the network card, and then click Next Step.

19
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@-ﬂ_-“.

Dual NIC will be available if the server has two network cards. This is useful when you need
to access devices on two different network segments.

Figure 2-17 Configure the information of the main server

Config Wizard

Step 1: Select Network Adapter Step 2: Central Server Config

Center IP

ing Port

Step9 Configure the IP address and port of the main server.
Step 10 Click Finish.

|

After successfully installing a sub server, you need log in to the platform of main server to
enable it so that it can work properly. For details, see the user's manualsee "7.1.1
Distributed Deployment".

Related Operations
e To edit service ports, start or stop services, refresh services, view service status or more, see "2.1.4
Managing System Services".
e To uninstall the platform, go to Control Panel > Programs and Features, and then locate DSS
Server. Double-click it, and then uninstall it according to the on-screen instructions.

2.3 Hot Standby

For detailed steps, see DSSReplicatorPlus2.0 Configuration Guide V8.1.1.docx. If you have any
problems, contact technical support.

20
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2.4 N+M

On the main server, enable the sub server, and then create the sub-standby relationship.

Prerequisites
See "2.1 Standalone Deployment" and "2.2 Distributed Deployment" to deploy the servers you need.
The relevant servers have been well deployed.

Procedure
Step1 Loginto the parent DSS client. On the Home page, click > System Deployment.
Step2 Click B
Step3 Click lE to enable the sub servers.
Step4  Configure a standby server.
1) Click & of a sub server.
2) Select Standby Server for Server Type, and then click OK.
Step5 Configure the sub-standby relationship in either of the following ways.

e Go to the Server Configuration page of the sub server to select a standby server.
1. Click [&] of a sub server.
2. On the Select Standby Server(s) section, select one or more standby servers.

Figure 2-18 Select a standby server

9 Server Configuration

3. Click OK.
e Go to the Server Configuration page of the standby server to select a sub server.
1. Click [8 of astandby server.
2. On the Select Sub Server(s) section, select one or more sub servers.
You can click to adjust the priority.
3. Click OK.

2.5 Configuring LAN or WAN

2.5.1 Configuring Router

For the list of the ports that need to be mapped, see "Appendix 1 Service Module Introduction"”.
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Make sure that the WAN ports is consistent with LAN ports.

2.5.2 Mapping IP or Domain Name

If the platform is deployed in a local network, you can map the IP address of the server to a fixed
WAN IP or a domain name, and then log in to the server using the WAN IP or domain name.

The page might vary between the main server and the sub server. This section uses the main server
page as an example.

Step1 Login to DSS server, and then double-click [B.

Step2 Clickthe 21 on the upper-right corner.

Figure 2-19 Setting

Settings

Server IP:

Mapping IP | Domain

Cancel

Step3  Enter afixed WAN IP address or a domain name in the Mapping IP | Domain box, and then
click OK.

1]
If you want to use a domain name, you need to make corresponding configurations on the

domain name server.
Step4  Click OK, and then the services will restart.
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3 Basic Configurations

Configure basic settings of the system functions before using them, including system activation,
organization and device management, user creation, storage and recording planning, and event

rules configuration.

3.1 Preparations

3.1.1 Installing DSS Client

See "2.1.5 Installing and Logging into DSS Client".

3.1.2 Installing Mobile Client

Step1 Enter IP address of the DSS in the browser and then press Enter.
Step2  Click Mobile > Download, and then scan the QR code to download the App.

Figure 3-1 Download App by scanning QR code

DSS Mobile Client

DSS Mobile Client (iPhone & Android Phone)

Application-based | Scalable | Scan QR code to download

@8 Download on App Store

Download -

Mobile

3.2 Managing Resources

Manage system resources such as devices, users, and storage space. You can add organizations and
devices, configure recording plans and retrieval plans, bind resources, and more.

3.2.1 Adding Organization

Classify devices by logical organization for the ease of management. The default organization is

23
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Root. If the parent organization is not specified, newly added devices are attached to Root.

Procedure
Step1 Login to the DSS Client. On the Home page, click £Y, and then in the Basic Config
section, select Device.

Step2 Click
Step Add an organization.

w N

1) Select a parent organization.
2) Click £

Figure 3-2 Add an organization

Organization

¥ i Current Site
£33 test-dms

22 Build3

= VTO

VTH

VTS

22 pyf-1

3) Enter the name of the organization, and then click OK.
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Figure 3-3 Add an organization

9 Create Organization

Parent Org

Root

ization Name:

Remark:

You can also right-click the root organization, and then click Create Organization to
add an organization.

Related Operations

e Change organization name
Right-click the organization, and then click Rename.

e Delete an organization
Organization with devices cannot be deleted.
Select the organization, click [, or right-click an organization and select Delete.

e Change the organization of devices
Select one or more devices, and then click Move To to move them to another organization.

3.2.2 Managing Device

Add devices before you can use them for video monitoring. This section introduces how to add,
initialize, and edit devices and how to change device IP address.

3.2.2.1 Searching for Online Devices

Search for devices on the same network with the platform before you can add them to the platform.
Step1  Login to the DSS Client. On the Home page, click BY, and then in the Basic Config
section, select Device.
Step2 Click &
Step3 Click B
The icon changes to when devices are searched.

w N
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|

o When using the platform for the first time, the platform automatically searches for
devices on the same network segment.

e If not the first time, the platform automatically searches for the devices in the network
segment you configured last time.

Figure 3-4 Search for devices

MAC Address

Step4  Specify IP Segment, and then click Search.

Figure 3-5 IP segment search

3.2.2.2 Initializing Devices

You need to initialize the uninitialized devices before you can add them to the platform.
Step1  Search for devices. For details, see "3.2.2.1 Searching for Online Devices".
Step2  Select an uninitialized device, and then click Initialize.

©=a
e You can select multiple devices to initialize them in batches. Make sure that the
selected devices have the same username, password and email information. The
information of these devices will be the same after initialization, such as password and
email address.
e ClickEl next to Initialization Status to quickly sort out devices in certain status.
Step3  Enter the password, and then click Password Security.
Step4  Enter the email address, and then click Change IP.

The email is used to receive security code for resetting password.
Step5  Enterthe IP address, and then click OK.
When setting IP addresses in batches, the IP addresses increase in an ascending order.
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3.2.2.3 Changing Device IP Address

You can change IP addresses of the devices that have not been added to the platform.
Step1  Search for devices. For details, see "3.2.2.1 Searching for Online Devices".
Step2  Select a device, and then click Change IP.

For devices that have the same username and password, you can select and modify their IP
addresses in batches.

Figure 3-6 Change IP address

(2}
Initialization Status ~ IP Address +  Device Model

DHI

d
]
d
d
i
]
d
d

DH-NVR4432-1

Step3  Enter New IP, Subnet Mask and Gateway, and then click Save.
When setting IP addresses in batches, the IP addresses increase in sequence.
Step4  Enter the username and password used to log in to the devices, and then click OK.

3.2.2.4 Adding Devices

You can add different types of devices, such as encoder, decoder, ANPR device, access control,
displays, emergency assistance device, alarm box, radar device, and video intercom. This section
takes adding an encoder as an example. The configuration pages shown here might be different
from the ones you see for other types of devices.

When you add devices by using automatic registration, IP segment, or importing, some devices will
fail to be added if they exceed the number of devices or channels allowed to be added to the
platform. These devices will be displayed in Devices without License.

3.2.2.4.1 Adding Devices One by One

There are multiple ways you can add devices to the platform, including using domain names, serial
numbers, IP addresses, IP segments, and automatic registration.

Step1 Login to the DSS Client. On the Home page, click EY, and then in the Basic Config
section, select Device.

Step2 Click &

Step3  Click Add.

Step4  Enter device login information, and then click Add.

In the Add Mode drop-down list,
e |P Address: Add a device. We recommend selecting this option when you know the IP
address of the device.

27



@hua .
TechNoLoaY User's Manual

Only Encoder devices support IPv6. If you want to add devices to the platform through
IPv6 addresses, you must first configure an IPv6 address for the platform. Contact
technical support for help.

e IP segment: Add multiple devices in the same segment. We recommend selecting this
option when the login username and password of the multiple devices in the same
segment are the same.

e Domain Name: We recommend selecting this option when the IP address of the device
changes frequently and a domain name is configured for the device.

e Auto Registration: We recommend this method when the IP address of a device might
change. The ID of auto register has to be in accordance with the registered ID
configured on the device you want to add. The port number must be the same on the
platform and on the device. The auto register port is 9500 on the platform by default.
To change the auto register port number, open the configuration tool to change the
port number of DSS_ARS service.

Sleep function is supported for IPCs that use 4G mobile network to communicate and
are solar-powered only when they are added to the platform through automatic
registration.

e P2P: Add devices under the a P2P account to the platform. The platform must be able
to access the P2P server. There is no need to apply for the dynamic domain name of the
device, perform port mapping or deploy a transit server when using it.

|

The parameters vary with the selected protocols.

Figure 3-7 Add an encoder

1.Login Information

Device Caty

Encoder

IP Address:

Username:

admin

Step5 Enter the information.
Step6  Click OK.
o To add more devices, click Continue to add.

e To go to the web manager of a device, click E
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3.2.2.4.2 Adding Devices through Searching

Devices on the same network with the platform server can be added using the automatic search
function.

Step1  Search for devices. For details, see "3.2.2.1 Searching for Online Devices".
Step2  Select adevice, and then click Add to Device List or B

o=

If devices have the same username and password, you can select and add them in batches.

Figure 3-8 Add in batches

MAC Address

o
2

© Initiali

oA

O In

Step3  Select the server and organization, enter username and password, and then click OK.

3.2.2.4.3 Importing Devices
Enter the device information in the template, and then you can add devices in batches.

Prerequisites

You have downloaded the template, and then enter device information in the template.

Figure 3-9 Download template

Organization Root

+ + Add Delete & Import | ¢% Export Move To

ntrol  Video Intercom  ANPR Device eo Wall Control
-
i Root IP Address + Device Name Device Type ¥ Organization

1111 D root

. Import

Total of 29 Re

v

# AddtoD
Procedure
Step1 Login to the DSS Client. On the Home page, click EY, and then in the Basic Config
section, select Device.
Step2 Click &
Step3  Click Import.
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Figure 3-10 Import devices

Import

Support File Extension:

Step4  Click Import File, and then select the completed template.
Step5 Click OK.

3.2.2.5 Editing Devices

Edit the information of devices.

3.2.2.5.1 Changing IP Address

For the devices that have been added to the platform, and their IP addresses have been changed,
you can edit their IP addresses directly on the platform so that they can connect to the platform
normally.

tep1 Loginto the DSS Client. On the Home page, click , and then in the Basic Config

section, select Device.

:

Step2 Click Device Config.
Step3  Click of a device.
Step4  Edit the IP address, and then click OK.

3.2.2.5.2 Modifying Device Information

tep1 Login to the DSS Client. On the Home page, click EY, and then in the Basic Config

section, select Device.

:

Step2 Click B2
Step3  Click of a device, and then edit device information.

Click Get Info and the system will synchronize device information.
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Figure 3-11 Basic information

O All Devices

Step 5

Step 8

Step 9

Click Video Channel, and then configure the channel information, such as the channel
name and channel features.

The types of features vary with different devices. Select features according to the capability
of the camera.

Click the Alarm Input Channel tab, and then configure number, names, and alarm types
of the alarm input channels.

Skip the step when the device do not support alarm input.

e Alarm type includes external alarm, Infrared detect, zone disarm, PIR, gas sensor, smoke
sensor, glass sensor, emergency button, stolen alarm, perimeter and preventer move.

e Alarm type supports custom. Select Customize Alarm Type in the Alarm Type drop-
down list. Click Add to add new alarm type. It supports up to 30 custom alarm types.

Click the Alarm Output Channel tab and then edit the number and names of alarm

output channels.

Click the POS Channel, and then edit the number and names of the POS channels.

This tab will only appear if the device has POS channels.
Click the Audio and Light Channel tab, and then edit the number and names of the audio
and light channels.

This tab will only appear if the device has audio and light channels.
Click OK.

3.2.2.5.3 Modifying Device Organization

You can move a device from an organization node to another one.

Step 1

Step 2

Log in to the DSS Client. On the Home page, click Y, and then in the Basic Config

section, select Device.
Click &
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Step3  Select a device to be moved, click Move To, select the target organization, and then click
OK.

Figure 3-12 Move a device

Organization

Online Status ~  Offline Reason Operation

Offline

]
e
]
e
e
]
]
e

Initialization Status ~  IP Address % Device Model MAC Address Operation

© Initialized PC-NVR 38176 1

3.2.2.5.4 Changing Device Password

You can change device usernames and passwords in batches.
Step1 Login to the DSS Client. On the Home page, click £Y, and then in the Basic Config

section, select Device.

Step2 Click &
Step3  Select a device, and then click Change Password.
w

You can select multiple devices and change their passwords at the same time.

Figure 3-13 Change device password
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Step4  Enter the old and new passwords, and then click OK.

3.2.2.6 Modifying Device Time Zone

Configure device time zone correctly. Otherwise you might fail to search for recorded video.
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[

If a device is accessed through ONVIF and the ONVIF version is earlier than 18.12, the device DST

cannot be edited on the platform. You can only edit manually.

Step1  Login to the DSS Client. On the Home page, click EY, and then in the Basic Config
section, select Device.

Step2 Click B

Step3  Select a device, and then click Time Zone Settings.

Figure 3-14 Modify device time zone
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Step4  Select atime zone.
Step5  Click OK.

3.2.2.7 Exporting Devices

You can export the information (except username and password for login) of all the devices on the
DSS client. When you need to switch or configure a new platform, you can quickly add them all by
importing them, but you need to enter the username and password for login again.

You can export up to 100,000 devices at a time.
Step1 Login to the DSS Client. On the Home page, click EY, and then in the Basic Config
section, select Device.

Step2 Click E&.
Step3  (Optional) Select only the devices that you need.
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Figure 3-15 Select a device type

eo Intercom  ANPR Devic
IP Address Device Name Device Type * atis Online Status > fi Operation
IVsS face Offline

IPC root Offline

L]
L
e
e
w
L
e
e

otal of 20 Record(s)

Step4  Click Export.
Step5  Enter the password used to log in to the DSS client, encryption password, and range, and
then click OK.

[

You can configure whether to verify the password. For details, see "7.3.1 Configuring

Security Parameters".

e The encryption password is used to protect the export file. It consists of 6 uppercase or
lower case letters, numbers, or their combination. You need to enter it when using the
export file.

e You can select All to export all the devices, or Selected to export the devices you
selected.

Step6  Select a path on your PC, and then click Save.

3.2.3 Binding Resources

The platform supports binding resources for linked actions. You can link a video channel with an

alarm input channel, ANPR channel, POS channel, access control channel, lift control channel or

another video channel, so that you can view the associated video for alarm, face and other

businesses.

Step1 Login to the DSS Client. On the Home page, click EY, and then in the Basic Config
section, select Device.

Step2  Click B

Step3  Select a channel, and then click Modify.
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Figure 3-16 Bind channel
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Step4  Select a channel, and then click OK.
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Multiple channels can be selected.

Figure 3-17 Select the channels you want to bind to the camera
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Step5  Click OK.

3.2.4 Adding Recording Plan

Configure recording plans for video channels so that they can record videos accordingly.

You can configure 2 types of recording plans for a channel. One is general recording plan, and a
device will continuously record videos during the defined period. The other is motion detection
recording plan, and a device will only continuously record videos when motion is detected.

3.2.4.1 Adding Recording Plan One by One

Add a center recording plan or device recording plan for a channel, so that it can make general or
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motion detection videos within the defined period.

Procedure
Step1 Login to the DSS Client. On the Home page, click £Y, and then in the Basic Config
section, select Device.

Step2  Click [
Step3  Select a channel, and then configure a recording plan.

e Configure a center recording plan.
1) Click Add Recording Plan next to Center Recording Plan.

Figure 3-18 Add a center recording plan (1)

Al Rule Config Sync People Counting ...

2) Configure the parameters, and then click OK.

Table 3-1 Parameter description

Parameter Description
Enable Turn on or off the recording plan.
Position Videos will be stored on the server by default. It cannot be changed.

e General recording: The device will continuously record videos within

Recording Type the defined periods.

e Motion detection recording: The device will continuously record
videos within the defined periods on motion detections.

Select Main Stream, Sub Stream 1 or Sub Stream 2.

Stream Type Videos recorded on the main stream will have the best quality, but they
require more storage.

Remarks Customizable description for the recording plan.

Select a default time template or click Create Time Template to add a

Recording Time new time template. See "3.2.6 Adding Time Template".

3) Click OK.
e Configure a device recording plan.
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The platform can obtain and display the recording plan that has been configured on
EVS of the latest versions. You can check if recording plan are obtained and displayed
on the page to know if your EVS is of the latest version.

1) Click Add Recording Plan next to Device Recording Plan.

Figure 3-19 Add a device recording plan (1)

Al Rule Config Sync People Counting ...

2) Configure the parameters, and then click OK.

Table 3-2 Parameter description

Parameter Description
Enable Turn on or off the recording plan.
Position Videos will be stored on the device by default. It cannot be changed.
The device will make recordings using the main stream by default. It
Stream Type
cannot be changed.
Remarks Customizable description for the recording plan.

Select a default time template or click Create Time Template to add a

Recording Time new time template. See "3.2.6 Adding Time Template".

Related Operations

e Enable/disable a recording plan
B means that the plan has been enabled. Click the icon and it becomes [, and it means
that the plan has been disabled.

e Click [E): Copy the recording plan to other channels.

e Edit arecording plan
Click of corresponding plan to edit the plan.

e Click [ to delete recording plans one by one.

3.2.4.2 Adding Center Recording Plans in Batches

Add a center recording plan of general or motion detection videos for multiple channels at the same
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time.

3.2.4.2.1 General Recording Plan

Step1 Login to the DSS Client. On the Home page, click EX, and then in the App Config section,
select Storage Plan > Recording Plan.

Figure 3-20 Center recording plan

Organization

Step2 Select General Recording Plan > Add General Recording Plan.
Step3  Configure the parameters, and then click OK.

Table 3-3 Parameter description

Parameter Description
Enable Turn on or off the recording plan.
Position Videos will be stored on the server by default. It cannot be changed.

Select Main Stream, Sub Stream 1 or Sub Stream 2.

Stream Type Videos recorded on the main stream will have the best quality, but they
require more storage.

Remarks Customizable description for the recording plan.

Select a default time template or click Create Time Template to add a

Recording Time new time template. See "3.2.6 Adding Time Template".

Recording Channel | Select the channels you want to add the recording plan for.

Related Operations

e Enable/disable a recording plan
B means that the plan has been enabled. Click the icon and it becomes [l and it means
that the plan has been disabled.

e Edit arecording plan
Click of corresponding plan to edit the plan.

e Edit arecording plan
Click of corresponding plan to edit the plan.

o XX Select multiple channels, and then delete them at the same time.

o LEEH and EEEER: Select multiple channels, and then enable or disable them at the same time.
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3.2.4.2.2 Motion Detection Recording Plan

Step1  Log in to the DSS Client. On the Home page, click Y, and then in the App Config section,
select Storage Plan > Recording Plan.

Figure 3-21 Center recording plan

Organization

rganization

Step2 Select Motion Detection Recording Plan > Add Motion Detection Recording Plan.
Step3  Configure the parameters, and then click OK.

Table 3-4 Parameter description

Parameter Description
Enable Turn on or off the recording plan.
Position Videos will be stored on the server by default. It cannot be changed.

e General recording: The device will continuously record videos within

Recording Type the defined periods.

e Motion detection recording: The device will continuously record
videos within the defined periods on motion detections.

Select Main Stream, Sub Stream 1 or Sub Stream 2.

Stream Type Videos recorded on the main stream will have the best quality, but they
requires more storage.

Remarks Customizable description for the recording plan.

Select a default time template or click Create Time Template to add a

Recording Time new time template. See "3.2.6 Adding Time Template".

Recording Channel | Select the channels you want to add the recording plan for.

Related Operations

e Enable/disable a recording plan
B means that the plan has been enabled. Click the icon and it becomes [, and it means
that the plan has been disabled.

e Edit arecording plan
Click of corresponding plan to edit the plan.

e Editarecording plan
Click of corresponding plan to edit the plan.
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o [EEEEH: Select multiple channels, and then delete them at the same time.
. and EEEEE: Select multiple channels, and then enable or disable them at the same time.

3.2.5 Adding Video Retrieval Plan

Configure a video retrieval plan to upload the videos that devices record when they are
disconnected from the platform. During the defined period, videos will be automatically uploaded
to the platform. The platform supports uploading videos within the past 7 days.

You can add a retrieval plan for each channel one by one, or add one for multiple channels in
batches.

3.2.5.1 Adding Retrieval Plan One by One

Step1 Login to the DSS Client. On the Home page, click £Y, and then in the Basic Config
section, select Device.
Step2  Click .

Figure 3-22 Add a retrieval plan for a channel

Step3  Select a device and then click Add Retrieval Plan.
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Figure 3-23 Add a retrieval plan

9 Recording Retrieval

Schedule:

Step4  Configure the parameters.

Table 3-5 Parameter description

Parameter Description
Enable Turn on or off the retrieval plan.

Select a period, and then the videos within the defined period will
Backup Storage for be uploaded. The platform supports uploading videos from
Retrieval devices within the past 7 days at most. Videos from the current

day will not be included.

Select the stream type of the videos that you want up upload. If
Stream Type the videos are recorded on sub stream 1 and Main Stream is
configured in this retrieval plan, uploading will fail.

Configure when to upload videos every day. Click [&] to

Schedule configure specific periods. You can configure up to 6 periods.

Step5  Click OK.

Related Operations
e Enable/disable retrieval plan
B means that the plan has been enabled. Click the icon and it becomes [, and it means
that the plan has been disabled.
e Edit retrieval plan
Click of corresponding plan to edit the plan.
e Click [ to delete recording plans one by one.

3.2.5.2 Adding Retrieval Plans in Batches

Step1 Login to the DSS Client. On the Home page, click Y, and then in the App Config section,
select Storage Plan > Recording Retrieval > Video Retrieval.
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Figure 3-24 Video retrieval

Organization

n  Backup Storage for Retrieval

Step2 Click Add Video Retrieval Plan.

Figure 3-25 Configure a video retrieval plan
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Step3  Configure the parameters, and then select channels in the Retrieval Channel section.

Table 3-6 Parameter description

Parameter Description
Enable Turn on or off the retrieval plan.

Select a period, and then the videos within the defined period will
Backup Storage for be uploaded. The platform supports uploading videos from
Retrieval devices within the past 7 days at most. Videos from the current

day will not be included.
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Parameter Description

Select the stream type of the videos that you want up upload. If
Stream Type the videos are recorded on sub stream 1 and Main Stream is
configured in this retrieval plan, uploading will fail.

Configure when to upload videos every day. Click [&] to

Schedule configure specific periods. You can configure up to 6 periods.

Step4  Click OK.

e Enable/disable retrieval plan
IBXJ means that the plan has been enabled. Click the icon and it becomes [, and it means
that the plan has been disabled.

e Edit retrieval plan
Click of corresponding plan to edit the plan.

e Click [ to delete recording plans one by one.

EEZ: select multiple plans and delete them in batches.

W Enable

e Select multiple plans and enable or disable them in batches.

3.2.5.3 Adding Retrieval Plan for MPT Devices

Step1 Login to the DSS Client. On the Home page, click EX, and then in the App Config section,
select Storage Plan > Recording Retrieval > File Retrieval.

Figure 3-26 File retrieval

............

Step2 Click Add File Retrieval Plan.
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Figure 3-
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27 Configure a file retrieval plan

Operation

Step3  Configure the parameters, and then select MPT devices in the Retrieval Device section.

Table 3-7 Parameter description

Parameter Description
Enable Turn on or off the retrieval plan.
Select a period, and then the videos within the defined period will
be uploaded. The platform supports uploading videos from
Backup Storage for devices within the past 7 days at most.
Retrieval

|.-.._—_|

Videos from the current day will also be uploaded.

Execute retrieval plan only
when Wi-Fi is connected

When selected, videos on MPT devices will be uploaded only when
they are connected to a Wi-Fi network.

|.-.._—_|

If it is not selected and MPT devices are connected to the mobile
network, uploading videos might result in additional charges.

Time to Execute Plan

Configure when to upload videos every day. Click [&] to configure
specific periods. You can configure up to 6 periods.

Step4 Click OK.

Related Operations
e Enable/disable retrieval plan

B means that the plan has been enabled. Click the icon and it becomes [, and it means
that the plan has been disabled.

e Edit retrieval plan

Click of corresponding plan to edit the plan.
e Click [ to delete recording plans one by one.
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o EEEH: sclect multiple plans and delete them in batches.

[ ] FYalell © Disabie

: Select multiple plans and enable or disable them in batches.

3.2.5.3.1 Adding Retrieval Plans One by One

The procedures are the same as other devices. For details, see "3.2.5.1 Adding Retrieval Plan One by
One".

3.2.5.3.2 Adding Retrieval Plans in Batches

Step1  Log in to the DSS Client. On the Home page, click EY, and then in the App Config section,
select Storage Plan > Recording Retrieval > File Retrieval.

Figure 3-28 File retrieval

Organization

Step2  Click Add File Retrieval Plan.
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Figure 3-
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29 Configure a file retrieval plan

Operation

Step3  Configure the parameters, and then select MPT devices in the Retrieval Device section.

Table 3-8 Parameter description

Parameter Description
Enable Turn on or off the retrieval plan.
Select a period, and then the videos within the defined period will
be uploaded. The platform supports uploading videos from
Backup Storage for devices within the past 7 days at most.
Retrieval

|.-.._—_|

Videos from the current day will also be uploaded.

Execute retrieval plan only
when Wi-Fi is connected

When selected, videos on MPT devices will be uploaded only when
they are connected to a Wi-Fi network.

|.-.._—_|

If it is not selected and MPT devices are connected to the mobile
network, uploading videos might result in additional charges.

Time to Execute Plan

Configure when to upload videos every day. Click [&] to configure
specific periods. You can configure up to 6 periods.

Step4 Click OK.

Related Operations
e Enable/disable retrieval plan

B means that the plan has been enabled. Click the icon and it becomes [, and it means
that the plan has been disabled.

e Edit retrieval plan

Click of corresponding plan to edit the plan.
e Click [ to delete recording plans one by one.
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o EEEH: sclect multiple plans and delete them in batches.

[ ] FYalell © Disabie

: Select multiple plans and enable or disable them in batches.

3.2.6 Adding Time Template

Step1 Login to the DSS Client. On the Home page, click EY, and then in the Basic Config
section, select Device.

Step2  Click .
Step3  Select a channel, and then add a recording plan.
Step4  Inthe Recording Time drop-down list, select Create Time Template.

Creating time template in other pages is the same. This chapter takes creating time
template in Record Plan page as an example.

Figure 3-30 Create time template

Time Template
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o
o
o
o
O
o
o

Sunday:

Step5 Configure name and periods. You can set up to 6 periods in one day.
Select the Copy From check box, and then you can select a template to copy from.
e On the time bar, click and drag to draw the periods. You can also click [==], and then
draw the periods for multiple days.
e You can also click [ to configure periods.
Step6 Click OK.

3.2.7 Configuring Video Retention Period

For videos stored on the platform, you can configure video retention period. When the storage
space runs out, new recorded videos will cover the oldest videos automatically.

Procedure
Step1 Login to the DSS Client. On the Home page, click £Y, and then in the Basic Config
section, select Device.

Step Click [E2.
Step Select a camera, and then click Modify.

w N
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Figure 3-31 Go to recording storage configuration page
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Step4 Click B to enable the storing of different type of video, and then configure the
retention period.
Step5 Click OK.

Related Operations
Enable/disable record plan
In the operation column, B means that the recoding storage configuration has been enabled.
Click the icon and it becomes [l meaning that the configuration has been disabled.

3.2.8 Configuring Events

You need to set up the event configuration on a device or its channels to receive alarms on the

platform.

Step1 Login to the DSS Client. On the Home page, click EY, and then in the Basic Config
section, select Device.

Step2 Click &
Step3  Select a channel or a device, and then click Event Config.

Events that can be configured are different for different types of devices. If you select
Device, you can only configure general events. If you select Channels, various events
supported by different types of channels will be displayed.
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Figure 3-32 Go to the event configuration (device)
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Figure 3-33 Go to the event configuration (channel)

Step4  Configure events. See "4.1 Configuring Events".

3.2.9 Configuring Device Parameters

Configure the camera properties, video stream, snapshot, video overlay, and audio configuration for
the device channel on the platform. The platform only supports configuring the channels added via
IP in Dahua protocols.

[

Device configuration might vary depending on the capacities of the devices. The pages in the
section are for reference only, and might differ from the actual ones.

3.2.9.1 Configuring Camera Properties

Configure camera image parameters for the Daytime, Night, and Regular modes to ensure high
image quality.

3.2.9.1.1 Configuring Property Files

Step1 Login to the DSS Client. On the Home page, click EY, and then in the Basic Config
section, select Device.

Step2  Click &2,

Step3  Select a device, and then click Parameter Setting.
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Figure 3-34 Device configuration

Parameter Setting
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Step4 Select Camera > Camera > Properties > Image.

Figure 3-35 Image
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Defog

Cancel

e To go to the device web page, you can click More configuration.
e PTZ will be displayed if the device has PTZ function.

Table 3-9 PTZ operation

Operation

Icon/Function Description

Arrow keys direction.

Click it and the camera will rotate to the corresponding
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Icon/Function Description

8

Adjust the speed. The higher the value, the faster the camera

rotates.
Zoom in and out.
Bl Adjust the focus level.

o0 Adjust the aperture.

Step5  Select a mode from the drop-down list for Profile Management.
Step6  Click Image to configure image parameters.

Table 3-10 Image parameters

Parameter Description

Style You can set the image style to be Standard, Soft, or Vivid.

You can adjust the overall image brightness through linear tuning. The
Brightness higher the value, the brighter the image and vice versa. If this value is set
too high, images tend to look blurred.

Adjusts the contrast of the images. The higher the value, the bigger the
contrast between the bright and dark portions of an image and vice versa.
Contrast If the contrast value is set too high, the dark portions of an image might
become too dark, and the bright portions might be over-exposed. If the
contrast value is set too low, images tend to look blurry.

Adjusts color shade. The higher the value, the deeper the color and vice

Saturation versa. The saturation value does not affect the overall brightness of the
images.
Adjusts the edge sharpness of images. The higher the value, the sharper
Sharpness the image edges. Setting this value too high might result in noises in
images.

Changes image brightness by non-linear tuning to expand the dynamic
Gamma display range of images. The higher the value, the brighter the image and
vice versa.

Step7 Click Exposure to set relevant parameters.
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|

If the device that supports real wide dynamic (WDR) has enabled WDR, long exposure is
not available.

Figure 3-36 Exposure
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Table 3-11 Exposure parameters

Parameter Description

e 50Hz and 60Hz: With the 50/60 Hz household power supply, exposure can
be automatically adjusted based on the brightness of the scene to ensure
Anti-flicker that no horizontal stripe appears on the image.

e Outdoor: In an outdoor scenario, you can switch the exposure modes to
achieve your target effect.

The following options are available for different exposure modes of the
camera:

e Auto: Auto tuning of the image brightness based on the actual

environment.

e Gain Priority: Within the normal exposure range, the device adjusts itself
Mode automatically first in the preset range of gains as per the brightness of the
scenes. If the image has not achieved the target brightness when the gains
hit the upper limit or lower limit, the device adjusts the shutter
automatically to achieve the best brightness. The gain priority mode also

allows for adjusting the gains by setting up a gain range.
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Parameter Description

e Shutter Priority: Within the normal exposure range, the device adjusts
itself automatically first in the preset range of shutter values as per the
brightness of the scenes. If the image has not achieved the target
brightness when the shutter value hits the upper limit or lower limit, the
device adjusts the gains automatically to achieve the best brightness.

e Aperture Priority: The aperture is fixed at a preset value before the device
adjusts the shutter value automatically. If the image has not achieved the
target brightness when the shutter value hits the upper limit or lower limit,
the device adjusts the gains automatically to achieve the best brightness.

e Manual: You can set up the gains and shutter values manually to adjust
image brightness.

[

o |f the Anti-flicker is set to Outdoor, you can set the Mode to Gain Priority
or Shutter Priority.

e Different devices have different exposure modes. The actual pages might
be different.

Reduces the noises of multiple-frame (at least two frames) images by using

3DNR inter-frame information between two adjacent frames in a video.

When 3D NRis On, you can set up this parameter.
Grade

The higher the grade, the better the noise reduction effect.

Step8  Click Backlight to set up relevant parameters.

The backlight mode offers backlight correction, wide dynamic, and glare inhibition

features.

e Turning on Backlight Correction avoids silhouettes of relatively dark portions in
pictures taken in a backlight environment.

e Turning on Wide Dynamic inhibits too bright portions and makes too dark portions
brighter, presenting a clear picture overall.

e Turning on Glare Inhibition partially weakens strong light. This feature is useful in a
toll gate, and the exit and entrance of a parking lot. Under extreme lighting conditions
such as deep darkness, this feature can help capture the details of the faces and license
plates.

54



@hua .
TechNoLoaY User's Manual

Figure 3-37 Backlight
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Table 3-12 Backlight parameters

Backlight o
Mode Description

e When selecting the Default mode, the system adjusts exposure

automatically to adapt to the environment and make the images taken in
Backlight the darkest regions clear.
Correction ; ; :

e When selecting the Custom mode and setting up a custom region, the
system exposes the selected custom region to give the images taken in
this region proper brightness.

HLC Glare inhibition. The system inhibits the brightness in bright regions and

reduces the size of the halo, to make the entire image less bright.

To adapt to the environmental lighting conditions, the system reduces the
brightness in bright regions and increases the brightness in dark regions. This
ensures clear display of objects in both bright and dark regions.

Wide Dynamic m

The camera might lose seconds of video recordings when switching from a
non-wide dynamic mode to wide dynamic.

The system adjusts image brightness automatically based on the

SSA environmental lighting conditions to show image details clearly.

Step9  Click WB to set relevant parameters.
The WB feature makes the colors of the images more accurate. In WB mode, white objects
in the images appear white in various lighting conditions.
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Figure 3-38 WB
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Table 3-13 WB parameters

WB Mode Description

The system automatically corrects different color temperatures to ensure

Auto . .
normal display of image colors.

The system automatically corrects the scenes without manmade lighting to

Natural Light . .
ensure normal display of image colors.

The system automatically corrects the outdoor scenes at night to ensure

Street Lam . .
P normal display of image colors.
The system automatically corrects most outdoor scenes with natural lighting
Outdoor L - ;
and manmade lighting to ensure normal display of image colors.
Manual You can set up the red gains and blue gains manually for the system to

correct different color temperatures in the environment accordingly.

You can set up custom regions and the system corrects different color

Regional Custom . .
temperatures to ensure normal display of image colors.

Step 10 Click Day & Night to set up relevant parameters.
You can set up the display mode of images. The system can switch between the Colored
mode and the Black&White mode to adapt to the environment.
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Figure 3-39 Day & night
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Table 3-14 Day & night parameters

Parameter Description

Mode e (Colored: The camera displays colored images.

images based on the environmental brightness.
o Black&White: The camera displays black&white images.

The Day & Night settings are independent of the Config Files settings.

e Auto: The camera automatically selects to display colored or black&white

and the Black&White mode.
Sensitivity M

Defines the sensitivity of the camera in switching between the Colored mode

You can set up this parameter when the Day & Night mode is set to Auto.

Delayed Colored mode and the Black&White mode.
recording an

Defines the delay of the camera in switching between the Colored mode and
the Black&White mode. The lower the delay, the faster the switch between the

You can set up this parameter when the Day & Night mode is set to Auto.

Step 11 Click Defog to set up relevant parameters. See Figure 3-40. For details of the parameters,

see Table 3-15.

Image quality drops when the camera is placed in the foggy or hazy environment. You can

turn on Defog to make the images clearer.
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Figure 3-40 Defog

9 Device Config

Camera

Image

Exposure

Backlight

wB

Day & Night

Defog

Mode:

off

IR Light

Cancel

Table 3-15 Defog parameters

Defog Mode Description

You can set up the defog intensity and the atmospheric light intensity
manually. The system adjusts the image quality as per such settings. The

Manual atmospheric light intensity mode can be set to Auto or Manual for light
intensity adjustment.
Auto The system adjusts the image quality automatically to adapt to the

surrounding conditions.

Off Defog disabled.

Step 12 Click IR Light to set relevant parameters.
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Figure 3-41 IR light

Camera

Image

Exposure

Backlight

WB

Day & Night

Defog

IR Light

Mode:

Cancel

Table 3-16 IR light parameters

IR Light Mode Description

You can set up the IR light brightness manually. The system provides light for

Manual images as per the preset IR light brightness.

The system adjusts the brightness of the light to adapt to the surrounding

IR "
Smart conditions.

The system adjusts the illuminator according to the lighting condition.
e When the environment turns dark, the low beam will be used first. If the
low beam is not enough, the high beam will be used.
o When the environment turns bright, the high beam will be adjusted or
Zoom Priority turned off first. If it is still too bright, the low beam will be adjusted or
turned off.

o When the focal length is adjusted to a wide angle value, the high beam
will not be used to avoid overexposure on the objects near the camera,
but you can manually adjust the brightness of the low beam by reducing
or increasing the light compensation value.

Off IR light disabled.

Step 13 Click OK.
If you want to set the configuration files in a different mode, repeat the steps to complete
the configurations.
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3.2.9.1.2 Applying Configuration Files

Apply the image parameters as configured in the pre-defined periods.
Step1 Login to the DSS Client. On the Home page, click EY, and then in the Basic Config
section, select Device.

Step2 Click &
Step3  Select a device, and then click Device Config.

Figure 3-42 Device configuration

Config
[ =] -

» A root Parameter Setting

> IPC

i EventlInfo EventConfig

Event Type Priority Time Template Tag Action Remarks Operation

Step4  Click Profile Management, and set configuration files.
e When the mode is set to Regular, the system monitors the objects as per regular
configurations.

Figure 3-43 Set configuration files as regular

Camera

e When the mode is set to Full Time, you can set Always Enable to Daytime or Night.
The system monitors the objects as per the Always Enable configurations.
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Figure 3-44 Set configuration files as full time

Camera

e When the mode is set to Shift by time, you can drag the slider to set a period of time as
daytime or night. For example, you can set 8:00-18:00 as daytime, 0:00-8:00 and 18:00-
24:00 as night. The system monitors the objects in different time periods as per
corresponding configurations.
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Figure 3-45 Set configuration files as shift by time

Camera

Full Time @) Scheduled

& 9 10 11 12 13 14 15 16 17 18 °

Night

& More Configuration

Cancel

Step5 Click OK to save the configurations.

3.2.9.2 Video

Set video parameters such as video stream, snapshot stream, overlay, ROl and saving path.

3.2.9.2.1 Video Stream

Set the video stream parameters such as stream type, encoding mode, resolution, frame rate, stream

control, stream, | frame interval, SVC, and watermark.

Step1 Login to the DSS Client. On the Home page, click EY, and then in the Basic Config
section, select Device.

Step2 Click .

Step3  Select a device, and then click Device Config.

w N
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Figure 3-46 Device configuration

Config

Parameter Setting

1 EventInfo EventConfig

Event Type Priority Time Template Tag

Step4 Select Camera > Video > Video Stream.
Step5 Set Video Stream.

Figure 3-47 Configure video stream settings

Camera

The default values of streams are for reference only, and the actual pages might be
different.

Table 3-17 Video stream parameters

Remarks

Operation

Parameter Description

Video Settings Enable or disable Sub Stream parameters.

H.264B > H.264 > H.264H.

at the same image quality.

from the given options.

e H.264: H.264B (Baseline Profile), H.264 (Main Profile), H.264H (High
Profile). Bandwidth consumption level at the same image quality:

e H.265: Main Profile encoding, consuming less bandwidth than H.264
Encoding Mode o MJPEG: Frame-by-frame compression, requiring large bandwidth
and high video stream to ensure clear image. To achieve better video

image, it is recommended that you select the largest stream value

e SVAC (Surveillance Video and Audio Coding): It is a standard for
security surveillance applications in China.
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Parameter Description

Turning on Smart Codec will compress the images to save storage
space.

Smart Codec m

When smart code is on, the device does not support sub stream 2, ROI,
IVS event detection.

The resolution of the videos. Different devices might have different max

Resolution .
resolutions.

The number of frames per second in a video. The higher the FPS, the

FPS more distinct and smooth the images.

The following video stream control modes are available:
e BRC_CBR: The bit stream changes slightly around the preset value.
e BRC_VBR: The bit stream changes according to the monitored

Bit Rate Control scenes.

[

When the Encode Mode is set to MJPEG, BRC_CBR remains the only
option for stream control.

This parameter can be set only when Stream Ctrl is set to BRC_VBR.

Image Quality Video image quality is divided into six grades: Best, Better, Good, Bad,
Worse and Worst.

This parameter can be set only when Stream Ctrl is set to BRC_CBR.

Stream You can select the proper stream value from the drop-down box based
on actual scenarios.

The system will recommend an optimal range of stream values to users

Reference Stream based on the resolution and FPS set up by them.

Refers to the number of P frames between two | frames. The range of |
| Frame Interval Interval changes with FPS.

It is recommended to set the | Interval to be two times as the FPS value.

FPS is subject to layered encoding. SVC is a scalable video encoding

SVC method on time domain.

Turn on Watermark to enable this feature.

You can verify the watermark characters to check whether the video has
Watermark

been tempered or not.

Characters for watermark verification. The default value is Digital CCTV.

Step6  Click Apply.

3.2.9.2.2 Snapshot Stream

Set snapshot parameters, including snapshot type, picture size, picture quality, and snapshot speed.

Step1 Login to the DSS Client. On the Home page, click BY, and then in the Basic Config
section, select Device.

Step2 Click B

Step3  Select a device, and then click Device Config.

w N
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Figure 3-48 Device configuration

Config

Parameter Setting

1 EventInfo Eve

Event Type Priority Time Template Tag Remarks Operation

Step4 On the Device Config page, select Camera > Video > Snapshot Stream.

Figure 3-49 Configure snapshot stream settings

Step5 Set Snapshot Stream.

Table 3-18 Snapshot stream parameters

Parameter Description

It includes General and Trigger.
e Regular refers to capturing pictures within the time range set up in a

time table.

Snapshot Type e Trigger refers to capturing pictures when video detection, audio

detection, IVS events, or alarms are triggered, provided that video
detection, audio detection, and corresponding snapshot functions are
enabled.

Image Size Same as the resolution in Main Stream.

Sets up image quality. It is divided into six grades: Best, better, good, bad,

Image lit
age Quality worse and worst.
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Parameter Description
Snapshot Sets up the frequency of snapshots.
Interval Select Custom to manually set up the frequency of snapshots.

Link to Device

Webpage Go to the web page of the device.

Step6  Click OK.

3.2.9.2.3 Overlay

Set video overlay parameters, including tampering, privacy mask, channel title, period title,

geographic position, OSD, font, and picture overlay.

Step1 Login to the DSS Client. On the Home page, click BY, and then in the Basic Config
section, select Device.

Step2  Click &
Step3  Select a device, and then click Device Config.

Figure 3-50 Device configuration

Config

Parameter Setting

i EventlInfo EventConfig

Event Type Priority Time Template Tag Action Remarks Operation

Step4  On the Device Config page, select Camera > Video > Overlay.
Step5  Set privacy mask.

Figure 3-51 Overlay

Camera

Privacy Masking

Enable:
—e

Channel Name

Time Title

1) Click the Privacy Mask tab.
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2) Click B8 to enable the function.
3) Click to adjust the size and position of the area frame. You can add 4 area frames at
most.
Step6 (Optional) Set the channel name to display on the video.
1) Click the Channel Name tab.

Figure 3-52 Set channel name

9 Device Config

Camera

Privacy Mask

Channel Name

Enable:
—

Channel Title:

314

Period Title

0OSD Overlay

People Count

2) Click [ to enable the function.

3) Adjust the size and position of the name frame.
Step7 (Optional) Set the period title to display on the video.

1) Click the Period Title tab.

Figure 3-53 Set period title
9 Device Config

Camera

Privacy Mask
Channel Name

Period Title

OSD Overlay

People Count

2) Click BB to enable the function.
3) (Optional) Select Week Display so that the week information displays in video images.
4)  Adjust the size and position of the frame.
Step8 OSD overlay.
1) Enable Geographic Position, and then enter the geographic information of the
camera.
2) Select a text alignment method.

67



@hua .
TechNoLoaY User's Manual

Figure 3-54 OSD overlay

9 Device Config

Camera

Camera

Channel Name

Period Title

OSD Overlay

Step9  Click OK.

3.2.9.3 Audio

Set audio parameters such as encoding mode, sampling frequency, audio input type, and noise

filtering.

Step1 Log in to the DSS Client. On the Home page, click EY, and then in the Basic Config
section, select Device.

Step2  Click .

Step3  Select a device, and then click Device Config.

w N

Figure 3-55 Device configuration

Config

Parameter Setting

1 EventInfo Eve

Event Type Priority Time Template Tag Action Remarks Operation

Step4  On the Device Config page, select Camera > Audio.
Step5  Set parameters.
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Camera

Figure 3-56 Configure audio settings

Table 3-19 Audio parameters

Parameter

Description

Audio Settings

Audio settings can be enabled when video has been enabled.

After disabling Audio Settings in Main Stream or Sub Stream sections,
the network transmits a mixed flow of videos and audios. Otherwise, the
transmitted flow only contains video images.

Encoding Mode

The encoding modes of audios include G.711A, G.711Mu, AAC, PCM, and
G.726.

The preset audio encode mode applies to audio talks.

Sampling
Frequency

Available audio sampling frequencies include 8K, 16K, 32K, 48K, and 64K.

Audio Input Type

The following types of audios connected to devices are available:
e Lineln: The device must connect to external audio devices.
o Mic: The device does not need external audio devices.

Noise Filtering

After enabling noise filtering, the system automatically filters out the
noises in the environment.

Microphone
Volume

Adjusts the microphone volume.
[ 1]

Only some devices support adjusting microphone volume.

Speaker volume

Adjusts the speaker volume.
[1]

Only some devices support adjusting speaker volume.

Step6  Click Apply.

3.2.10 Synchronizing People Counting Rules

If you create, edit or delete people counting rules on a device, you have to manually synchronize
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them to the platform.
Step1 Login to the DSS Client. On the Home page, click EY, and then in the Basic Config
section, select Device.

Step2 Click &
Step3  Select a channel, and then click Sync People Counting Rules.

Figure 3-57 Synchronize people counting rules from the device

Video Channel Type:
Bullet Camera

¥ i Root

Config

Al Rule Config Sync People Counting ...

EventInfo Eve
Event Type Priority Time Template
Motion Detection High All-Period Template

I
RecordingInfo A ng Plan

Storage Path Time Template

Step4  Click Sync Rules, and then the system prompts Synchronization Complete.

Figure 3-58 Synchronize people counting rules from the device

9 Sync People Counting Rules

3.3 Adding Role and User

Users of different roles have different menus and permissions of device access and operation. When
creating a user, assign a role to it to give the corresponding permissions.

3.3.1 Adding User Role

Arole is a set of permission. Classify users of the platform into different roles so that they can have

different permissions for operating the devices, functions and other system resources.

e Super administrator: A default rule that has the highest priority and all the permissions. This role
cannot be modified. A super administrator can create administrator roles and common roles. The
system supports 3 super administrators at most.
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e Administrator: A default rule that cannot be modified and has no permission of configuring
cascade, authorization, backup and restoring. An administrator can create other administrators.

e Common role: A common role that has no permission of configuring cascade, authorization,
backup and restoring, user management, and device management.

Step1  Login to the DSS Client. On the Home page, click EY, and then in the Basic Config

section, select User.

Click 4.

Step3  Click Add, set role information, and then select device and control permissions and assign

[¥4]
—
0]

N

the rule to users.

Figure 3-59 Add a role

O Add Role

(L]

e [fadeviceis not selected under Device Permissions or a menu not selected under
Menu Permissions, all users assigned with this role will not be able to see the device or
menu.

e Click [} of a selected organization. All permissions of subsequently added devices
under this organization will also be assigned to users of this role.

Step4  Click OK.

3.3.2 Adding User

Create a user account for logging in to the platform.

Procedure
Step1 Log in to the DSS Client. On the Home page, click £Y, and then in the Basic Config
section, select User.

Step2 Click EA
Step3  Click Add, and then configure the user information.
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Table 3-20 Parameter description

Parameter

Description

Username

Used to log in to the client.

Multi-client Login

Allow the user to log in to multiple clients at the same time.

Password

Used to log in to the client.
Confirm Password

Enable and enter a name, and then this user will be set as an MPT user.
This is used in the group talk function in the map. For details, see "5.1.4
Map Applications".

[

If you enable this function, you cannot enable Multi-client Login.

MPT User

Enable Forced
Password Change at
First Login

The user is required to change the password at first-time login.

Enable Password

Change Interval Force the user to change the password regularly.

Enable Password The password must be changed after it expires on the defined date.

Expiry Time

The PTZ control priority of the user. The larger the value, the higher the
PTZ Control priority. For example, User A has a priority of 2 and User B has a priority
Permissions of 3. When they operate on the same PTZ camera, which is locked, at

the same time, the PTZ camera will only respond to the operations from
User B.

Email Address Used to reset password and receive alarm emails.

Limit the user to log in from specific computers. One user can be bound

Bind MAC Address to 5 MAC addresses at most.

Select one or more roles to assign the user permissions, such as which

Role i
devices are allowed to be operated.

Step4  Click OK.

Related Operations
e Click [#] to lock user. The locked user cannot log in to the DSS Client and App.
e Click to modify information of a user except the username.
e (lick ] to delete a user.

3.3.3 Importing Domain User

You can import domain users from the domain system of your current organization to create

platform users.

Step1  Configuring domain information

1) Log in to the DSS Client. On the Home page, click EY, and then in the System Config
section, select System Parameters.

2) Click Active Directory and configure domain information.

3) Enable active directory to set domain information. [l indicates active directory is
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enabled.

e C(lick to enter the password.

e After setting domain information, click Get DN and it will acquire basic DN
information automatically.

e After getting DN information, click Test to test if domain information is available.

Figure 3-60 Set active directory

Active Directory —@

SSL Private Key:

Domain MName;

HOOOC0000C0m

Username: Password:

OO

Base DN:
DC =3, DC=xxx

Get DN

4) Click Save.
Step2  Import domain users.
1) Log in to the DSS Client. On the Home page, click EY, and then in the Basic Config
section, select User.
2) Click tab, and then click Import Domain Users.
3) Select the users to be imported, and then click Next.

You can also search for a user by entering keywords in the search box.
4) Select the roles, and then click OK.

Related Operations
To log in using a domain user account, start the DSS Client, and then select Domain User for user
type.
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3.3.4 Syncing Domain User

When there are users that have expired, you can use sync domain user to delete the expired users.
tep1 Login to the DSS Client. On the Home page, click BY, and then in the Basic Config

section, select User.

:

Step2 Click EA
Step3  Click Sync Domain Users.
Step4  Select the users to be deleted, and the click Delete.

Figure 3-61 Sync domain user

Sync Domain Users

© Domain users liste are invalid. Click "Delete” to delete them from the platform.

No. Domain User Username

Delete Cancel

3.3.5 Password Maintenance

The platform supports modifying user password, and resetting system user password when it is
forgotten. Only the system user can reset password. Other users, when their passwords are
forgotten, can ask the system user to modify the passwords.

3.3.5.1 Changing Password for the Current User

We recommend changing your password regularly for account safety.
Step1 Login to the DSS Client, click [ at the upper-right corner, and then select Change
Password.
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Figure 3-62 Change password

Step2  Enter the old password, new password, and then confirm the new password. Click OK.

3.3.5.2 Changing Password for Other Users

The system user can change the password for other users without the need to verify the old
password.
tep1 Login to the DSS Client. On the Home page, click EY, and then in the Basic Config
section, select User.

:

Step2 Click EA.
Step3  Select a user, and then click .
Step4 Enable Change Password, enter the new password and confirm password, and then click

OK.

Figure 3-63 Change user info
9 Modify User

Basic Info

Username:

Multi-client Login:

3.3.5.3 Resetting User Password

You can reset the password of a user by security questions or email address, but only the system
account supports resetting the password by security questions.
Step1  Onthelogin page, click Forgot password?.

Step2  Enter the account that you want to reset the password for, and then click Next Step.
Step3  Select how you want to reset the password.

e By security questions. This is only applicable to the system account.
1. Click Reset Password through Security Questions.
2. Answer the questions, and then click Next Step.
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e By email address. This is applicable to all accounts, but an email address must be
configured first. For details, see "3.3.2 Adding User".
1. Click Reset Password through Email Verification.
2. Click Send Verification Code.
3. Enter the verification code that you received from the email address, and then click

Next Step.
Step4  Setanew password and confirm it, and then click Next Step.
The password has been reset.

3.4 Configuring Storage

Manage the storage of the platform, including adding network disks, setting storage types to store
different types of files, creating disk groups to store files from specified channels, and setting the
storage location and retention period of the images and recorded videos from devices.

3.4.1 Configuring Network Disk

e The storage server is required to be deployed.
e One user volume of the current network disk can only be used by one server at the same time.
e User volume must be formatted when adding network disk. Check if you have backed up the

data.
Procedure
Step1 Login to the DSS Client. On the Home page, click EY, and then in the Basic Config
section, select Storage.
Step2  Select [2]
Step3  Click Add.
Step4  Select server name and mode, enter the IP address of network disk, and click OK.

e Normal mode: All volumes of the network disk will be added. Those used by any user
will be in red.

e User mode: Enter the username and password of a user. Only volumes of the network
disk assigned to this user will be added.
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Figure 3-64 Add network disk (normal mode)
9 Add NetDisk

Cancel

Figure 3-65 Add network disk (user mode)
9 Add NetDisk

Server Name:

Username:

- EanzE

Step5  Select disk, and then click to format the corresponding disk.

1.
2.

Select user volume, and then click [&].
Select format disk type, and then click OK.
Video: Stores videos.

Image and File: Stores video files from MPT devices, and all types of images.

Figure 3-66 Format disk

Initialize Disk

Disk Type:

Video

Related Operations

e To configure disk type, click 3.
e Toformat a disk, click [H].
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[

Formatting will clear all data on the disk. Please be advised.

3.4.2 Configuring Server Disk

Configure local disk to store different types of files, including videos, ANPR snapshots, incident files,
and face or alarm snapshots. In addition to the local disks, you can also connect an external disk to
the platform server, but you have to format the external disk before using it.

[

e To set up local storage, you need a physical disk with only one volume or any volume of one
physical disk. Back up the data of the disk or volume before setting its disk type, which will
format and erase all data from it.

e One physical disk with only one volume or any volume of one physical disk can only store one
type of files. If you need to store more than one type of files, you need more than one physical
disks or volumes, but it cannot be the one where you installed the operating system of the server
or the DSS server. See "2.1.2 Installing DSS".

Step1 Login to the DSS Client. On the Home page, click EY, and then in the Basic Config

section, select Storage.

Step Select [=.
Step Format a disk to set a storage type

A\

This operation will clear all data on the disk. Please be advised.

w N

1) Select user volume, and then click [&].
1) Select storage type, and then click OK.
e Video: Stores videos.
e Images and Files: Stores video files from MPT devices, and all types of images.
e Incident File: Stores videos and images in the case bank. This disk cannot be
overwritten.

If you do not set up one or more disk types, you will not be able to properly use
corresponding functions. For example, if you do not set up an Image and File disk, you
will not see images in all alarms.
Step4 Manage local disks.

e |nitialize disk
click [&)

e To configure disk type: Click [E3.

e To format a disk: Select a disk or user volume, click

3.4.3 Configuring Disk Group

Allocate disk groups for video storage.
Step1 Log in to the DSS Client. On the Home page, click EY, and then in the Basic Config

78



@hua .
TechNoLoaY User's Manual

section, select Storage.

Step2 Click B3
Step3  Click Add Disk Group, enter disk group name, and then select a server and disks.

Figure 3-67 Configure disk group

ame:

Step4  Click Next Step.
Step5 Select devices or channels on the left.
Step6  Click OK.

3.4.4 Configuring Device Storage

When there are a large number of devices on the platform, it will put too much pressure on the
network disks or local disks because they might produce a lot of images and videos that need to be
stored. The platform supports setting the storage location and retention period of the images and
videos for storage devices, such as an IVSS, to reduce the pressure on the server.
The types of images include face captures, video metadata, and events.
Step1 Log in to the DSS Client. On the Home page, click EY, and then in the Basic Config
section, select Storage > Device Storage Config.
Only organizations with storage devices are displayed.
Step2  Select an organization, click E] of a device on the right.
Step3  Configure the parameters, and then click OK.

Table 3-21 Parameter description

Parameter Description

e Save to Central Storage: All images produced by the channels
connected to this device will be stored on the network disks or

Event Image Storage local disks of the platform.

Location e Link to Images on Device: All images produced by the

channels connected to this device will be stored on the device
itself. The platform will obtain images from the device.

e Save to Central Storage: All alarm videos produced by the
channels connected to this device will be stored on the network

Event Video Storage disks or local disks of the platform.

Location o Link to Videos on Device: All alarm videos produced by the

channels connected to this device will be stored on the device

itself. The platform will obtain videos from the device.

79



@hua .
TechNoLoaY User's Manual

Parameter Description

[

To make sure that alarms videos are complete, we recommend
you set a 24-hour recording plan for the device. Otherwise, the
platform might not be able to obtain videos. For example, a
recording plan of 00:00-14:00 has been configured on the
device so that the channels connected to it will record videos
during that period. If an alarm is triggered on 14:01, the
platform will not be able to obtain videos for this alarm.

This function is applicable to the images and videos stored on the
device.

After enabled, the platform will obtain the value from the device,
Retention Time of Images | and you can change it to 1-180. The images and videos that have
and Videos on Device been stored longer than this value will be automatically deleted.

A\

Deleted files cannot be recovered. Please be advised.

3.5 Connecting to Multiple Sites

If you have multiple platforms, you can connect to others as sites to your current platform, so that
you can view the resources from them directly on your platform, including viewing real-time videos
from video channels, searching for viewing real-time and historical events, and downloading
recorded videos.
The versions of different platform must be the same.
Step1 Loginthe DSS Client.
Step2 Click ﬁ-i on the upper-right corner, and then click Add Site.
Step3  Enter a name for the site, and the login information, and then click OK.
You can now view real-time videos of the devices, and real-time and historical events from
the site.

Figure 3-68 Resources from the site shown on the Monitoring Center

e + Site Name Alarm Catego... Alarm Type

Device Discons
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4 Businesses Configuration

This chapter introduces the basic businesses, such as storage plan, video monitoring, access control,
alarm controller, video intercom, target detection, face recognition, ANPR, and intelligent analysis.

4.1 Configuring Events

Configure events first if you want to display alarm event notifications on the platform.

Procedure
Step1 Login to the DSS Client. On the Home page, click EY, and then in the App Config section,
select Event.
Step2 Click Add.

Figure 4-1 Configure the event source

Event Source

Radar
Parking Lot

Lift Control Channel

Soft Trigger

Step3  Configure the event source.
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|

e Before configuring the event, check whether the channel features match the event
type; otherwise the event type cannot be selected as the alarm source. To configure
channel features, see "3.2.2.5.2 Modifying Device Information".

o |f Alarm Input Channel is selected, check whether the Triggered Event that you select
matches the alarm input channel you select; otherwise, the event will not be triggered.

e Soft Trigger is a type of event that is manually triggered. You can customize its name
and button type. When viewing the live video image of the configured channel in the
Monitoring Center, you can click its button to trigger an alarm manually.

Figure 4-2 Manually trigger an alarm by clicking the button

Step4  Configure parameters under Event Attribute.
Configure alarm priority as needed, so that you can quickly know the priority of alarm
when receiving an alarm on the DSS Client.

Figure 4-3 Event attributes

Event Attributes

Priority: Time Template:

High All-Period Template

Remarks:

Step5 Configure alarm linkage actions.
e Tolink video, enable Linked Action > Link Video.
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BN LinkVideo —®

ct Camera

Select Channels

4 fin Root

Figure 4-4 Link video

Selected(D)

Q Channel Organization QOperation

Table 4-1 Parameter description

Parameter Description
e Event source: The camera of the alarm itself is linked when the
alarm occurs.
e Bound camera: If the alarm channel is bound to a video channel,
Camera you can view the video of the bound channel. To bind a channel,

see "3.2.3 Binding Resources".

e Select camera: Select a camera so that you can view the camera
video when the associated alarm is triggered.

When an alarm is
triggered, display
camera live view on
client

Enable this parameter, and then the platform will open the real-time
video of the channel where an alarm is triggered, and play it in the
defined stream type.

[1]

After the event is configured, you must enable Open Alarm Linkage
Video and select how the real-time video will be open in alarm
settings. For details, see "8.3.4 Configuring Alarm Settings".

Event Recording

Start recording when an alarm is triggered.

Stream Type

Define the stream type of the recorded video. If you select main
stream, the recorded video will be in higher quality than sub stream,
but it requires more storage.

Recording Time

The duration of the recorded video.
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Parameter Description

When there is recorded video that is stored on the device or platform
before the alarm is triggered, the platform will take the defined
duration of that video, and then add it to the alarm video.

[1]

e If the alarm video is stored on the device, we recommend you

Prerecording Time configure a 24-hour recording plan to make sure that there is
prerecorded content to add to the alarm video.

e |If the alarm video is stored on the platform, the platform will record
videos and use certain input bandwidth continuously.

e This parameter is not applicable to alarms in parking lots.

e To trigger a snapshot, enable Trigger Snapshot.
Select a video channel, and then it will take a snapshot when an alarm is triggered.

Figure 4-5 Trigger a snapshot

O] Trigger Snapshot  —®

Camera: Select Video Channel:

Select Camera

e Tolinka PTZ action, click Link PTZ, and then select the PTZ channels and presets to be
linked.

Figure 4-6 Link PTZ

@ LinkpTZ —®
Select Channels Selected(0)

O. Channel Organization Action Operation

» {1 Root

o C(lick Alarm Output, select an alarm output channel, and then set duration.

Figure 4-7 Alarm output

@ AlarmOQutput —®

Select Channels Selected(0)

Q Channel Organization Operation

4 i Root

e Tolink audio and light, click Link Audio and Light, select the audio and light channels,
and then select the action duration.
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Figure 4-8 Link audio and light

Organization Action Operation

root 10s L]

root 10s L]

o C(lick Link Access Control Device, select access control channels, and then select a
linked action.

Figure 4-9 Link access control device
B Linka Control Device

Access Control Channel;

All Mormally Open

e To play alarm video on the video wall, click Link Video Wall, select a camera on the left
of the page, and then select a video wall window on the right of the page.

Make sure that you have added decoders to the platform, configured video wall and set
alarm window.

e To execute an HTTP URL; command, click Link HTTP URL Command. Click Add, and
then configure its request method, HTTP URL, and remarks. You can click to test if

the command is valid.

Figure 4-10 Link HTTP URL command

B LinkHTTP URL Command —®

e To link emails, enable Email, and click B to add the email address, and then an email
will be sent to the selected email address when an alarm is triggered.

Figure 4-11 Link email

To configure the email template, select Add Email Template from the Email Template
drop-down list.
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Figure 4-12 Email template

Email Template

Template Name
ault E-mail Template

Event Time Event Type Event Source Organization

Content:

e Apply an alarm protocol to help users process alarms when they are triggered . Click

Alarm Protocol, and then select a protocol from the Protocol Template drop-down
list.

Figure 4-13 Alarm protocol

Alarm Protocol —®

Click Add protocol template to create a new protocol; click to edit the content of
a protocol.
e Toinform a user, click Notify User, and then select the user to be informed.
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Figure 4-14 Notify user

Notify User

0000001
123

Related Operations
e Toeditan event, click .
e Todelete an event, click EA.
e Todisable an event, click [l

4.2 Configuring Map

4.2.1 Preparations

e Devices are deployed. For details, see device user's manuals.

e Basic configurations of the platform have been finished. For details, see "3 Basic Configurations".

e Foronline map, make sure that you have got the map information in advance. For raster map,
make sure that map pictures are prepared.

e To show device alarms on the map, make sure that Map flashes when alarm occurs is enabled
in Home > Management > Local Settings > Alarm.

4.2.2 Adding Map

4.2.2.1 Adding Vector Map

Procedure
Step1 Login to the DSS Client. On the Home page, click EY, and then in the App Config section,
select Map.
Step2 Inthe map list, select the vector map, and then click .
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Figure 4-15 Map

Map Relationship Main Map

¥ A Main Map
* I |
>
m

n

Sub Map ofGoogle Maps Offline

Step3  Configure the parameters.

Figure 4-16 Map information
9 Modify Vector Map

Map URL:

Map Initial Status

Min Display Level of the Map:

o Online map
1. Select Online.
2. Configure the information of the map, and then click OK.
e Offline map
1. Select Offline.
2. Click Import and import offline map.
3. Configure map information, and then click OK.
Step4  Add asub map.
If there is a specific area on the map that you want to view its detailed information, you can
add an image of it on the map as a sub map. For example, you can add a plane image of a
parking lot on the map.
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1) On the map resource tree on the left, click the name of the map that you have just
added, or open the GIS map and click Add Sub Map.

2) Name the sub map, upload a map picture, and then click OK.

3) Drag the map to adjust its position, and then click OK.
The sub map is added.

Related Operations

Hide Device Name

Only display the icons of devices.

Satellite Map

View the satellite map.

Delete Devices

To delete a device from the map, click it and then click Delete Resource.

Show Device

Select which type of resources you want to display on the map.

Move

To move a device, click Move and then drag the device on the map.

Select

To select one or more devices, click Select, and then click on the devices on the map one by one.
Pane

To select devices in batches, you can click Pane, and then draw a frame on the devices to select
the device.

Clear

To clear all markings on the map, click Clear.

Add Sub-map

To add a sub map on the current map, click Add Sub Map, click on the map to locate it, enter a
name, upload a map picture and then click OK.

Length

Select Box > Length, connect two points with a line on the map (double-click to finish drawing),
and then the distance between the points is shown.

Area

Select Box > Area, select a region on the map (double-click to finish drawing), and then the area
is measured.

Add Mark

Select Box > Add Mark, and then mark information on the map.

Reset

Select Box > Reset to restore the map to its initial position and zoom level.

4.2.2.2 Adding Raster Map

A raster map is suitable for places where you want to view their detailed information, such as a

parking lot. You can add multiple ones.

Procedure
Step1 Log in to the DSS Client. On the Home page, click EY, and then in the App Config section,
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select Map.
Step2  Select Main Map, and then click Add Map.
Step3  Enter the map name, select the picture and then click OK.

Figure 4-17 Add main map

Name: Description:

Local Area

Map:

Step4  Add a child map.
1) Click the added raster map, and then click Add Sub Map.
2) Enter the map name, upload the picture, and then click Next Step.
3) Drag the picture to the desired position and click OK.

Related Operations
e Hide Device Name
Only display the icons of devices.
e Delete Devices
To delete a device from the map, click it and then click Delete Resource.
e Show Device
Select which type of resources you want to display on the map.
e Move
To move a device, click Move and then drag the device on the map.
e Select
To select one or more devices, click Select, and then click on the devices on the map one by one.
e Pane
To select devices in batches, you can click Pane, and then draw a frame on the devices to select
the device.
e (lear
To clear all markings on the map, click Clear.
e Add Sub-map
To add a sub map on the current map, click Add Sub Map, click on the map to locate it, enter a
name, upload a map picture and then click OK.
e Length
Select Box > Length, connect two points with a line on the map (double-click to finish drawing),
and then the distance between the points is shown.
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e Area
Select Box > Area, select a region on the map (double-click to finish drawing), and then the area

is measured.
e Add Mark
Select Box > Add Mark, and then mark information on the map.
e Reset
Select Box > Reset to restore the map to its initial position and zoom level.

4.2.3 Marking Devices

Link a device to the map by dragging it to the corresponding location on the map according to its
geographical location.
Step1  Login to the DSS Client. On the Home page, click EY, and then in the App Config section,
select Map.
Step2  Click the map.
Figure 4-18 Map

Map Relationship Main Map

Child Map O

_|_

Add Child Map

Step3  Drag the device channel from the left device tree to the corresponding location of the

map.

4.3 Personnel and Vehicle Information Management

Configure personnel and vehicle information for the applications of access control, vehicle control,

attendance management, and video intercom.

e Personnel information contains card number, password, face picture, and more. People bound
with vehicle information will be displayed in the vehicle list.

e Vehicle information helps to confirm the entry of the vehicle into a certain area. Vehicle bound
with personnel information will be displayed in the personnel list.
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4.3.1 Configuring Personnel Information

Figure 4-19 Personnel management

Add Add | t
FPersonnel Personnel F’errr;%ﬂnel
One by One in Batches

Start Start Start

Add Departments Add Depariments Import Personnel

Add Personnel in

Add a Person Batches

Quick Authonization

Issue Cards in
Batches

{Optional) View
Moving Track

(Optional) View
Moving Track

End End End

4.3.1.1 Adding Person Group

Add groups and you can manage people and assign permission by group.

Procedure
Step1  Login to the DSS Client. On the Home page, click EY, and then in the App Config section,
select Personal and Vehicle Info.
Step2 Click E&
Step3 Click [

w N

Figure 4-20 Added person group (1)

Person Group

| 2 &

™ ,
¥ nn All Persons

fww

w1

Step4  Enter person group name and click OK.
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Figure 4-21 Added person group (2)
9 Add Person Group

Group Name:

Remark:

- _ (:anCEI

Related Operations
e Todelete a person group, select it, and then click [El. All permissions associated with the people
in the group will also be deleted.
e Torename a person group, select it, and then click [E.
e To move a person into a different group, select the person, and then click Move To.

4.3.1.2 Adding Personnel

Add people to the platform and grant them access to different access control devices, entrance and
exits permissions, and more.

B

e The information of a person must be the same on the platform and access control devices, such
as the person ID and card number. Otherwise the attendance data of this person cannot be
synchronized between the platform and access control devices.

e To collect fingerprints or card number, connect a fingerprint collector or card reader first.

4.3.1.2.1 Adding a Person

Procedure
Step1 Login to the DSS Client. On the Home page, click EY, and then in the App Config section,
select Personal and Vehicle Info.
Step2  Click E&.
Step3  Click Add.
Step4 Click the Basic Info tab to configure person information.

1) Hover over the profile, and then click Upload to select a picture or click Snapshot to
take a photo.

e You can upload 2 pictures or take 2 snapshots.

e Click ] on the Snapshot page, and then you can select camera, pixel format,
resolution, and image quality. These settings are only effective with the current
client.

2) Enter personnel information as necessary. ID is required and must be unique. It can be
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up to 30 characters, and letter-number combination is also supported.

Figure 4-22 Personnel information

9 Add Person

Basic Info

Only certain devices support the second picture or snapshot. The second picture or
snapshot can be the person's face being blocked, such as wearing a mask or a hat.
Step5 Click Bl and then set person details as required, including nickname, ID, address,
birthday, region, company, job title, and more.
Step6 Ifthe person is resident, Click next to Resident Info, and then bind room number.

o Room No.: The number of the apartment in which this person lives. The room number
is displayed in the access records and video intercom operation records. Access
permission of the corresponding VTO is also included when authorizing access control
permission to this person.

o Homeowner: When several people live in one apartment, you can set one of them as
the homeowner.

Step7  Click the Authentication Info tab, and then set validity period and access control
information.
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Figure 4-23 Authentication Info

Authentication Info

Multi-factor Authentication Password 0 Unlock Password (Only for 1st gen)

- -

Fingerprint Name Qperation

1) Configure effective periods, within which the face, card, password, and fingerprint are
effective.

2) When access controllers are added and passwords are required to unlock the door,
configure the password first.

e A multi-factor authentication password must be used with a card, person ID, or
fingerprint to unlock the door. It is only applicable to second-generation access
control devices.

e Click B and you can set up an unlock password that can be used to directly unlock
the door. It is only applicable to first-generation access control devices.

Step8 Issue cards to personnel.
One person can have up to 5 cards. There are two ways to issue cards: by entering card No.
or by a card reader. A card number is 8-16 numbers. Only second-generation access
control devices support 16-digit card numbers. When a card number is less than 8
numbers, the system will automatically add zeros prior to the number to make it 8 digits.
For example, if the provided number is 8004, it will become 00008004. If there are 9-16
numbers, the system will not add zero to it.
e |ssue a card through a card issuer or a device with a card reader.

1. Click E] next to Card, select a card issuer or a reader of a device, and then click
OK.
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Figure 4-24 Card reader manager

Card Reader Manager

Card Reader:

Device

Device:

2. Click , swipe a card on the device you select, the card number will be recognized
and displayed.

3. click |

e Manually enter the card number.
Click , enter card number, and then click [

Figure 4-25 Reader manager

Card No.:

A12345678

Table 4-2 Card operations

Icon

Description

If a person has more than one card, only the main card can be issued to the first-
generation access control device. The first card of a person is the main card by
default.

Click IEJ on an added card, the icon turns into [, which indicates that the card
is @ main card.

Set a card as duress card. When opening door with a duress card, there will be a
duress alarm.

Click this icon, it turns into [E&, and I is displayed at upper right, which
indicates that the card is set as a duress card. To cancel the duress setting, click [E&.

Change card for the person when the current card does not work.

Remove the card, and then it has no access permissions.
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Step9  Collect fingerprint.
To open door with fingerprint, you need to collect personnel fingerprints. A person can
have up to 3 fingerprints.
1) Click B next to Fingerprint.
2) Click Add.
3) Select a fingerprint collector from the Fingerprint Collector drop-down list, and then
click OK.
4) Click Add

Figure 4-26 A collected fingerprint

Fingerprint

& add

Table 4-3 Fingerprint operations

Icon Description

One can have 3 fingerprints, but only these fingerprints can be issued to devices.
Click this icon, and then it turns into B, which indicates that this fingerprint has
been set as a main one. To cancel the main fingerprint setting, click .

Set a fingerprint as duress fingerprint. When opening door with a duress
fingerprint, there will be a duress alarm.

Click this icon, it turns into [, which indicates that the fingerprint has been set as
a duress fingerprint. To cancel the duress setting, click [

Modify fingerprint name.

& | Remove the fingerprint, and then it has no access permission.

Step 10 If the person has a vehicle, click E] next to Vehicle Information to add vehicle
information.
Click [Ell and then enter plate No., select vehicle color and logo.
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|

Add vehicle information to a person, so as to enable vehicle access permission for this

person.

Figure 4-27 Add vehicle information

Vehicle Information

A7 . 4 —
Vehiclel W

Plate No.:

Step 11 If the person needs access control permission, enable the permission first.
1) Click BB next to Access Control Permission.
2) Select Access Type, and select Allow Device Login check box as needed.
e Allow Device Login: People have permission to go into web page from the device.
e Select General if it is the first time for the person to use the card to unlock the door.
3) Click Add, and then select access control permission group. For details, see "4.4.1.1

Creating Face Comparison Group".

Figure 4-28 Add to access control permission group

Access Control Permission  —®

Access Type:

General Allow Device Login

Ac Permission Group:

& Add

Access Permission Group Name Operation

Step 12 Enable Lift Control Permissions so that the person can use certain lifts.
1) Click [ next to Lift Control Permissions.
2) Select one or more lift control devices, and then select the floors this person can go to.
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Figure 4-29 Lift control devices and floors

Lift Control Permissions ' —®

1)

e Name Channel Name Operation

Building 1 flo 2 - @

¥ B | Current Site

You need to create a face comparison group first.

Step 13 Enable Face Comparison to recognize the person by images.
1) Click I next to Face Comparison.
2) Select a face comparison group.

Figure 4-30 Face comparison

Face Comparison —@

You need to create a face comparison group first.
Step 14 If the vehicle needs access to the parking lot, enable and configure Vehicle Group first.
1) Click [l next to Parking Lot Vehicle Group.
2) Enable Parking Space Available and configure the number of the parking space for
the vehicle owner.
3) Click Add to select a vehicle of the person, and then select which vehicle group it
belongs to, and for how long it has permission to park in the parking lot.

Figure 4-31 Parking lot vehicle group

Parking Lot Vehicle Group —@

Parki

1

+ Add

Plate No. Vehicle Group Validity Period Operation

Step 15 Click OK.
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To delete a person, you can select the person, and then click H; to delete all people on

this page, select the Select All check box, and then click Delete.

Related Operations
e To edit basic information of a person, select the person, and then click n
e To delete a person:
o Click H to delete a person and associated permissions.
o Select multiple people, and then click Delete to delete them and their permissions.
¢ Click Delete All to delete all the people and their permissions in the group.

e To view authorization exception, click .
e To search for a person, enter key words in the .

4.3.1.2.2 Importing Personnel

To quickly add a number of personnel, you can download a personnel template, fill in it and then
import it to the platform. You can also import an existing personnel file.

Prerequisites
Prepare an .xlsx file that includes the information of the people you want to import, their face images
(optional), and then compress them into a zip file. The xIsx file can include information of up to
10,000 people. The zip file cannot be larger than 1 GB.

Procedure
Step1 Log in to the DSS Client. On the Home page, click Y, and then in the App Config section,

select Personal and Vehicle Info.

Step2 Click EA.
Step3  Select Import > Import from File.

Figure 4-32 Import personnel information

Import

Step4 Import the personnel information file.
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|

If there is no personnel information file, click Template Download and follow the
instructions on the page to create personnel information.
Step5 Click OK.
The following cases might occur during an import:
e |[f there are failures, you can download the failures list to view details.
e Read carefully the instructions in the template to make sure all the information is
correct.
e (Cannot read the contents with a parsing error reported directly.

Related Operations
e Export personnel information.
Select an organization, click Export, and then follow the instructions on the page to save the
exported information to a local disk.
e Download template.
To add personnel information in batches, you can download the template, fill in the information,
and then import it.

4.3.1.2.3 Extracting Personnel Information

When personnel information has been configured on access control devices or door stations, you

can directly synchronize the information to the platform.

Step1 Login to the DSS Client. On the Home page, click EY, and then in the App Config section,
select Personal and Vehicle Info.

Step2  Click EA.
Step3  Click Import, and then select Import from Device.

Figure 4-33 Import from device

All Persons

Racir Infn Aunthentiration Infa

Q

i All Persons Import from Device

Step4  ClicklEll select a channel from an access control device or door station, and then click OK.
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Figure 4-34 Extract task list

Import from Device

9 Acquire Task List

- C:ar“:El

Step5 Double-click a result to view the detailed information.
Step6  Synchronize personnel information to the platform, or export information.

Figure 4-35 Personnel extraction results

Import from Device

9 220

¥ Importall

1D MName Access Type Authorization Information

Total of 80 Record(s)

e To add all the personnel information to the platform, click Import All.
e To add part of the information, select the people of interest, and then click Import
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selected.
e To export information, select the people you want, and then click Export.

4.3.1.3 Issuing Cards in Batches

Step1 Log in to the DSS Client. On the Home page, click EY, and then in the App Config section,
select Personal and Vehicle Info.

Step2 Click EA.
Step3  Select the people to issue card to, and then click Batch Issue Card.

Figure 4-36 Issue card in batches

Person Group All Persons

+ o

B X1
11111111

Step4  Set term of validity.
Step5 Issue cards to personnel.
Step6  Support issuing cards by entering card number or by using a card reader.

e By entering card number
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Figure 4-37 Enter card number

9 Batch Issue Card

Issue Card €}

ID Mame Operation

-

andy

1) Double-click the Card No. input boxes to enter card numbers one by one.
2) Click OK.

e By using a card reader

1) Click B

2) Select a card reader or device, and then click OK.
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Figure 4-38 Reader manager

3) Select people one by one and swipe cards respectively until everyone has a card
number.
4) Click OK.

4.3.1.4 Editing Personnel Information

Modify personnel information including basic information, authentication details, and authorization.

Person ID cannot be modified.

Step1 Login to the DSS Client. On the Home page, click EY, and then in the App Config section,
select Personal and Vehicle Info.

Step2 Click EA.
Step3 Click to edit information. For details, see "4.3.1.2.1 Adding a Person".

4.3.2 Vehicle Management

Manage vehicle information including vehicle type, owner, entry and exit permissions and arming

groups.

Procedure
Step1 Login to the DSS Client. On the Home page, click EY, and then in the App Config section,
select Personal and Vehicle Info..
Step2 Click &
Step3  Click Add to add vehicle information.

w N
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Figure 4-39 Add vehicle information

9 Add Vehicle

Owner Info

Vehicle info

Entrance and Exit Vehicle Group —®

e Add vehicles one by one
1. Enter Owner Info of the vehicle by clicking Select from Person List.
2. Enter Vehicle Info such as plate number (required and unique), vehicle color, brand
and more. After selecting owner, you can add multiple vehicles.
3. Click - to enable Parking Lot Vehicle Group, and then you can set the
available parking spots for the selected person, and grant access permissions by
adding vehicles into entrance and exit vehicle groups.

[1]
If the owner has more vehicles than the set parking spots, once no parking spots
available, owner cannot access the parking lot.

4. Click - to enable Vehicle Arming Group, and then click Add to arm the

vehicles you have just added.

1]
For arming group details, see "4.4.2.1 Creating Vehicle Arming Group".

e Add vehicles in batches
1. Click Import at the top, and then click Template Download.
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ECHNOLOGY

Figure 4-40 Download template

Import

2. Fillin the template, and then select Import > Import File. Click to select the file and
import.
L]
The platform supports downloading files that failed to import for you to check and
fix.
Step4  Click OK.

Step5 (Optional) You can export vehicle information to local storage as needed.

Figure 4-41 Export vehicle information

Encryption Password: Confirm Encryption Password:

Export Range:

Selected

- C ane El

e Click Export and then enter required information, such as passwords for login and

encryption, to export all the items.
e Select vehicles, and then click Export to export only the selected information.
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Related Operations
e You can search vehicles by entering keywords in search box at the upper-right corner.
e C(Click or double-click the column to edit the vehicle information.
e Click & to delete vehicles one by one. You can also select multiple vehicles and then click
Delete at the top to delete in batches.

4.4 Watch List Configuration

Configure face and vehicle watch list for future investigation.

e For face watch list, you can create and arm face comparison groups to recognize faces.

e For vehicle watch list, you can create vehicle comparison groups, add vehicles and then link
devices for plate recognition.

4.4.1 Face Watch List

Configure face watch list and issue the list to devices for recognition and alarm.

4.4.1.1 Creating Face Comparison Group

Prerequisites
e Make sure that the devices for face recognition have been successfully configured onto the
Platform.
e Make sure that the basic configuration of the Platform has completed. For details, see "3 Basic
Configurations". During the configuration, you need to pay attention to following parts.
¢ When adding devices on the Device page, set the Device Category to Encoder.
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Figure 4-42 Device category

9 Add Device

1.Login Information

Add Mode

| Encoder

IP Address: Device Port:

Username:

admin

Root

o When adding devices like NVR or IVSS which support face recognition, set the device feature
to Face Recognition. For details, see "3.2.2.5 Editing Devices".
Figure 4-43 Feature configuration
9 All Device

Features Keyboard Code

Output C

trol Channel

¢ Make sure that you have configured at least one disk with the type of Images and Files to
store face images. Otherwise, the snapshots cannot be displayed.

Procedure
Step1 Login to the DSS Client. On the Home page, click Y, and then click Watch List.
Step2 Click [ and then click Add at the upper-left corner to add face comparison group.
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Figure 4-44 Add face comparison group
9 Add Face Comparison Group

Face Comparison Group Name:

Color:

® Gray

Remark:

Step3  Enter the required information, and then click Add.

Related Operations
e You can search groups by entering key words in the search box at the upper-right corner.
e Click B to edit the group.
e Click & to delete the group.

4.4.1.2 Adding Face

Add person in the created comparison group.

Procedure
Step1 Login tothe DSS Client. On the Home page, click B, and then click Watch List.
Step2 Click B8, and then double-click the created group to add people.
Step3  Click Add at the upper-left corner, enter required information and then click OK to add
faces into the group or click Add and Continue to add more people.

e Enter basic information of the person such as ID (required and unique), name, gender
and more.

e Move your mouse to the image section, click Upload to select an image from local
storage. You can also click Snapshot to take a face photo on the spot if your PC
supports camera function.
¢ You can configure the capture parameters on the Snapshot page, such as camera,

resolution and more. The configurations are only effective for the current client.
o Certain devices support two face images for more accurate recognition. means
no uploaded face image and [@ means uploaded.
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Figure 4-45 Add a person

9 Add Person

xtended Info

Basic Information

Email:

Phone Number: Remark:

Extended Info

Cancel

Step4  Click to display and enter the Expanded Info, including nickname (display in VTO
contact), address, ID type and more.

Step5 Click OK.
e C(lick B atthe bottom of the created group to add people one by one.
e Click [ at the bottom of the created group to add multiple people at the same time.

Related Operations

You can search faces by entering key words in the search box at the upper-right corner.
Click to edit the person information.

Click [& to delete person from the group and face library one by one.

Click [ to remove person from the group but keep it in the face library. You can also select
multiple people and then click Remove at the top to remove in batches.

4.4.1.3 Arming Face

Arm the added faces to specified devices for future recognition and alarm.

Step1 Login tothe DSS Client. On the Home page, click B, and then click Watch List.

Step2 Click E, and then click [ of the face comparison group you want to arm.

Step3  Click Add, select one or more devices or channels, and then click OK.
The platform will send the information of the face watch list to the devices and channels
you selected, and display the progress. If exceptions occur, you can click . to see the

reason.
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Figure 4-46 Send face comparison group

end Face Comparison Group

Face Comparison Group: 1111

ted (3) =

e e, Send to Organization Operation
¥ B un Current Site
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Step4  After the face watch list is successfully sent, click Next Step.
Step5  Click Add, select the channels you want to arm, and then configure the similarity for each
channel.
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(11

When the similarity between the face captured by the channel and a face in the face watch
list reaches or is greater than the defined value, it is considered a match.

Figure 4-47 Arm face comparison group
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Step7  (Optional) View exceptions and arm the face comparison group again.

Step6  Click OK.

1) Click . to view why arming failed and address the issue.

2) Click Send Again to arm the face comparison group again.

4.4.2 Vehicle Watch List

Create vehicle comparison group and add vehicles in, together with Event configuration, you can
link devices like ANPR camera to recognize and reports to the Platform.

4.4.2.1 Creating Vehicle Arming Group

Step1 Login to the DSS Client. On the Home page, click , and then click Watch List.
Step2 Click E, and then click Add on the upper-left corner to add a vehicle arming group.
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Figure 4-48 Add a vehicle arming group

9 Add Vehicle Arming Group

Vehicle Arming Group Mame:

Vehicle Arming Group Color:

® Gray

Remark:

Step3  Enter the required information, and then click Add.

Related Operations
e You can search groups by entering key words in the search box at the upper-right corner.
e Click B to edit the group.
e Click [& to delete groups one by one. You can also select multiple groups and then click Delete
at the top to delete in batches.

4.4.2.2 Adding Vehicles

Vehicles in the watch list that has been armed will be recognized and you will receive alarms.

Procedure
Step1 Loginto the DSS Client. On the Home page, click , and then click Watch List.
step2  Click [BY
Step3  Click [ﬁ] of a group, or double-click a group, an then click Select from Vehicle List.

Step4  Select the vehicles you want to add, and then click OK.

Related Operations
e You can search vehicles inside a group by setting search conditions on the left.
e C(lick to edit the information of a vehicle.
e C(lick E] to remove vehicles from the group but keep it in the vehicle list. You can also select

multiple vehicles, and then click Remove to remove them in batches.
e Click Operation at the upper-right corner to select what vehicle information to be displayed.

4.4.2.3 Arming Vehicles

Link ANPR camera or other devices which support plate recognition to arm watched vehicles in real
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time. Once matched vehicles are detected, an alarm is triggered and reported to the Platform.
Log in to the DSS Client. On the Home page, click , and then arm the vehicle on the Event page.
Click Add. For how to configure events, see "4.1 Configuring Events".

Figure 4-49 Arm vehicle event

O Add Event

Event Source

Event Source Type o d Even Event Source

Device

Video Channel ) -
Intelligent Event ¥ B i Video

Alarm Input Channel

Access control Channel

Radar

Parking Lot

® High Risk Vehicle

4.5 Access Control

e Access control
Issue cards, collect fingerprints and face data, and apply permissions, so that the authorized
people can open door by using card, face or fingerprint.

e Advanced functions
Configure advanced access control rules such as First-card Unlock, Multi-card Unlock, Anti-pass
Back and Interlock to enhance security.

4.5.1 Preparations

Make sure that the following preparations have been made:
e Access control devices are correctly deployed. For details, see the corresponding user’s manual of
the device.
e Basic configurations of the platform have been finished. See "3 Basic Configurations" for details.
¢ When adding access control devices, select Access Control for device category.
o (Optional) On the Bind Resource page, bind video channels for access control channels.
o Personnel information is added correctly. For details, see "4.3 Personnel and Vehicle
Information Management".
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4.5.2 Configuring Door Groups

Configure door groups to include access permission of one or more access control devices.
Step1 Login to the DSS Client. On the Home page, click , and then in the App Config section,
select Access Control.
Step2  Click [EY.
Step3  Create a door group.
1) Click Add at the upper-left corner, or the Add Door Group tab.
2) Enter the group name, select a time template and a holiday schedule, select a device
channel, and then click OK.
After the time template and device channel are selected, the permission assigned to
personnel is valid only for period of the selected time template of the selected device
channel.

Figure 4-50 Add a door group

9 Add Door Group

Basic Info

Step4  Authorize.
1) On the Access Permission Group page, select a door group, and then click the
corresponding B icon.
2) Select personnel, and then click OK.

4.5.3 Configuring Access Permission Groups

Configure access permission groups so that you can quickly assign access permissions by door

groups.

Procedure
Step1 Loginto the DSS Client. On the Home page, click , and then in the App Config section,

select Access Control.

Step2  Click [,
Step3  Create an access permission group.
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1) Click Add at the upper-left corner.

Figure 4-51 Add an access permission group

9 Add Access Permission Group

Basic Info

ion Group Name:

Door Group

¥ Add @ Remove
@ Door Group Name Operation

Front Door (]

2) Enter the group name, and then select the door groups as needed.
3) Click Save and Add Person.
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Figure 4-52 Add a person

9 Add Person

Basic Info

ID:

24717897

Gender:

Unknown

Person Group: Email Address:

All Persons

Phone No.: Remarks:

Additional Info

Residence Info

Cancel

4) Enter the information from different sections. See "4.3.1.2.1 Adding a Person" for
details.
5) Click Add and Continue, and then click OK.

Related Operations
e Enter keywords in the search box at the upper-right corner, and then press the Enter key to
search for the groups you want.
e Double-click a group, and then click Add to add people. You can also click [ or [ to add
people to a group.
e C(lick to edit the name, door groups, and remarks of a group.
e Click B to delete a group; select the groups as needed, and then click Delete to delete them all.
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4.5.4 Configuring Public Passwords

Anyone with a pubic password can unlock associated doors. You can add up to 100 passwords.

[

Only second-generation access control devices and video intercom devices support this function.
tep1 Login to the DSS Client. On the Home page, click , and then in the App Config section,

:

select Access Control.

Step2 Click [E2.
Step3  Click Add, enter a name and a password, and then select the access control channels and

video intercom devices as needed.

Figure 4-53 Add a public password

9 Add Public Password

Basic Info

Select Access Control Channel

Channel Name Operation
e
e

Select Video Intercom Device

Cancel

Step 4 élick Save.
4.5.5 Configuring Advanced Functions

4.5.5.1 First Card Unlock

Only after the specified first-card user swipes the card every day can other users unlock the door
with their cards. You can set up multiple first-card users.
tep1 Login to the DSS Client. On the Home page, click , and then in the App Config section,

select Access Control.

:

Step2  On the Access Control page, click [Eg].
Step3  Click the First Card Unlock tab.
Step4  Click Add.
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Step5 Configure the parameters, and then click OK.

Figure 4-54 First card unlock configuration
Y First-card Unlock Config

frar Linlock by Mrst Cerd:

Cancel

Table 4-4 Parameters

Parameter Description

Door You can select which access control channel to use the first-card unlock
function.

Time Template First-card unlock is valid in the time period of the selected time template.

Status After first-card unlock is enabled, the door is in either the Normal mode or
Always Open mode.

User You can select one or more users to be first-card unlock users. Any one of
them swipes the card, and then other users can unlock the door.

Step6  Click -, and then it changes to [l The function is enabled.

4.5.5.2 Multi-Card Unlock

You can configure a door to be opened by a number of people in a defined order.
e You can add up to 50 people in a group. Each person can only be added to one group at the
same time.
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e [f you enable the multi-card unlock function for a door channel, you can select up to 4 multi-card
unlock groups of people to the door, but the number of people who need to verify their
identifications cannot exceed 5.

o |[f the first-card unlock and multi-card unlock functions are enabled on a door channel at the
same time, the platform will execute first-card unlock first.

e We do not recommend adding the people related to the first-card unlock function to a multi-card
unlock group. If a person related to the first-card unlock function and also in a multi-card unlock
function swipes a card, the platform will consider that the first-card unlock function is used.

e The access type of the people in a multi-card unlock group cannot be VIP or Patrol. This
parameter is configured when adding people to the platform. See "4.3.1.2 Adding Personnel".

1 Login to the DSS Client. On the Home page, click , and then in the App Config section,

select Access Control.

[94]
—
F

Step2  Onthe Access Control page, click .
Step3  Click the Multi-card Unlock tab.
Step4  Add a user group.

1) Click Add Multi-card Unlock Group.

2) Click Add.

3) Enter the group name, select users from User List and then click OK.
You can select up to 50 users.

Figure 4-55 Multi-card unlock group configuration
9 Multi-card Unlock Group Config

L
m
Operat..

&

Step5  Configure the multi-card unlock function.
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1) Go back to the Multi-card Unlock page, and click Add.
2) Select the door to use the multi-card unlock function.
3) Select the user group. You can select up to four groups.

Figure 4-56 User group information

O Multi-card Unlock Config

Q
B Multi-card Unlock Group Name  Quantity inloc 3 ty  NumberofV.. UnlockMode  Operation

4) Fillin the Valid Quantity for each group to be on site and the Open Door Mode. Click
B or [ to adjust the group order.

5) The valid quantity refers to the number of users in each group that must be on site to

swipe their cards, user their passwords, or press their fingerprints.

[1]
Up to five valid users are allowed.
6) Click OK.
Step6  Click - and then it changes to H The function is enabled.

4.5.5.3 Anti-passback

The anti-passback feature requires a person to enter and exit from the specific doors. For the same

person, an entry record must pair with an exit record. If someone has entered by tailing someone

else, which means there is no entry record, this person cannot unlock the door to exit.

Step1 Loginto the DSS Client. On the Home page, click , and then in the App Config section,
select Access Control.

Step2  On the Access Control page, click .
Step3  Click the Anti-passback tab.

Step4 Click Add.

Step5 Configure the parameters, and then click OK.
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Figure 4-57 Anti-passback parameters
© Anti-passback Config

Q + Add

Group 1

Doorl Reader 1 [

Table 4-5 User selection information description

Parameter

Description

Device

You can select the device to configure the anti-passback rules.

Anti-passback name

You can customize the name of an anti-passback rule.

Reset Time(min)

The access card becomes invalid if
an anti-passback rule is violated.

The reset time is the invalidity
duration.

Time Template

You can select the time periods to
implement the anti-passback rules.

(X'is a number)

Remark Description information.
The group sequence here is the
Group X sequence for swiping cards. You can

add up to 16 readers for each group.

Each group can swipe cards on any
of the readers.

[

When the selected device is a
multi-door controller, you
must set up these parameters.

Step6  Click - and then it changes to H The function is enabled.
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4.5.5.4 Multi-door Interlock

A regular access controller employs interlock within a group. To open one of the access control
channels (under normal access control), other access control channels must be closed; otherwise the
door cannot be unlocked. The A&C Central Controller employs interlock across groups, where the
access control channels within the same group are not interlocked, and can all be opened. However,
whenever an access control channel in a group is opened, no channels of other groups can be
opened. The configuration steps in this chapter are for an A&C Central Controller.

tep1 Login to the DSS Client. On the Home page, click , and then in the App Config section,

select Access Control.

d

Step2 Onthe Access Control page, click .
Step3  Click the Multi-door Interlock Config tab.
Step4 Click Add.

Step5 Configure the parameters, and then click OK.

Figure 4-58 Multi-door interlock

9 Multi-door Interlock Config

Device

Interlock Name:

Multi-door Interlock List

Group2 @

Table 4-6 Parameters

Parameter Description

Device You can select the device to set up inter-lock.
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Parameter

Description

Multi-door Interlock
Name

You can customize the name of the inter-lock rule.

Remark

Description information.

Multi-door Interlock
List

You can set up inter-lock across different
door groups. If a door in Group 1 is
opened, no doors can be opened in
Group 2 until all doors in Group 1 are
closed.

Supports up to 16 door groups, with up
to 16 doors in each group.

[1]

When the selected device is
a multi-door controller, you
must set up these
parameters.

Step6  Click -, and then it changes to [l The function is enabled.

4.5.5.5 Remote Verification

For devices with remote verification, when users unlock the doors with card, fingerprint, or password

in the specified time period, it must be confirmed on the platform client before the access controller

can be opened.

tep1 Login to the DSS Client. On the Home page, click , and then in the App Config section,

select Access Control.

:

N
—+ |+
D |

Click Add.

%)

—+
F

I

On the Access Control page, click [Eg].
Click the Remote Verification tab.

Figure 4-59 Add remote verification

9 Add Remote Verification

Step5 Select Time Template and access control channel, and click OK.
Step6  Click -, and then it changes to = The function is enabled.
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After the setup, door unlocking by card, fingerprint, or password that takes place in the

corresponding access control channel triggers a pop-up on the client.
You can choose to unlock the door or ignore it by clicking the corresponding button, and
the pop-up automatically disappears.

4.5.6 Configuring Time Templates

Configure time templates for different access control strategies. For example, employees can only
gain access to their offices during work time.
Step1 Login to the DSS Client. On the Home page, click , and then in the App Config section,

select Access Control.

Step2 Click H.
Step3  Click Create Time Template from the Time Template drop-down list when adding or

editing a door group.

Figure 4-60 Time template

Time Template

Copy From:

Monday:

Saturday:

o
o
o
o
o
o
o

Step4  Enter the template name, set time periods, and then click OK.
There are two ways to set time periods:
e Drag your mouse cursor on the time bars to select time sections. To remove a selected
time section, click on the time bar and drag.
e Click B and then set time periods in the Period Setup dialog box.

|

e You can add up to 6 periods for each day.
e To use an existing template, select the Copy From check box and then select a
template in the drop-down list.

4.5.7 Configuring Holidays

Step1 Login to the DSS Client. On the Home page, click , and then in the App Config section,
select Access Control.
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Step2 Click Add Holiday Schedule from the Holiday Schedule drop-down list when adding or
editing a door group.

Figure 4-61 Add a holiday schedule

9 Holiday Plan

2021-07-15 ~ 2021-07-16

Step3  Configure the parameters.

1. Enter a holiday schedule name.

2. Configure the periods in the Schedule section.

3. Click B to add a holiday: Enter the holiday name, set a start date, and how many days
this holiday lasts, and then this holiday will be effective within the periods you set from
the previous step.

Step4  Click Add.

4.5.8 Configuring Access Control Devices

After an access control device is added, and if it is online, you can restart it, and synchronize its time
with the platform.
Step1 Login to the DSS Client. On the Home page, click EY, and then in the Basic Config

section, select Device.

Step2 Click B
Step3  Select an access control device from the device tree.
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ECHNOLOGY

Figure 4-62 Select an access control device

¥ /i Root

» O 220

P 03 pyf-1

» A root
Step4  Configure the access control device.
o C(lick Restart Device to restart the device.
e Click [ atthe upper-right corner to go to the web page of the device.

4.5.9 Configuring Door Information

You can configure door status, Always-Open or Always-Close period, alarm and more.
Step1 Log in to the DSS Client. On the Home page, click EY, and then in the Basic Config

section, select Device.
Step2 Select a door channel in the device tree, and then click Door Config on the right.

Step3  Configure door information, and then click OK.
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Figure 4-63 Door configuration

9 Door Config
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5
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The page is only for reference, and might vary with different access control devices.

Table 4-7 Parameters description

Parameter

Description

Set reader direction

Indicates the in/out reader based on the wiring of ACS.

Door Status

Set access control status to Normal, Always Open, or Always Close.

NO Period

If enabled, you can set up a period during which the door is always
open.

NC Period

If enabled, you can set up a period during which the door is always
closed.

Door Sensor Enable

You can only enable intrusion and timeout alarms when the door
sensor is enabled.

Enable Alarm

e Intrusion: If the door is unlocked by methods you have not
configured, the door contact is split and triggers an intrusion
alarm.

e Unsuccessful Attempts Exceeding Limit: If failed to unlock the door
for certain times, an alarm will be triggered.

e Duress: Entry with the duress card, duress password, or duress
fingerprint triggers a duress alarm.

e Timeout: Unlock duration timeout triggers a timeout alarm.

Public Password

Enable this function, and then you can use a public password to unlock
the door. For how to configure a public password, see "4.5.4
Configuring Public Passwords".
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Parameter

Description

Unlock Duration

Sets up for how long the door will unlock. The door locks automatically
after the duration.

Unlock Timeout

Unlock duration exceeding the Unlock timeout triggers a timeout
alarm.

Multi-door interlock

Select whether to enable your multi-door interlock configuration. See
"4.5.5.4 Multi-door Interlock”.

Unlock Method

You can use any one of the methods, card, fingerprint, face, and
password, or their combinations to unlock the door.

e Select And, and select unlock methods. You can only open the
door using all the selected unlock methods.

e Select Or and select unlock methods. You can open the door in
one of the ways that you configured.

e Select Unlock by period and select unlock mode for each time
period. The door can only be opened by the selected method(s)
within the defined period.

4.6 Video Intercom

4.6.1 Preparations

Make sure that the following preparations have been made:

e Access control devices are correctly deployed. For details, see the corresponding user’'s manuals.

e Basic configurations of the platform have been finished. To configure, see "3 Basic

Configurations".

¢ When adding video intercom devices on the Device page, select Video Intercom as the

device category.

¢ When adding access control devices that support intercom, select Device Category to

Access Control in Login Information, and then select Door Station access Controller or

Fence Station Access Controller according to the type of your device.

[

e The platform automatically creates a room after you add a VTH. For details, see "4.6.4 Configuring

Room".

e Any configuration modification on the device will not be reported to the platform. You need to

go to the device modification page of Web Manager to manually synchronize the modification.

4.6.2 Call Management

Create call group, management group and relation group respectively and define restricted call

relations. This function is only available for administrators.
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A\

Click on the page of call group, management group or relation group, the system will restore
management group and relation group to their original status.

4.6.2.1 Configuring Call Group

VTOs and VTHSs can only call each other when they are added into the same call group. DSS will
automatically generate corresponding call group when VTO, second confirmation station and fence
station are added.

e Add VTOs and access control devices that support intercom, and then a device group will be
automatically generated. Add VTHs from the same unit into the group, and realize mutual call
between VTH and VTO within the group.

e Add second confirmation stations and automatically generate a call group. Add them to the
group together with the VTHs of the same room, and realize mutual call between VTHs and
second confirmation stations within the group.

e Add fence stations and automatically generate a call group. Add all the VTHs into the group to
realize mutual call between fence stations and all the VTHs.

e Add VTHs. If the VTHs are connected to unit VTO, second confirmation station, fence station, they
will be automatically added to the call group, and realize mutual call among unit VTOs, second
confirmation stations and fence stations.

VTHs from different call groups can call each other only when there is a fence station is each
group.

4.6.2.2 Adding Management Group

Management group is to make groups for administrators, and realize relation binding of one to one,
one to many or many to many. Administrators include DSS administrator and VTS. If there is a default
management group, VTS will be automatically added to the management group when it is added.

B

Before configuring management group, you need to create users, select video intercom menu
permission and device permission, and add new users to the management group.
tep1 Login tothe DSS Client. On the Home page, click EY, and then in the App Config section,

:

select Video Intercom.

Step2 Click B

Step3 Click Manager Group Config.

Step4 Click Add Group.

Step5 Enter group name, select administrator account or VTS, and click OK.

The added management group is displayed in the list.
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|

e To transfer members, click and move the member to other groups.
e To manage group members, click to add or delete group members.

Figure 4-64 Edit manager group
Add Manager Group

Group Name:

Control Permissions Selectad(0)

Select All

system

000000?

000

Cancel

4.6.2.3 Configuring Group Relation

Link call groups and management groups, and VTOs or VTHs in a call group can only call

administrators or VTSs of a linked management group. There are two situations for creating relation:

e A call group only links to one management group.

Any device in the group can call administration with one click, all the bound administrators
within the management group will generate ring bell. At this moment, all other ring bells will
stop as long as there are no administrator answers. The device call request can be rejected as
long as all the administrators reject to answer.

A call group links to several management groups.

There is priority among several management groups. When any device in the group calls
administrator with one click, and all the online administrators of management group with
highest priority will generate ring bell. If no administrator answers, then it will call next
management group. The interval between two calls is 30 seconds; it can skip up to one
management group. If neither of two groups answer, then the device prompts call overtime, no
response.

Step1 Login to the DSS Client. On the Home page, click Y, and then in the App Config section,

select Video Intercom.

N

Step Click El.
Step Click Relation Group Config.

w

132



@hua .
TechNoLoaY User's Manual

Step4  Click Add.
Step5 Enter a name, select call group and management group, and then click OK.

Figure 4-65 Add a group relation
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Cancel

Added relation group is displayed in the list. If there are several relation groups, you can
click [ or [ to adjust priority level. When there is a call, the online administrators with
the highest priority will generate ring bell first.

4.6.3 Configuring Building/Unit and Call Mode

Make sure the status of building and unit of the DSS client is the same as the VTO. If building and

unit are enabled on the platform, they must also be enabled on the device, and vice versa; otherwise,

the VTO will be offline after being added. That also affects the dialing rule. Take room 1001 unit 2

building 1 as an example, the dialing rule is as follows:

e If building is enabled while unit is not, the room number is "141001".

e If building is enabled, and unit is enabled as well, the room number is "1#2#1001".

e If building is not enabled, and unit is not enabled either, the room number is "1001".

Step1  Login to the DSS Client. On the Home page, click EY, and then in the App Config section,
select Video Intercom.

Step Click [R.
Step Enable or disable building and unit as required, and then click OK.

A\

This configuration must be the same as the device configurations. Otherwise, information

w N

of the devices might be incorrect. For example, if only Building is enabled on a VTO, you
must only enable Building on the platform.
Step4  Configure the call mode.

e Simultaneous Call: When a room is being called, all the VTHs and App users in it will
receive the call. If there are only App users in the room, then all App users will receive
the call.

e Group Call: When calling a room, only the VTHs in it will receive the call. If call
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Step 5

forwarding is enabled on the VTHSs, then all App users will receive the call.
Click Save.

4.6.4 Configuring Room

Add a room to include the VTHs and App users in it.

When you add a VTH to the platform, the platform will automatically create a room. You can also

create a room and add the VTH later. The VTH will automatically join the corresponding room. The

rooms that are automatically created cannot be deleted. You can only delete those that are manually

created.
Step 1

N

Step
Step

w

Log in to the DSS Client. On the Home page, click EY, and then in the App Config section,
select Video Intercom > Room Config.

Click Add.

Select an organization, enter a name for the room and the room number, and then click
Add.

If the VTH with the same room number has been added to the platform, or the homeowner
with the same room number has registered, the VTH or the App user will join the room
automatically.

Related Operations
Operations on the App users:

° @: Set an App user to be the homeowner after it is linked with a person.

° : Reset the password of an App user. The App user will need to log in to the App with the new

password.

e [E5]: Link an App user to a person.
° Hz Delete an App user.

4.6.5 Synchronizing Contacts

Synchronize contacts information to VTO and then you can view contacts on the VTO or its web
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Log in to the DSS Client. On the Home page, click Y, and then in the App Config section,
select Video Intercom.

Click .

Select an organization node (VTO), and then click Send Contacts.

Select one or more VTHs as needed, and then click OK.

Now you can view contacts on the VTO or web page.

4.6.6 Setting Private Password

Set room door passwords so that the room door can be opened by entering password on the VTO
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(outdoor station).

B

Make sure that contacts are sent to the VTO; otherwise you cannot set private password.

Step1 Log in to the DSS Client. On the Home page, click EY, and then in the App Config section,
select Video Intercom.

Step2  Click EA.

Step3  Select a VTO, and then you can see all the VTHs linked to this VTO.

Step4  Selecta VTH and click [@, or select several VTHs and click Change Password.

Step5  Enter password, and then click OK.
You can use the new password to unlock on the VTO.
[
The format should be room number + private password, and the room number consists
of 6 digits. For example, a person who lives in 1001 with the private password of the VTO in
the building being 123456, can enter 001001123456 to unlock the door.

4.6.7 QR Codes

Configure the information of the QR codes that are used by homeowners to download the App and

register an account.

Step1  Login to the DSS Client. On the Home page, click EY, and then in the App Config section,
select Video Intercom > QR Codes.
Step2  Enter a name and some notes for your community, and then click Save.
Homeowners can scan the QR Code for App Download to download and install the App
on the phone, and then scan the QR Code for App Registration to register. For how to
register, see the user manual of the App.
4.6.8 App User

You can view information of App users, freeze user, modify login password and delete user.

Prerequisites

App users have registered by scanning the QR code on the platform or the VTH. For details, see the

user manual of the App.

Procedure
Step1 Login to the DSS Client. On the Home page, click EY, and then in the App Config section,
select Video Intercom.
Step2  Click E.
Table 4-8 Parameter description
Operation Description
The App user cannot log in for 600 s after being frozen.
Freeze APP user The account will be frozen when invalid password attempts exceeds 5
by an App user.
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Operation Description

Click and enter a new password on the Reset Password page, and

then click OK.
Change APP user m
login password e The password must be 8 to 16 characters and must include numbers
and letters.

e C(Click @ todisplay password, or ™ to mask password.

Click B to delete App users one by one, or select multiple App users,

Delete APP user click Delete, and then follow the instructions to delete the users.

4.7 Attendance Management

Configure attendance devices, attendance shifts and periods, so as to manage attendance records
and reports.

4.7.1 Preparations

Make sure that the following preparations have been made:
e Attendance devices are correctly deployed. For details, see the corresponding user’'s manuals.
e Basic configurations of the platform have been finished. To configure, see "3 Basic
Configurations".
¢ When adding attendance devices on the Device page, select Access Control as the device
category.
o Personnel information is added correctly. For details, see "4.3.1 Configuring Personnel
Information".

4.7.2 Configuring Attendance Terminal

Make sure that access controller is used as the attendance device for check-in and check-out,

recording attendance information, and uploading attendance data.

Step1 Login to the DSS Client. On the Home page, click EY, and then in the App Config section,
select Attendance.

Step2  Select Attendance Config > Attendance Terminals.
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Figure 4-66 Attendance terminal

(o} Attendance Terminal Name Device Name Operation

(]
L]
-]

Step3  Select access control channels, and then click Save.
L]

You can enter keyword and search for devices.

4.7.3 Configuring Statistics Rule

The smallest timing unit of swiping card is minute. Seconds will be rounded up or down. For

example, if you swipe your card at 09:00:01 and the rule is set to round down, then the time of you

swiping the card is 09:00; if the rule is set to round up, then the time of you swiping the card it is

09:01.

Step1 Login to the DSS Client. On the Home page, click EY, and then in the App Config section,
select Attendance.

Step2  Click Elon the left, and then select Statistics Rule.

Figure 4-67 Statistical rule
Set Rounding off Rule:

rded in minutes. Att: nce time is calculated in hours, roun digit after the decimal.

Step3 Select arule, and then click Save.

4.7.4 Synchronizing Attendance Records

The platform will synchronize attendance records from selected devices at the defined time. The
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attendance report will be updated if new records are synchronized to the platform.

The platform also supports synchronizing attendance records manually. For details, see "5.4.4

Viewing Attendance Data".

Step1 Login to the DSS Client. On the Home page, click EY, and then in the App Config section,
select Attendance.

Step2  Select Auto Sync Record.

Step3  Click I to enable this function.

Figure 4-68 Automatically synchronize attendance records

AutoSync —®

Step4  Configure the time, and then select access control devices.
Step5 Click Save.

4.7.5 Configuring Attendance Period

Set attendance period, which can be used as time evidence to judge if a person is late, on time, or
leaves early.
tep1 Login to the DSS Client. On the Home page, click EY, and then in the App Config section,
select Attendance.

:

Step2 Click B
Step3  Click Add on upper-left corner of the page.
Step4  Set parameters of attendance period.

e Fixed attendance requires you to sign in and sign out during the fixed hours.
Click to add another working period. You can set up two working periods at most.
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Table 4-9 Fixed attendance parameters

Parameter Description
Period Name C.ustom perlod name, used to recognize period, such as early shift and
night shift.
Set corresponding color of period, and corresponding color will be
Color directly displayed on calendar when making shift for personnel, and

quickly identify shift information.

Attendance Mode

Set as Fixed Attendance.

Working Time

Set corresponding working hour of period. Attendance time supports
cross-day, but not exceeds 24 hours. One attendance period supports
max two types of attendance time.

Working Hour

Fill in according to actual situation.

Valid Check-in Time

If working time is set from 09:00 to 18:00, then valid sign-in time can be
set as 08:00-10:00, valid sign-out time can be set as 16:00-18:00.

Configuration rules are as follows:

e The start time of valid sign-in time is earlier than or equal to start
working time (09:00), the end time of valid sign-in time should be
later than start working time (09:00), earlier than start time of valid
sign-out time. If there are several sign-in records within valid sign-in
time, then the earliest record is considered as sign-in time.

e The start time of valid sign-out time is later than the end time of
valid sign-in time, earlier than end working time (18:00), the end
sing-in time of valid sign-out time is later than or equal to end
working time (18:00). If there are several sign-out records within
valid sign-out time, then the earliest record is considered as sign-
out time.

Valid Check-out Time

If working time is set from 09:00-18:00, then valid sign-in time can be
set as 08:00-10:00, valid sign-out time can be set as 16:00-18:00.

Configuration rules are as follows:

e The start time of valid sign-in time is earlier than or equal to start
working time (09:00), the end time of valid sign-in time should be
later than start working time (09:00), earlier than start time of valid
sign-out time. If there are several sign-in records within valid sign-in
time, then the earliest record is considered as sign-in time.

e The start time of valid sign-out time is later than the end time of
valid sign-in time, earlier than end working time (18:00), the end
sing-in time of valid sign-out time is later than or equal to end
working time (18:00). If there are several sign-out records within
valid sign-out time, then the earliest record is considered as sign-
out time.

Shall check in

If you set two working time, then the second working time can cancel
sign in, you don’t have to sign in when you work at the second working
time, and the start time of working time can be used as sign-in time.

Shall check out

If you set two working time, then the first working time can cancel sign
in, you don’t have to sign out when you finish work at the second
working time, and the end time of working time can be used as sign-
out time.
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Parameter

Description

Allow Late Time
(Minutes)

Allow Early Time
(Minutes)

Absence TimeOn duty
_ minute later.

Absence TimeOn duty
_ minute earlier.

Define the rules for being late, absence and early leave. Take the values
in the snapshot as an example.

® Checkin on time: Check in no later than 5 minutes.

e Later: Checkin 5 minutes later, but no later than 30 minutes.

e Absence: Check in 30 minutes later or check out 120 minutes
earlier.

® |Leave on time: Check out no earlier than 5 minutes.

e |eave earlier: Check out 5 minutes earlier, but no earlier than 120
minutes.

o Overtime: Check out 60 minutes later.

OvertimeOff duty _
minte later.

Define overtime rule.

If it is set to 120 minutes, off duty check-out time is later than end time
of working time, and period >120 minutes, then it is recorded as
overtime, overtime period is Period- 120 minutes.

e Flexible attendance just calculates whether the daily working hours of a person meets

the rule according to the sign-in/out time.

Table 4-10 Free attendance parameters

Parameter

Description

Period name

Custom period name, used to recognize period, such as flexible
attendance.

Attendance mode

Set as Flexible Attendance.

Set corresponding color of period, corresponding color will be directly

Color displayed on calendar when making shift for personnel, and quickly
recognize shift information.
Work Time Set the period you must work in a day.

Working Hours

Set how many hours you have to work a day. For example, if you set 8,
then it means you are required to work 8 hours.

Valid Check-in Time

Sign in after restricted time is recorded as late.

Valid Check-out Time

You are required to sign out before the designated time, otherwise no
sign out is recorded.

Must Check In/Out

You must check in or check out within the defined period.

[

If you have configured 2 or mo re attendance periods, you can select
which within period people must check in or out.

Minimum OverTime
Work (Hours)

For example, working hour is 8 hours a day, and if you work overtime
for 2.5 hours, then it is recorded as overtime, then you can set 10.5 here.

Cumulate Time For
Every Two
Punches.Minimum
Time Interval Between
Every Two Punches
(Minutes)

Swipe card at odd number is recorded as check-in. For example, the
first card-swiping is check-in. Swipe card at even number is recorded as
check-out. For example, the second card-swiping is check-out. It is
recorded swiping the card twice when the interval of two continuous
card swiping is larger than the defined value.

Step 5

Click Save.
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If attendance period is already applied to attendance shift, then before deleting
attendance period, go to Attendance Shift, disable the attendance period in the
attendance shift, and then delete the attendance period you want.

4.7.6 Configuring Holiday Plans

Set holiday time to determine overtime type.

Step1  Log in to the DSS Client. On the Home page, click Y, and then in the App Config section,
select Attendance.
Step2  Click [=].
Step3  Click Add on the upper-left corner.
Step4  Configure the information.
Figure 4-69 Add a holiday
© Add Holiday
Holiday Name:
Holiday Mode:
Fixed Date
Holiday Lenght (Days):
1
Table 4-11 Holiday parameters
Holiday mode Description
Set some specific date as holiday. For example, set May 1, 2019 (Labor's
Fixed Date day) as holiday, and lasts for 1 day, then set Start Date as May 1, 2019 and
Holiday Days as 1.
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Holiday mode

Description

Date Cycle

If the holiday is the fixed weekday of some week in some specific month,
and it cycles according to year, which can be configured as date cycle. For
example, if you want to set Mother’s Day as holiday, and it lasts for 1 day,
then you can set Start Date as the second Sunday in May, and Holiday
Days as 1.

Year Cycle

If the holiday is fixed date and it cycles according to year, which can be
configured as year cycle. For example, set New Year’s Day as holiday, and it
lasts for 1 day, then you can set Start Date as January 1 and Holiday Days
as 1.

Step5  Click Save.

4.7.7 Configuring Attendance Shift

Set attendance shift according to attendance period, used for department and personnel shift.
tep1 Login to the DSS Client. On the Home page, click £Y, and then in the App Config section,

:

select Attendance.

Click [E.

| |
Dl e
oW IN

day.

Click Add on the upper-left corner of the page.
Set shift details, select a day, and then click Apply to arrange attendance period for the
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Figure 4-70 Configure attendance shifts
D Add Shift

Shift Name:

® Daily cycle. Startfromday 1.

Day1 Day2 Day 3 Day4 Day3 Day 6 Day7

© © ¢ o o o o

Period Name  Time Interval Opera...

Cancel

Table 4-12 Attendance shift parameters

Parameter Description
Shift Name Custom period name, used to recognize shift.
Cyclic Mode Day: Start cycle from the first day, cycle period can be set as any number

from 1 to 31 according to day. For example, if you set 2, then the cycle
period is 2 days.

Week: There are 7 days in a week by default, it starts cycle from Sunday,
and so Sunday is required to be set as the first day. Cycle period can be
set as any number from 1 to 4. For example, if you set 2, then 2 weeks can
Cyclic Period (Days) | bea cycle period.

Month: There are 31 days in a month by default, it starts cycle from the
current day (If the date does not exist, then it will be deleted during shift
arrangement), cycle period can be set as any number from 1 to 3
according to month. For example, if you set 2, then 2 months can be a
cycle period.

Step5 Click Save.
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Delete in-use attendance shift: Go to Shift Management > Person Shift, check if there are
shifts to be deleted; if yes, remove the relation, and then delete.

4.7.8 Shift Management

Arrange shifts for personnel or department. You can also arrange temporary shift for personnel. The
shift priority is temporary shift > holiday > personnel shift > department shift.

4.7.8.1 Personnel/Department Shift Arrangement

The operations for personnel shift and department shift are similar. This section takes personnel shift

as an example.

e If you configure department shift, then all the personnel of the department need to conform to
the shift.

e If both personnel and department are configured with shift, then the latest personnel shift shall
prevail. For example, after configuring the personnel shift, and the corresponding department is
configured as well, then personnel shift is based on the latest department shift.

o If the department where new personnel belong to is configured with shift, then the shift of new
personnel should conform to department shift.

Step1 Click B on the Attendance page.

Step2 Click [} on the upper-left corner of the page.

e If you need to configure shift for department, click B on the upper-left corner and
enter the page of department shift arrangement. The following operation is the same
as personnel shift arrangement.

e Click [ next to the personnel and you can view the shift details.

Step3  Select shift personnel, click [ to add shift information.
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5 Person Shifts

Select Shift

Select Person

Figure 4-71 Select shifts

Table 4-13 Parameter description

Parameter Description
Start Time Set start date and end date of personnel shift. Click the column of Start
] Time and display calendar, select date and time, and then click OK to
End Time complete date setting
Shift Select the one you need. See "4.7.8.1 Personnel/Department Shift
Arrangement”.

Step4  Click Save.

4.7.8.2 Temporary Shift

Arrange a temporary shift when needed.

Step1 Click B on the Attendance page.

Step2  Select personnel and date.
Step3  Click [ and then click Reset to select an attendance shift as needed. You can add max. 2

attendance periods and 1 free attendance period.
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Figure 4-72 Temporary shift

9 Temporary Shifts

Select Shift

Period Name Operation

SelectPerson

00000864

00004514

Step4  Click OK and save shift information.

1]
Temporary shift can be deleted, right-click the date which is configured with temporary
shift, and delete temporary shift according to system prompt.

4.8 Visitor Management

After appointment is made on platform, and visitor information is registered, the visitor can have
access permission. Access permission is disabled after the visitor leaves.

4.8.1 Preparations

e Access control devices have been added into the platform.
e Basic configurations of the platform have been finished. To configure, see "3 Basic

Configurations”.

4.8.2 Configuring Visit Settings

Step1 Login to the DSS Client. On the Home page, click EY, and then in the App Config section,
select Visitor.
Step2 Configure the parameters.
e Automatic visit
Enable the function, and then select the channels as needed. Visitors with appointment
can verify their identities on the selected channels without registering.
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e Automatic leave

¢ Enable the function, and then select the channels as needed. Visitors who are
visiting can verify their identities on the selected channels to end their visits
automatically.

o Sign out regularly: Expired visits will be automatically ended at the defined time
point.

o Daily sign-out time: For visitors who do not arrive for their appointment before the
daily sign-out time, their appointment will be cancelled.

o Sign out now: For visitors who missed their appointment when you click this
button, their appointment will be cancelled.

e Default visitor permissions: Set default access permissions for visitors.

e Email template: You can set up an email template and automatically send emails when
visitors make an appointment, arrive for their appointment, and end their visit. You can
customize the email subject and content with the visitor information, such as visitor's
name and ID number.

e Visitor pass remarks: Customize the content of remarks on a visitor pass.
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Figure 4-73 Customize visitor pass remarks

Figure 4-74 Visitor pass remarks

Visitor Pass

|
The passizvalid only within the visit period.
Please generate a new pass after the period.
Tony
Phone Mao.:
Plate Mo.:
1D Mo.:

Remarks: Welcome!

Validity: 2021-07-20 19:31:52 - 2021-07-20 21:31:52

Step3  Click Save.

4.9 Parking Lot

Control vehicle entrance and exit control with the functions such as ANPR, number of parking space,
alarm, and search. In case the vehicle is not recognized by the ANPR camera, visitors can use VTO to
call the management center, and then the management center can remotely open the barriers after
verifying the identity of the visitor.

4.9.1 Preparations

Make sure that the following preparations have been made:

e Devices, such as ANPR cameras, parking space detectors, VTOs, barriers, and displays for available
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parking spaces, are added to the platform.

e Basic configurations of the platform have been finished. To configure, see "3 Basic

Configurations".

0o

When adding an ANPR camera, select Access ANPR Device as the device category.

After you have added ANPR cameras, you can bind video channels to their channels. This is
useful when you have installed other cameras at the entrance to view and record videos of
the entire scene, not just the vehicle. You can view video from the bound camera when
checking the alarm details. For how to bind channels, see "3.2.3 Binding Resources".

When adding an NVR, select Encoder as the device category.

Select Entrance ANPR from Features for the corresponding NVR channels.

When adding VTO, select Video Intercom as the device category.

Also, you need to add the information of people and assign them permissions so that they
can use the VTO normally. For details, see "4.3 Personnel and Vehicle Information
Management".

[

Make sure that the configuration of building and unit on the DSS client is the same as the
device. If building and unit are enabled on the platform, they must also be enabled on the
device, and vice versa. Otherwise, the VTO will be offline after being added. For details, see
"4.6.3 Configuring Building/Unit and Call Mode".

Add a screen.

Add a display for available parking space. Select Display Device as the device category.
Dahua screen and Jiuzhou screen are supported as the display for available parking space.
Snapshots taken by ANPR cameras are stored in the Images and Files disks. You must
configure at least one Images and Files disk so that snapshots of vehicles can be normally
displayed. For details, see "3.4 Configuring Storage".

4.9.2 Configuring Parking Lot

A parking lot includes parking spaces, entrances and exits, barrier control rules and other

information. Link an ANPR camera for recognizing license plates, and a VTO for verifying identities.

4.9.2.1 Basic Information

Procedure
Step1 Login to the DSS Client. On the Home page, click Y, and then in the App Config section,
select Parking Lot > Parking Lot Configuration > Parking Lot Basic Config.
Step2  Click the root node named Current Site, and then click Add.
Step3  Configure the basic information of the parking lot, and then click Next Step.
Table 4-14 Parameter description
Parameter Description
Parking Lot Name To differentiate from other parking lots.
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Parameter Description

e Count parking spaces by entering and exiting vehicles:
Set up the total and available parking spaces in the parking
lot, and then the parking spaces will be automatically

Enable Parking Space counted based on each vehicle that enters or exits the

Counting parking lot.

e Count parking spaces using parking space detectors:
After parking space detectors are added to the platform and
configured, parking spaces will be automatically counted.

e First Character Rule

o 1 character added to the front of the plate number: It will
still be considered as a match when an additional
character is added to the plate number. For example,
AB12345 is recognized as AAB12345.

o Missing the first character of the plate number: It will still
be considered as a match when the first character is
missing from the plate number. For example, AB12345 is
recognized as B12345.

e |ast Character Rule

o 1 character added to the end of the plate number: It will
still be considered as a match when an additional
character is added to the end of the plate number. For
example, AB12345 is recognized as AB123455.

o Missing the last character of the plate number: It will still
be considered as a match when the last character is

Fuzzy Match of Entrance & missing from the plate number. For example, AB12345 is

Exit Plate No. Snapshot recognized as AB1234.

e Misread Character Rule: It will still be considered as a match if
a character is recognized incorrectly, but the number of
characters are correct. For example, AB12345 is recognized as
AB12B45.

|

When you enable multiple rules, the platform will check if each
rule is satisfied. Only when one or more rules are satisfied will
platform consider it to be a match. For example, 1 character
added to the front of the plate number, and missing the first
character of the plate number are both enabled. When the plate
number AB12345 is recognized as AAB12345, it satisfied 1
character added to the front of the plate number, but not
missing the first character of the plate number. This will be
considered as a match. If the plate number AB12345 is
recognized as AB112345, it does not satisfy both rules. This will
not be considered as a match.
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Parameter Description

Auto overwrite when If a vehicle entered the parking lot but has not exited, a new
captured vehicle has not entry record will be generated when the vehicle is recognized to
existed have entered again.

Step4  Configure the entrance and exit points, and then click Next Step.
L]

The platform supports up to 60 entrances and exits.

1) Click [: or Add Entrance and Exit Point.

2) Enter a name, and then click OK.

3) If there is an entrance point, click ﬂ next to Entrance.

4) Enter a name for the point, select a capture mode, and then add a camera, video
intercom device (optional), or information display (optional).
If limited by the surroundings, you can install two cameras for this point, and then set
Capture Mode to Dual Camera to improve the successful rate of recognition number
plates.
In Dual Camera mode, the vehicles captured by the two cameras within the defined
Dual Camera Coordination Time will be considered as the same one. You must
configure the time properly according to the installation positions of the cameras and
the distance between them.

Figure 4-75 Entrance point configuration

[+ Entrance *

-
Entrance W&

Entrance Name

License Plate Snapshot and Recognition

® Dual Camera

® Online

Information Display

5) If there is an exit point, click [: next to Exit, and then configure the parameters.

The parameters are similar to the ones in Entrance. For details, see the steps above.
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Step5  Configure the passing rules, and then click Next Step.
1) Select a vehicle entrance rule, and then configure the parameters.

Table 4-15 Parameter description

Parameter Description

e Registered Vehicles Access Rule
Click Add, and then select By Parking Lot or By Point.

By parking lot: The vehicle groups will be added to all entrance
and exit points of the parking lot, and the vehicles in these
group can enter and exit through any entrance or exit.

By point: You can add different vehicle groups to different

Registered Vehicles entrance or exit points. For example, vehicle group is added to
East entrance but not South entrance, then the vehicles in the
group can only enter the parking lot through East entrance.

e Allow Passage When Available Space is 0: After enabled,
vehicles are allowed to enter the parking lot even if there are
no available parking space.

Click - to enable this function for an entrance point.

All vehicles can enter the parking lot.
e Vehicles on the Blocklist to Enter: After enabled, vehicles on
the blocklist are also allowed to enter the parking lot.
e Registered Vehicles Access Rule
Click Add, and then select By Parking Lot or By Point.
All Vehicles By parking lot: The vehicle groups will be added to all entrance
and exit points of the parking lot, and the vehicles in these
group can enter and exit through any entrance or exit.
By point: You can add different vehicle groups to different
entrance or exit points. For example, vehicle group is added to
East entrance but not South entrance, then the vehicles in the

group can only enter the parking lot through East entrance.
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Parameter Description

You can customize the passing rule for the entrance.

e For how to configure Registered Vehicles Access Rule and
Allow Passage When Available Space is 0, see the content
above.

e All Vehicles: Select a default time template or create a new
one, and then any vehicle can enter the parking lot within the
specified duration.

For how to create a new time template, see "3.2.6 Adding Time
Template".

e Open Barrier by Verification: After enabled, the access
permission of a vehicle must be verified, and then an
administrator can manually open the barrier for it. If Open
Barrier by Card Swiping After Verification is also enabled,
the driver can swipe a card, and then the barrier will
automatically open if the can verify the driver to be the owner
of the vehicle.

e Open Barrier by Card Swiping Without Verification: The

Custom barrier will automatically open if the card has access
permission.

[

You can enable Open Barrier by Verification or Open Barrier
by Card Swiping Without Verification at the same time.
e Available Parking Space Counting:

[

You must enable parking space counting and select Count
parking spaces by entering and exiting vehicles.

¢ Count each vehicle as an occupied parking space: The
number of parking spaces decreases after a vehicle enters.

¢ Count each unregistered vehicle as an occupied parking
space: The number of parking spaces decreases only after a
vehicle that is not registered to the platform enters.

¢ Custom: Configure which vehicles in the vehicle groups will
be used to calculate parking spaces.

G
For how to configure vehicle groups, see "4.9.3 Managing Vehicle Group".

2) Select a vehicle exit rule, and then configure the parameters.
The parameters are similar to the ones in the entrance. See the previous step.

3) Enable Send Plate No. to Devices, and then add vehicle groups to the allowlist and
blocklist.
Devices can use this information to determine which vehicles to let in when the
platform is offline.
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Step 6

Step 7

(Optional) Configure parking space detectors, and then click Next Step.

|

If you do not need to calculate parking spaces by using parking space detectors, you can
skip this step and click Next Step.
1) Click Add or Add Parking Space Detector.

You need to add parking space detectors to the platform first. For how to add parking
space detectors, see "3.2.2 Managing Device".
2) Select the parking space detectors that belong to this parking lot, and then click OK.
(Optional) Configure indoor and outdoor parking space available displays, and then click
Save and Exit.
1) Click Add, and then select the displays that belong to this parking lot, and then click
OK.
2) Click of an outdoor parking space available display, select the color and what to
display when available parking space is 0, and then click OK.
3) Click [H of an outdoor parking space available display, select a parking space
counting mode, and then click OK.
If you select Count parking spaces using parking space detectors, two options are
available:
e Selected Parking Spaces: Only count the parking spaces of the parking space
detectors you select.
e Count parking spaces by parking space detectors: Count the parking spaces
from all parking space detectors in this parking lot.
4) Click of an indoor parking space available display, select the arrow position and
the color, and then click OK.
5) Click [H of an indoor parking space available display, select a parking space counting
mode, and then click OK.
6) Click [H of an indoor parking space available display, configure a parking space
counting mode for each direction, and then click OK.
If you select Count parking spaces using parking space detectors, two options are
available:
e Selected Parking Spaces: Only count the parking spaces of the parking space
detectors you select.
e Count parking spaces by parking space detectors: Count the parking spaces
from all parking space detectors in this parking lot.

Related Operations

[F: Edit the passing rules of the parking lot.

[F]: Edit the available parking space of the parking lot.
IB: Edit the information of the parking lot.

B: Delete the parking lot.
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4.9.2.2 Reserved Parking Space

Link a parking space to one or more plate numbers. Alarms will be triggered if vehicles with other

plate numbers park in this parking space.

Step1 Login to the DSS Client. On the Home page, click EY, and then in the App Config section,
select Parking Lot > Parking Lot Configuration > Reserved Parking Space Config.

Step2  Select a parking lot, and then click Add.

Figure 4-76 Link a parking space to plate numbers

Add Reserved Parking Space

Vehicle Group = VIP

Owner Name

Total 7 Record(s) . 20 per Page

Ok Cancel
Step3  Select a parking space you want to link plate numbers to, a vehicle group, and one or more
plate numbers, and then click OK.

4.9.2.3 Parking Lot Layer

Add a plan view image to the parking lot, and then mark the entrance and exit points, parking
spaces, parking space available displays, and monitoring devices on it, so that you can manage the
parking lot in an intuitive way. If the parking lot has multiple floor, you can add an image for each

floor.

Step1  Login to the DSS Client. On the Home page, click EY, and then in the App Config section,
select Parking Lot > Parking Lot Configuration > Parking Lot Layer Config.

Step2  Select a parking lot, and then click Add.

Step3  Enter a name for the layer, upload an image, and then click Save and Configure Layer.

Step4 Drag an entrance or exit point to the image, and then click Next Step.

Step5 Drag a parking space to the image, adjust its size and direction, and then click Next Step.

155



@hua .
TEcHNoLOGY User's Manual

Figure 4-77 Mark a parking space
L
=3

5 |

53 3 3

Pl 3

3 3 3

Step6 Drag a parking space available display to the image, and then click Next Step.
Step7 Drag a channel of a monitoring device to the image, and then click Next Step.

Related Operations
o [N Edit the marked information on the layer.
o [ Edit the name and image of the layer.

° E; Delete the layer.

4.9.2.4 Event Parameter

Configure events for a parking lot so that you can receive notifications when alarms are triggered.
Step1 Configure an event, and you need to select Parking Lot as the type of event source. For
how to configure an event, see "4.1 Configuring Events".
Step2 Login to the DSS Client. On the Home page, click EY, and then in the App Config section,
select Parking Lot > Parking Lot Configuration > Event Parameter Config.
Step3  Select a parking lot, the events that were configured will be displayed on the right.
The following events will not be displayed because there are no additional parameters to
be configured.
e Blocklist alarm: An alarm will be triggered when a vehicle on the blocklist enters the
parking lot.
e Reserved parking space alarm: An alarm will be triggered when a vehicle parks in a
parking space, but its plate number is not linked to the parking space.
e Parking overline: An alarm will be triggered when a vehicle crosses a line after it is
parked.
Step4  Click & to configure an event.
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Table 4-16 Parameter description

Parameter Description

Parking Overtime

Overtime Parking Threshold: The unit is minute. Alarm
will be triggered if a vehicle has parked for longer than the
defined value.

Detection Interval: How long the platform will check which
vehicles have parked overtime. For example, select 5
minutes, then the platform will check whether there are
vehicles that have parked overtime in the parking lot. If yes,
then an alarm will be triggered.

Vehicles to Trigger Alarms:

¢ All Vehicles: All vehicles will trigger alarms if they park
overtime, but VIP vehicles are not included. If you enable
Include VIP Vehicles, VIP vehicles will also trigger
alarms when they park overtime.

¢ Non-registered Vehicle and Vehicle in the Blocklist:
The vehicles whose information is not registered to the
platform will trigger alarms when they park overtime.

¢ Custom: Enable Non-registered Vehicle, and then the
vehicles whose information is not registered to the
platform will trigger alarms when they park overtime;
enable Registered Vehicle and add vehicle groups, and
then the vehicles in these groups will trigger alarms
when they park overtime.

o=

You can enable Non-registered Vehicle and
Registered Vehicle at the same time.

No Entry and Exit Record

No Entrance/Exit Record Duration: The unit is day. If a
vehicle has not entered or exited the parking lot for longer
than the defined duration, then an alarm will be triggered.
Statistical Time Point: The platform will start calculating
the duration of a vehicle that has not entered or exited the
parking lot on the defined time.

Entrance and Exit Vehicle Group of Interest: Only
calculate the duration for the vehicles in the vehicle groups
that are added.

4.9.3 Managing Vehicle Group

Add vehicles to different groups, so that you can quickly apply different parking lot functions to

multiple vehicles at the same time.

General, VIP, and blocklist are the default groups. If you need to use them, you can directly add

vehicles to them.
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Step Log in to the DSS Client. On the Home page, click , and then in the App Config section,
select Parking Lot > Vehicle Groups.

(%]

tep 1
tep2 Click Add.
tep3  Entera name and select a color for the group, and then click Add.
tep 4

|

p Click @ of a group, or double-click a group and click Select from Vehicle List, select the
vehicles that you want to add to the group, and then click OK.

4.10 Intelligent Analysis

Before using the people counting and scheduled report functions, you must configure them first.

e People counting: Create a people counting group and add multiple people counting rules from
one or more devices to it. Then, you can view the real-time and historical number of people of
the group.

e Scheduled report: Configure the when to send a report with historical people counting data, the
email address to send the report to, and the content of the email.

4.10.1 People Counting Group

Create a people counting group, and then add multiple people counting rules from one or more

devices. In Intelligent Analysis, you can view the real-time and historical number of people of the

group.

Step1 Login to the DSS Client. On the Home page, click EY, and then in the App Config section,
select Intelligent Analysis > People Counting Group Config.

Step2  Click Add at the upper-left corner.

Figure 4-78 Add a people counting group

9 Add People Counting Group

Bas

Step3  Configure the parameters.
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Table 4-17 Parameter description

Parameter Description

People Counting Group

Name Name of the people counting group.

Calibration Time The number of the people in this group will be reset to the
_ defined value at the defined time every day. The defined time
Calibrated Number of People | 350 means the start of a counting cycle.

When enabled, you can configure the red and yellow light

Limit Number of People threshold of the people in the group.

When the number of people in the group reaches the defined

Red Light Threshold value, the light will turn red.

When the number of people in the group reaches the defined

Yellow Light Threshold value but smaller than the red light value, the light will turn
yellow.
Select the devices whose people counting rules you want to
Rule include in the group, and then their data will be combined
together.

Step4  Click Save.

4.10.2 Scheduled Report

Historical data will be sent on a regular basis to one or more email address that you set on the

scheduled time.

Step1 Login to the DSS Client. On the Home page, click EY, and then in the App Config section,
select Intelligent Analysis > People Counting Group Config.

Step2 Configure one or more types of report.

e Daily report: Data from yesterday will be sent to your email at a defined time. If set to
03:00:00, the data from the day before (00:00:00-23:59:59) will be sent to your email at
03:00:00 every day.

o Weekly report: Data from last week will be sent to your email at a defined time. If set to
03:00:00 on Wednesday, the data from Wednesday to Tuesday of each week will be
sent to your email at 03:00:00 every Wednesday.

e Monthly report: Data from last month will be sent to your email at a defined time. If set
to 03:00:00 on 3rd, the data from 3rd of last month to 2nd of the current month will be
sent to your email at 03:00:00 on 3rd of each month.

Step3  Configure one or more email addresses to send the report to, and the content of the email.

1) Click [: to select the users that have been configured email addresses, or enter an

email address, and then press Enter.
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Figure 4-79 Invalid email address, you must press Enter

Email Address

=4 administrato

Figure 4-80 Valid email address

Email Address

+ administrator@gmail.com X

2) Configure the content of the email.

Step4  Send the report.
e C(lick Send Now to immediately send the report that you configured.
e C(lick Save, and then the report will be sent at the defined time.

4,11 Synthesis

Use a bridge to import events to the platform from third-party systems, and then use these events to
create alarms schemes and perform certain linkage actions. You can also share access control and
attendance data with third-party databases, which can be used by third-party personnel to
formulate their own reports.

4.11.1 Synchronizing Events

Step1 Log in to the DSS Client. On the Home page, click EY, and then in the System Config
section, select Synthesis > Event Sync.
Step2 Click Add.
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Figure 4-81 Add a bridge
9 Add Bridge

Bridge Name:

Bridge IP/Domain Name:

Cancel

Ll

e Abridge serves as a connector between the platform and third-party systems, and is
responsible for importing events from a third-party system to the platform. It must
comply with the connection protocol between the third-party system and the platform.
For different systems, the protocol might vary and you might need to develop a new
bridge. Before using this function, make sure the bridge has been deployed and is
running.

e You can add up to 5 bridges.

Step3  Configure the parameters.

Table 4-18 Parameter description

Parameter Description

Bridge Name Name of the bridge.

Bridge

IP/Domain

Name IP address or domain name, and port number of the bridge.

Bridge Port

Access Key Automatically generated. Click to copy it.
Automatically generated.

Secret Key e (lick to verify your password, and then generate a new secret key.
e C(lick to verify your password, and then you can click to copy it.

Step4  Click Add or Add and Modify Event Sync.
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Figure 4-82 Synchronize events

9 Modify Event Sync

Incoming Trigger Event

+ Add ¥ Import

Incoming Trigger Event Code Incoming Trigger Event Name

Incoming Event Source

Step 5

+ Add & Import

Incoming Event Source No. Incoming Event Source Name

Synchronize incoming trigger events.

e Onebyone

1) Click Add.

2) Enter the code and name of the incoming trigger event.
3) Click OK.

Operation

Operation

Figure 4-83 Enter the code and name of the incoming trigger event

Add Incoming Trigger Event

Event Code:

| Tr'l'pwirs{

- C:E”-“:’El

e In batches
1) Click Import.
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Figure 4-84 Download template

Import

Supported file extensions

2) Click Download Template, save the template to your PC, and then enter the
information in it.
3) Click Import File, select the file, and then click Open.

Figure 4-85 Synchronize events in batches

Import

* Incoming Trigger Events Import Templatexlsx

—— ]
v imported

Step6  Synchronize incoming event sources.
e Onebyone
1) Click Add.
2) Enter the number and name of the incoming event source.
3) Click OK.
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Figure 4-86 Enter the code and name of the incoming event source

Add Incoming Event Source

Incoming Event Source No.:

1

Incoming Event Source Name:

‘ IPCO01|

- CE”-I ¢ El

e In batches
1) Click Import.

Figure 4-87 Download template
Import

Supporte

2) Click Download Template, save the template to your PC, and then enter the
information in it.

3) Click ImportFile, select the file, and then click Open.
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Figure 4-88 Synchronize incoming event sources in batches

Import

wvent Source Import Templatexdsx
L] l

y imported

Step7 Click Close at the lower-left corner.

Related Operations
e [ Edit the information of the bridge.
e (B Edit the incoming trigger events and event sources.
e [ Delete the bridge.
e Addevent
1. Goto Home page, click BY, and then in the Applications Configuration section, select
Event.
2. Click Add.

In the Event Source section, select the one you import from the third-party system.

Figure 4-89 Add an third-party event
D Add Event

Event Source

Event Source Type Event Source

Device

Video Channel o _
¥ Third Party Event B select Al
Alarm Input Channel

® Tripwire

C hird Party [PC00
Access control Channel . Third Party IP( 1

Radar
Parking Lot
14
lishu_test

%

4, For other parameters, see "4.1 Configuring Events".
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4.11.2 Synchronizing Data

You can manually or regularly synchronize data in the platform to third-party databases.

Step1 Login to the DSS Client. On the Home page, click EY, and then in the System Config
section, select Synthesis > Data Sync.

Step2 Click Add.

1]
You can only add one database.

Figure 4-90 Add a database

1.Add database

Database Name:

Username:

Cancel

Step3  Select the type of the database, and then enter its name, IP address, port, username and
password.

Click Test. If the connection is through, the system will prompt that it connects to the
database successfully.
Step4  Click Next Step.
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Figure 4-91 Synchronize data

Synchronization Data

Auto Sync

Cancel

Figure 4-92 Configure parameters

Table Field Data Type Data Length Description Enable Third-party System Data Table Field

int

r

varchar

Step6 Set Business Module to Access Control or Attendance, and then enter the name of the
data table in the third-party system.

(L]

Each business module can only be added once.

Step7 Click 3 to select what data to be synchronized. You must disable the data you do not
want to synchronize.

Step8 Double-click the area under Third-party System Data Table Field, enter the
corresponding name in the table in the third-party system.
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Step9 Click [B@M and then configure the time to automatically synchronize the data everyday.
[1]

You can only configure 4:00-23:00.
Step 10 Click OK.

Figure 4-93 Database information

Related Operations

e [ Turn on or off automatic synchronization.
All the data will be synchronized on the first attempt, including after you delete and then add the
database again. Only new data will be updated on subsequent synchronizations.

e [ Edit the information of the database or the data that is being synchronized. You can view
each synchronization result in the log. See "8.1.3 System Log".

e B Synchronize the data immediately.

e [ Delete the database.

4.12 Maintenance Center

After configuring video storage detection, you will be prompted if the duration or integrity of
recording is abnormal. Also, a scheduled report can be sent at the defined time to one or more email
addresses to keep the persons updated of the status of the platform. The information in the report
can include channel status, device status, server status, hard disk status, fault status, and abnormal
videos.

4.12.1 Configuring Video Storage Detection

The platform will continue to check the duration and integrity of the videos. You will be prompted if
the one of them is abnormal. For example, 30 days of duration and video integrity have been
configured for channel A. If there are only 24 days of video, or the video does not last for 24 hours on
any day, the platform will give corresponding prompts.

Prerequisites
Recording plans have been configured for channels and videos have been recorded.

Procedure
Step1 Log in to the DSS Client. On the Home page, click EY, and then in the App Config section,
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Step 2

Step 3
Step 4

select Maintenance Center > Video Storage Detection Config..

In the Video Storage Detection Config section, select channels, and then configure the
number of days of video.

You can also enter a number in the Days to Record Videos in Batches Config input box,
and then click Apply. The number of days will be applied to all selected channels.

In the Detection of Video Completion Status, select channels.

Click OK.

Related Operations

You can view the detection results in Maintenance Center. If the duration of video is not enough,

the number of days will be displayed in red. If video does not last for 24 hours on any day, the

integrity status will be abnormal. For details, see "5.7.1 Viewing System Status".

Figure 4-94 Video duration and integrity status
Current Site 2 MNormal 0 Abnormal

| Current Site o Normal 3 Abnormal

IPC-88.3 Current Site o Normal 0 Abnormal

4.12.2 Configuring Scheduled Report

Configure a period so that the platform will regularly send data on how the system is running to the

defined email addresses, including channel status, device status, server status, disk status, faults, and

abnormal videos.

Step 1

Step 2

Log in to the DSS Client. On the Home page, click EY, and then in the App Config section,

select Maintenance Center > Scheduled Report Config.

Configure one or more types of report.

e Daily report: Data from yesterday will be sent to your email at a defined time. If set to
03:00:00, the data from the day before (00:00:00-23:59:59) will be sent to your email at
03:00:00 every day.

o Weekly report: Data from last week will be sent to your email at a defined time. If set to
03:00:00 on Wednesday, the data from Wednesday to Tuesday of each week will be
sent to your email at 03:00:00 every Wednesday.

e Monthly report: Data from last month will be sent to your email at a defined time. If set
to 03:00:00 on 3rd, the data from 3rd of last month to 2nd of the current month will be
sent to your email at 03:00:00 on 3rd of each month.

Select a format of the report, including Excel or PDF.

Select the type of information to be included in the report.

It includes channel status, device status, server status, disk status, faults, and abnormal

videos.

Configure one or more email addresses to send the report to, and the content of the email.

1) Click to select the users that have been configured email addresses, or enter an

email address, and then press Enter.
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Figure 4-95 Invalid email address, you must press Enter
E-mail Address

+ administrator@gmail.com

Figure 4-96 Valid email address

E-mail Address

+ I

2) Configure the content of the email.

Step6 Send the report.
e C(lick Send Now to immediately send the report that you configured.
e C(lick Save, and then the report will be sent at the defined time.
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5 Businesses Operation

5.1 Monitoring Center

The monitoring center provides integrated real-time monitoring applications for scenarios such as
CCTV center. The platform supports live video, license plate recognition, target detection, access
control, emap, snapshots, events, video playback, video wall, and more.

5.1.1 Main Page

Provides frequently used functions such as video and event and alarm.
Log in to the DSS Client. On the Home page, click m, and then select Monitoring Center.

Figure 5-1 Monitoring center

Table 5-1 Interface description

No. Parameter Description

e List of resources including devices, POS channels,
browser, and maps.

e You can search for a device or channel in the search field.

Favorites and device Fuzzy search is supported so that you can simply enter

tree part of the name and then select the exact one from the

provided name list.

o Add, delete or rename the favorites. You can also tour the
channels in favorites.

171



@/hua

User's Manual

No. Parameter Description
e Save the current view of window split and video channels
in the live view section, and name the view. You can
directly select the view from the View tab to display it
2 View quickly next time.
e Channels under a view or view group can be displayed by
tour (in turn). You can set the tour interval to be 105,30 s,
1 min, 2 min, 5 min or 10 min. Maximum 100 views can be
created.
3 PTZ PTZ control panel.
4 Save view Click to save current video window as a view.
5 Close all windows Close all windows in live view.
6 Channel control Control the door channels in live view.
7 Real-time videos Drag a channel to the windows and view its real-time video.
e Set window split mode. Supports 1,4, 6, 8,9, 13, 16, 20, 25,
36 or 64 splits, or click to set a customized split mode.
If the live-view channel number is more than the number
8 Window split mode of current windows, then you can turn page(s) by clicking
and full screen at the bottom of the page.
e Switch the video window to Full Screen mode. To exit
Full Screen, you can press the Esc key or right-click on the
video and select Exit Full Screen.
9 Event panel button Display or hide the event panel.
10 Event and alarms Events and alarms.
. Live view and e Live view: View real-time videos.
playback e Playback: View recordings. See "5.1.3 Playback".

5.1.2 Video Monitoring

View live videos. For ANPR and face cameras, you can view information of ANPR, face detection and

face recognition. For video metadata cameras, you can view metadata information.

5.1.2.1 Viewing Live Video

View the live video of connected devices.

Ll

This section only introduces viewing live video. For POS live view, see "6.4 POS". For map live view,

see "4.2 Configuring Map".

Step 1
Step
Step

w N

Log in to the DSS Client. On the Home page, click FH, and then click Monitoring Center.
Click [=.

View real-time video.
You can view live video in the following ways:

e Double-click a channel or drag the channel from the device list on the left to one
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window on the right.

e Double-click a device to view all channels under the device.

e Right-click a node, select Tour, and then set tour interval. The channels under this node
will play in turn according to the defined interval.

o If the number of splits in the window is more than the number of online channels,
video of all channels will be displayed in the window. Otherwise, click [IEE on
the top of the page to turn pages.

o Close the on-going tour before starting live view.

Figure 5-2 Live view

Resources

Blackbody error

3

» \Permal | NVR 1
Step4  You can perform the following operations during live view.
e Display intelligent snapshots.
When viewing live video of face detection cameras, face recognition cameras, ANPR
cameras, or target detection cameras, right-click the monitoring image, and then select
Start Picture Overlay. The snapshot will be displayed on the upper-right corner of the
live window. If no more images are captured, a snapshot will be displayed up to 5 s by
default, and it will disappear after 5 s.
Point to the live window, and then select type of images to be displayed.
e Point to the video window, and then you can see the shortcut menu on the upper-right
corner.
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Figure 5-3 Live window

Table 5-2 Parameter description

Icon Name Description

&) Instant playback Open/close instant playback.
B Audio Open/close audio.

Audio Open/close two-way audio.

communication

Click it, and then the system begins to record local file and you
can view the record time on the upper left. Click again, and
then system stops recording and saves the file to your PC. The
recorded video is saved to ..\DSS\DSS Client\Record by default.
To change the storage path, see "8.3.5 Configure File Storage
Settings".

Local record

H

Take a snapshot. The snapshots are saved to ..\DSS\DSS
Snapshot Client\Picture by default. To change the snapshot storage path,
see "8.3.5 Configure File Storage Settings".

Eq Close Close the video.

e Sleep function is supported for IPCs that use 4G mobile network to communicate and
are solar-powered.
o When the device is asleep, you can click to wake it up.
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Figure 5-4 Wake up the device

©

The device is asleep. Click the icon to wake it
up.

¢ The device will regularly request to sleep to save battery. When you are viewing its
live video, the device will request to sleep every 2 minutes. When you are not
viewing its live video, the device will request to sleep every 1 minute. You can
accept or reject so that you can continue to watch live video. When rejecting the
request, you can choose whether to delay the next request from the device.

Figure 5-5 Request to sleep from the device

[

device will g@'to sleep in 8
onds. Would you like to
ontinue watchir};g the video?

- : r
Remind MeLater

e Right-click the live video, and then the shortcut menu is displayed.
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[1]

The menu varies depending on device functions.
Figure 5-6 Live video operation menu

Select Audio Input

Start Remote Recording

Continuous Snapshot

Stream Type

Play Mode

Video Adjustment

Digital Zoom

Window Mode

Al Overlay

SMD Qverlay

Disable Privacy Masking

Alarm Output Control

Audio and Light Control
Add to Favorites

Set as Alarm Window

Table 5-3 Description

Parameters Description

If the camera has more than one audio input channels, you can select
Audio Input Selection one or select the mixed audio. This configuration is effective with
both live view and playback.

Record the audio and video in the current window, and save the
recordings to the path defined when configuring record plan.

If a channel already has recorded within the same period, the video

Start Remote Record status will be overlaid over the live view.

If video storage disk is configured on the platform, the videos will be
saved to the platform server.

Take snapshots of the current image (three snapshots each time by
default). The snapshots are saved to ..\DSS\DSS Client\Picture by
default. To change the snapshot storage path, see "8.3.5 Configure
File Storage Settings".

Continuous Snapshot

Select stream type as required. Generally, main stream requires the
Stream Type most bandwidth, and sub stream 2 the least. The smaller the
bandwidth is required by the stream, the smoother the video image.
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Parameters

Description

Play Mode

e Real-Time Priority: The video is in real-time, but video quality
might be reduced.

e Fluency Priority: The video is fluent, but video lagging might
occur.

e Balance Priority: Real-time priority or fluency priority, depending
on actual conditions.

e Custom: Configure the video buffer time from Local Settings >
Video. The larger the value, the more stable the video quality.

Video Adjustment

Adjust the brightness, contrast, saturation, and chroma of the video
for video enhancement.

Digital Zoom

Click it, and then click and hold the video image to zoom in on the
image. Right-click the image, and then select Digital Zoom again to
exit zooming in.

Window Mode

Divide one window into 2 (1+1 mode), 4 (1+3 mode), and 6 (1+5
mode). One window will play the real-time video, and the others play
different defined areas of the real-time video.

If a device supports target tracking, you can enable this function in
any window mode, the windows that play defined areas of the real-
time video will follow the target when detected, until it disappears.

Al Overlay

The client does not show rule lines on the live video by default. If
needed, you can click Al Overlay and enable Rule Overlay and
Bounding Box Overlay, and then the live video shows rule lines if
the Al detection rules are enabled on the device. This configuration is
effective with the current selected channel both in live view and
playback.

SMD Overlay

Enable SMD Overlay to show target bounding box over live video.
When SMD is enabled on the device, you can enable SMD Overlay
for the device channel, and then the live video will display dynamic
target bounding boxes. This configuration is effective with the
current selected channel both in live view and playback.

Disable Privacy Masking

For a camera that supports privacy masking of human face, you can
disable the masking here to view the face image.

Alarm Output Control

Turn on or turn off alarm output channels.

Audio and Light Control

You can turn on or off the audio and light channels one by one or at
the same time.

Add to Favorite

You can add the active channel or all channels into Favorite.

Set as Alarm Window

When selecting open alarm linkage video In Preview (in live
window) from Local Settings > Alarm, then the video will be
displayed on the window which is set to alarm window. If multiple
alarms are triggered, the video linked to the latest alarm will be
opened. If the number of alarm windows is fewer than the number of
linkage videos, the video linked to the earliest-triggered alarm will be
opened. After enabling Set as Alarm Window, the window frame is
displayed in red.
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Parameters Description
This function is available on fisheye cameras only. When changing
the video stream, the fisheye view mode will maintain the current
configuration.
Fisheye View

According to different installation methods, the fisheye view can be
varied.

e In-ceiling mount: 1P+1, 2P, 1+2, 1+3, 1+4, 1P+6, 1+8.

e Wall mount: 1P, 1P+3, 1P+4, 1P+8.
e Ground mount: 1P+1, 2P, 1+3, 1+4, 1P+6, 1+8.

e To view real-time temperature of a point on the thermal camera view, hover over that
point.

Figure 5-7 View temperature
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e If a channel supports electronic focus, you can enable electronic focus for it on the

platform to adjust video definition and size.
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The page might vary according to the lens types of cameras. Lens types include
embedded zoom lens and external CS electronic lens. The following figure is for

reference only.

Figure 5-8 Live view

Table 5-4 Description

Parameters Description

Zoom in/out.

Click or click and hold E or @, or drag the slider [l to the left or
right to zoom in/out.

Zoom +/- (for
embedded zoom lens)

Adjust camera focus to achieve the best video definition.

Focus +/- Click or click and hold E or ﬁ, or drag the slider ] to the left or
right to adjust focus.

Auto Focusing (for
embedded zoom lens) | Adjustimage definition automatically.

ABF (auto back m
focusing, for external Other focusing operations are unavailable during auto focusing.
CS electronic lens)

When image definition is imperfect, or after many times of zooming or
Reset focusing operations, you can click Reset to reset the lens, so as to
eliminate lens deviation.

e Tour
On the live view page, right-click a device or node, select Tour, and then select an
interval. The channels under this device or node will be played in turn at the pre-
defined interval. You can also customize the interval.
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Figure 5-9 Start tour

10min

Customize

¢ To view remaining time of a channel during tour, check ERaa.
o To pause, click @)
o To exit tour play, click m
e Region of interest (Rol)
A window can be divided into 4 or 6 regions during live view. One area is used to play
live video and other regions are used to zoom in regional image.
On the live view page, right-click the window, select Window Mode, and then select a
mode. For example, select a 1+3 mode.
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To exit the Window Mode, right-click the window and then select [X.

*

o View real-time events.

Figure 5-10 Split mode
t Audio Input

- .
otart Re

Continuous Snapshot

Al Overlay

) Cverlay
Add to Favorites

MNindow

Click [E] to open the event panel, which displays the real-time alarm events of the

channel.

o Click the event type on the top of the event panel to view the corresponding event.

o Click event record to view the snapshot. Video playback is also supported.

Operations related to different events might be different.
o [@: Refreshes events in real time. [@: Stops refreshing.
o Click B to clear the events in the event panel.
o Click [ to quickly view the latest events.
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e Remotely unlock the door.
When viewing the access control channel, you can remotely control the status of the
door on the upper-right corner: Normally open ((El), normally closed ([B]), or normal
status (8)). You need to enter the login password of the current user before operation.
Restore the door to normal status first, and then the door can be opened and closed
according to defined period or through face recognition.
In the video window of the access control channel, you can remotely lock or unlock the
door.

Figure 5-12 Lock/unlock the door

e Video intercom.
When viewing the video intercom channel, you can answer or hang up the call.
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Figure 5-13 Video intercom

5.1.2.2 View

The current layout and resources can be saved as a view for quick play next time. Views are
categorized into different groups, which include three levels: First-level root node, second-level
grouping and third-level view. Tour is supported for first-level root node and second-level grouping.
The tour time can be 105,30 s, T min, 2 min, 5 min, 10 min, or customized (5 s-120 min). Up to 100
views can be created.

5.1.2.2.1 Creating View

Views are categorized into different groups, convenient for management and quick use. Group
includes three levels, first-level root node, second-level grouping and third-level view.
Step1 Login to the DSS Client. On the Home page, click FH, and then select Monitoring Center.
Step2  Click [
Step3  Create a view group.

1) Click the View tab.

2) Right-click View, select New Folder.

Figure 5-14 Create a new folder

View

* [ View

Tour

MNew Folder

3) Enter afolder name, click OK.
Step4  Create view.
1) Customize the window split mode, view real-time videos of channels in the windows,
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and then click [E] on the upper-right corner.
2) Enter a name for the view, select a view group it belongs to, and then click OK.

5.1.2.2.2 Viewing View

e Liveview
On the Monitoring Center page, select a view, double-click or drag it to the window to start
viewing.

e Tour
On the Monitoring Center page, right-click view group or root node, select Tour and tour

period.

184



@/hua

User's Manual

Figure 5-15 Go to video tour page
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Figure 5-16 View tour
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¢ To view remaining time of a channel during tour, check EXaa.

o To pause, click [E1.

o To exit tour play, click El.

5.1.2.3 Favorites

Add frequently used channels to favorites to realize quick search and call.
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5.1.2.3.1 Creating Favorites

Step1 Log in to the DSS Client. On the Home page, click FH, and then select Monitoring Center.

Step2 Click E.
Step3  Create favorites.
1) Click E1.

Figure 5-17 Favorites

bk

» i Root (0/0)
P m POS(0/1)

-
nn Browser

» M Main Map

2) Right-click root node or created favorites, and then select New Folder.
3) Enter a folder name, click OK.
Lower-level favorites are generated under the selected root node or favorites.
4) Click Bl
The system goes back to the device list.
Step4  Add channels to favorites.
e In the device list, right-click a channel, and then select Add to Favorite.
e Right-click the window with live video, and then select Add to Favorite.

5.1.2.3.2 Viewing Favorites

e Liveview
On Monitoring Center page, click open favorites list, select favorites or channels, double-
click or drag to video window and the system starts to play live video.
e Tour
On Monitoring Center page, click B, open favorites list, select the root node or favorites, select
Tour and then set duration. The system starts to play the channels in tour.
o To view remaining time of a channel during tour, click EE.
¢ To pause, click Bl
o To exit tour play, click .

5.1.2.4PTZ

Operate PTZ cameras during live view on the DSS Client.

5.1.2.4.1 Configuring Preset

A preset is a set of parameters involving PTZ direction and focus. By calling a preset, you can quickly
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rotate the camera to the pre-defined position.

Procedure
Step1  On the Monitoring Center page, open the video of a PTZ camera.
Step2 Click HEE.

Figure 5-18 Go to PTZ control panel

Step3  Click [&
Step4 Addapreset.
1) Rotate the PTZ camera to a specific point.
2) Click B enter the preset name, and then click .

Related Operations
Call a preset: Click [@ of a specific preset, and then camera will rotate to the related position.

5.1.2.4.2 Configuring Tour

Set Tour to enable an camera to go back and forth among different presets. Set tour to enable
camera to automatically go back and forth between different presets.

Prerequisites
You have added at least 2 presets.

Procedure
Step1  On the Monitoring Center page, open the video of a PTZ camera.
Step2 Click HEE.
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Figure 5-19 Go to PTZ control panel

()

Step3 Click B
Step4 Click &
Step5  Addtours.

1) Enter tour name, and click Eg.

2) Select a preset from the drop-down list on the left.
3) Repeat the previous 2 steps to add more presets.
4) Click OK.

Related Operations
To start tour, click [8], then camera goes back and forth among the presets.

5.1.2.4.3 Configuring Pattern

A pattern is a record of a consecutive series of PTZ operations. You can select a pattern to repeat the
corresponding operations quickly. See pattern configuration instructions as follows.

Procedure
Step1  On the Monitoring Center page, open the video of a PTZ camera.

Step2 Click HEE.
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Figure 5-20 Go to PTZ control panel

()

Step3 Click B
Step4 Click B and then operate the 8 PTZ buttons of PTZ to set pattern.
Step5 Click B

Related Operations
Call pattern: Click [8], and then the camera will automatically repeat the pattern that you have
configured.

5.1.2.4.4 Configuring Scan

The camera automatically scans horizontally at a certain speed.
Step1  On the Monitoring Center page, open the video of a PTZ camera.
Step2 Click HEE.
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Figure 5-21 Go to PTZ control panel

o

Step3 Click EEE.

Step4  Click PTZ button, and rotate PTZ to the left to a position, and then click to set the left
boundary.

Step5 Continue to rotate PTZ to the right to a position, and then click B to set the right
boundary.

Step6 Click B to start scanning, then PTZ will rotate back and forth automatically within the

two boundaries.

5.1.2.4.5 Enabling/Disabling Pan
On the Monitoring Center page, open the video of a PTZ camera. Click [, and then click E&. PTZ
rotates 360° at a specified speed. Click ] to stop camera rotation.

5.1.2.4.6 Enabling/Disabling Wiper

Enable/disable the PTZ camera wiper. Make sure that the camera supports wiper function.
On the Monitoring Center page, open the video of a PTZ camera. Click [, and then click [ to
turn on wiper. Click [ to turn off wiper.

5.1.2.4.7 Enabling/Disabling Light

Turn on/off camera light . Make sure that the camera supports light.
On the Monitoring Center page, open the video of a PTZ camera. Click [, and then click & to
turn on light. After enabling light, click [F] to turn off light.

5.1.2.4.8 Configuring Custom Command

Step1  On the Monitoring Center page, open the video of a PTZ camera.

190



@hua .
TechNoLoaY User's Manual

Step2 Click HEEN.

Figure 5-22 Go to PTZ control panel

Step3  Enter your command in the Command box.

Figure 5-23 Custom command

Command

Step4 Click [ to show the command functions.

5.1.2.4.9 PTZ Menu

Step1  On the Monitoring Center page, open the video of a PTZ camera.
Step2 Click HEN.
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Figure 5-24 Go to PTZ control panel
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Step3 Click EEE.

Step4 Click L
Step5 Use the panel to go to the menu configuration page.

Figure 5-25 Go to PTZ menu configuration page

Command

€ @ Pooos

Table 5-5 PTZ menu description

Parameters Description

=i Up/down.
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Parameters Description

HE Left/right. Point to set parameters.

= Click. -‘ to enable PTZ menu function. System displays main menu on the
monitor window.

BEa Click B to close PTZ menu function.

It is the confirm button. It has the following functions.
oK e If the main menu has the sub-menu, click OK to enter the sub-menu.
e Point to Back and then click OK to go to go back to the previous menu.

e Point to Exit and then click OK to exit the menu.

Point to Camera and then click OK to enter camera settings sub-menu page.
Camera Set camera parameters. It includes picture, exposure, backlight, day/night
mode, focus and zoom, defog, and default.

Point to PTZ and then click OK to go to PTZ sub-menu page. Set PTZ functions.

P1Z It includes preset, tour, scan, pattern, rotation, PTZ restart, and more.
Point to System and then click OK to go to system sub-menu page. Set PTZ
System simulator, restore camera default settings, video camera software version and
PTZ version.
Return Point to the Return and then click OK to go back to the previous menu.
Exit Point to the Exit and then click OK to exit PTZ menu.

5.1.2.5 Fisheye-PTZ Smart Track

Link a PTZ camera to a fisheye camera so that when the fisheye camera detects a target, the PTZ
camera automatically rotates to it and track.

5.1.2.5.1 Preparations

Make sure the following preparations have been completed:
e Fisheye camera and PTZ camera are well deployed. For details, see corresponding user's manuals.
e Basic configurations of the platform have been finished. For details, see "3 Basic Configurations".
¢ When adding cameras, select Encoder from Device Category.
¢ Features of fisheye camera is set to Fisheye. For details, see "3.2.2.5.2 Modifying Device
Information".
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Figure 5-26 Set fisheye camera features

9 All Device

= . . Channel Number:
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1 (0-1024)
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N . ~
& Alarm Output Channel

E POSChannel

5.1.2.5.2 Configuring Fisheye-PTZ Smart Track

Step1 Log in to the DSS Client. On the Home page, click FH, and then click Monitoring Center.

Step2  Click B

Step3 Inthe device tree on the left, right-click a fisheye camera, and then select Modify Smart
Track.

Step4 Click | next to Please select a PTZ camera to link, and then select a PTZ camera.

Figure 5-27 Set smart track rules (1)

Fisheye-PTZ Config

Fisheye ea a PTZ camera to link

Cancel

Step5 Click and then move the [l of the fisheye on the left to select a position. Click [ of
the PTZ camera to find the position. Adjust the PTZ camera to find the position and move
the PTZ to the center position (The green cross on the image).
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Figure 5-28 Set smart track rules (2)
Fisheye-PTZ Config

Fisheye

FiZad Tl

e A >
Wova W '10. x

Fisheye point SD point ... Operation
[ ]
[ ]

Cancel

e Select 3-8 mark points on fisheye camera.
e When you find mark point on the right side of the PTZ camera, click [B] to zoom out
PTZ.
e C(lick to 3D position, and when you click a certain point on the left side of PTZ
camera, it will automatically move to the center.
Step6  Click to save the calibration point.
See above steps to add at least three calibration points. These three points shall not be on
the same straight line.
Step7 Click Save.

5.1.2.5.3 Applying Fisheye-PTZ Smart Track

Step1 Login to the DSS Client. On the Monitoring Center page, select the fisheye camera on the
device tree and then right-click to select Smart Track.
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Figure 5-29 Select a smart track channel
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CK camera2 Smart Track

S IP PTZ Camer Modify Smart Track

Step2  Click any point on the left of fisheye, PTZ camera on the right will automatically rotate to
corresponding position.

5.1.3 Playback

Play back recorded videos.

5.1.3.1 Page Description

Log in to the DSS Client. On the Home page, click E and then click Monitoring Center. Click the
Playback tab.

Figure 5-30 Playback page

Table 5-6 Description

Icon Description
E Lock the video stored to the server within some period of designated
channel. Locked video will not be overwritten when disk is full.
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Icon Description
o6 Cut video

Download video

=l [

Filter video according to record type.

5

i

Make dynamic detection analysis over some area of the record image,
and it only plays back the video with dynamic image in the detection
area.

Play multiple recorded videos from the same time. For example, you are
playing recorded videos from 3 channels at the same time. Select
channels, configure when you want to play the recorded video from,
and then click this icon. All 3 channels will play recorded videos from
the same time.

Stop/pause playback

Frame by frame playback/frame by frame backward.

Fast/slow playback. Max. supports 64X or 1/64X.

During playback, you can drag time progress bar to play back record at
the specific time.

Select the storage location of the video to be searched. Supports
searching for the video on the platform server or storage device.

Tag records.

Lock records.

5.1.3.2 Playing Back Recordings

Step 1

N
—+ |+
D |[D

(V4]
—~
~

Log in to the DSS Client. On the Home page, click E and then select Monitoring

Center.
Click the Playback tab.
Select a channel from the device tree, and then double-click it, or drag it to the window.

Select the storage path of recorded video from [ESSIEELISTYES , and then click to

select the date.
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|

Dates with blue dot means there are recordings.

Figure 5-31 Playback page

. YA &E
Step5 Click [@ to play the video.
Step6 Hover over the video, and then the icons appear. You can perform the following actions.

Figure 5-32 Video playback

Table 5-7 Description

Icon Name Description
Take a recordin Click this icon to start recording. The recorded video is stored
[lq] raing locally. The saving path is C:\DSS\DSS Client\Record\ by
on the device
default.
m Take a snapshot Take a snapshot of the current image and save it locally. The
on the device saving path is C\DSS\DSS Client\Picture\by default.
E Close Close the window.
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Icon Name Description
If the device has been marked on the map, click the icon to
Map location open the map in a new window to display map location of the
device.
Capture the target in the playback window. Click to
select the search method, and then the system goes to the
E Search by pagi with search results: More operations:
snapshot ° sﬁ: Move the selection area.
° a: Adjust the size of the selection area.
e Right-click to exit search by snapshot.
Tag Tag the videos of interest for easy search in the future.
Right-click the video, and then you can perform the following actions.
Figure 5-33 Shortcut menu
Select Audio Input
& Continuous Snapshot
Video Adjustment
Digital Zoom
Al Overlay
SMD Overlay
B, Disable Privacy Masking
Playback on Video Wall
Set as Alarm Window
Table 5-8 Description
Parameters Description

Select Audio Input

If the camera has more than one audio input channels, you can select
one or select the mixed audio. This configuration is effective with
both live view and playback.

Continuous Snapshot

Take snapshots of the current image (three snapshots each time by
default). The snapshots are saved to ..\DSS\DSS Client\Picture by
default. To change the snapshot saving path, see "8.3.5 Configure File
Storage Settings".

Adjust the brightness, contrast, saturation, and chroma of the video

Video Adjustment for video enhancement.
- Click it, and then double-click the video image to zoom in the image.
Digital Zoom . . ) . Lo
Double-click the image again to exit zooming in.
The client does not show rule lines over live video by default. When
needed, you can click Al Overlay and enable Rule Overlay and
Bounding Box Overlay, and then the live video shows rule lines if
Al Overlay

the Al detection rules are enabled on the device. This configuration is
effective with the current selected channel both in live view and
playback.
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Parameters

Description

SMD Overlay

Enable SMD Overlay to show target bounding box over live video.
When SMD is enabled on the device, you can enable SMD Overlay
for the device channel, and then the live video will display dynamic
target bounding boxes. This configuration is effective with the
current selected channel both in live view and playback.

Disable Privacy Masking

For a camera that supports privacy masking of human face, you can
disable the masking here to view the face image.

Playback on Video Wall

Play the video of the current channel on video wall. Make sure that
video wall is configured (see "5.1.5 Video Wall").

Set as Alarm Window

When selecting open alarm linkage video In Preview(in live window)
from Local Settings > Alarm, then the video will be displayed on the
window which is set to alarm window. If multiple alarms are
triggered, the video linked to the latest alarm will be opened. If the
number of alarm windows is fewer than the number of linkage
videos, the video linked to the earliest-triggered alarm will be
opened. After enabling Set as Alarm Window, the window frame is
displayed in red.

5.1.3.3 Locking Videos

Lock the video stored on the server within a period of a specific channel. The locked video will not be

overwritten when disk is full.

Procedure

(9]
~+
D

—_

Center.

wn |
—+ |+
D |D

%)

—+
F

I

select the date.

Log in to the DSS Client. On the Home page, click E, and then select Monitoring

Click the Playback tab.
Select a channel from the device tree, and then double-click it, or drag it to the window.

Select the storage path of recorded video from |[ESCIEERESE, , and then click to

The search results are displayed.
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|

Dates with blue dot means there are video recordings.

Figure 5-34 Playback page

Store on Device b Y a x & E‘

Step5  Select a window that has recorded video, and then click E on the bottom of the page,

and then click on the timeline to mark the start point and end point of the video clip you

need.

Figure 5-35 Lock record

Start Time: 2021-04-13 21:50:44

End Time: 2021-04-1

G

e R i B g E—
2000 23100 C 01.00 0200 03.00 04.00 0500

Store on Device [ ‘g}é & B = 4« B
Step6  Confirm the start and end time, and then click OK.
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Related Operations
Click E on the lower-right corner, and then all the recordings locked by the user currently logged
in to the client are displayed. Double-click one to quickly play the recording.

5.1.3.4 Tagging Videos

You can tag records of interest for quick search.
Step1 Login tothe DSS Client. On the Home page, click E, and then select Monitoring

Center.
Step2  Click the Playback tab.
Step3  Select a channel from the device tree, and then double-click it, or drag it to the window.
Step4  Select the storage path of recorded video from [JSEIEERE=IYES and then click to

select the date.
The search results are displayed.

1]
Dates with blue dot means there are video recordings.

Figure 5-36 Playback page

& | j Ly :
ck .

Step5 Point to the window that is playing record, and then cli
Step6 Name the tag, and then click OK.

5.1.3.5 Filtering Recording Type

Filter video according to record type, record type includes scheduled record, alarm record, and

motion detection record.

Step1 Login to the DSS Client. On the Home page, click E, and then select Monitoring
Center.

Step2  Click the Playback tab.

Step3  Select a channel from the device tree, and then double-click it, or drag it to the window.

(V4]
—
N

Click , select a record type (or types), and then click OK.

The system only displays videos of the selected type. Each section on the time bar in green
indicates a recorded video of the type you selected.
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Figure 5-37 Filter record type

Record Type Filter
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5.1.3.6 Clipping Videos

B ™ Alarm Video
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tep1 Login to the DSS Client. On the Home page, click E, and then select Monitoring

:
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select the date.

Click the Playback tab.
Select a channel from the device tree, and then double-click it, or drag it to the window.

Select the storage path of recorded video from

The search results are displayed.

Store on Server , and then click to
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|

Dates with blue dot means there are video recordings.

Figure 5-38 Playback page

=t
02:00

Step5  Select a date with video recordings, and then click .
Step6  On the timeling, click the point with green shade to start clipping, drag your mouse, and
then click again to stop clipping.

Figure 5-39 Download recorded video

Download Recorded Video
Start Time:
2021-04-13 21:49:44

End Time:

2021-04-1:

Transcode:

File Format:

w e

Sancel

| o
02:00 0300

Store on Device [ ﬂ & @ =) 4 B |l M 4« 1x

Step7  Enter the password of the current user.
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Step8 (Optional) Enable Transcode, and then select the file format.
Step9  Click OK.

5.1.3.7 Smart Search

With the smart search function, you can select a zone of interest on the video image to view motion
records within this section. The relevant camera is required to support Smart Search; otherwise the
search result will be empty.

Step1 Logintothe DSS Client. On the Home page, click E, and then select Monitoring
Center.

Step2  Click the Playback tab.

Step3  Select a channel from the device tree, and then double-click it, or drag it to the window.

Step4  Select the storage path of recorded video from [JSSIEERIESES , and then click to

select the date.
The search results are displayed.

[

Dates with blue dot means there are video recordings.

Figure 5-40 Playback page

04:00 05:00

Store on Device ~Yax &R

Step5  Select a window that has videos, click , and then select a type.
The smart search page is displayed, with 22 x 18 squares in the window.
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Figure 5-41 Smart search

1x

Step6  Click the squares and select detection areas.
(1]

e Select a detection area: Point to image, click and drag to select a square.
e For the selected area, click again or select square to cancel it.
Step7 Click ] to start smart search analysis.
o If there are search results, the time progress bar will become purple and display
dynamic frame.
e |t will prompt that the device does not support smart search if the device you selected
does not support the function.

Click E to select the detection area again.

Step8  Click the play button on the image or control bar.
The system plays search results, which are marked purple on the timeline.

Step9 Click m to exit smart search.

5.1.4 Map Applications

You can view video, cancel alarms, and view device locations on the map.

Prerequisites
Make sure that you have configured a map. For details, see "4.2 Configuring Map".

Procedure
Step1 Login tothe DSS Client, and on the Home page, select E > Monitoring Center.
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Step2  Click g
Step3  Inthe map list, click a map.

Figure 5-42 View map (GIS map)
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Figure 5-43 View map (raster map)
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Step4 Engage in group talk on the GIS map.

1) Click next to the list of maps.
The default group includes all MPT users.

=
For how to configure an MPT user, see "3.3.2 Adding User".
2) Click Add Group Talk.
3) Enter a name for the group, select MPT users, and then click OK.

4) Click the new group, and then click on the upper-right corner to join the group.
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Figure 5-44 Join the new group

Group Talk

—

+ Add Group Talk B Emergency Response Unit

B Default Group{0/1 « MPT1

B Emergency Response .

5) Press the F2 key to talk to the users in the group.
6) (Optional) Click and you can edit the users in the group.
The users removed from the group will return to Default Group.

Step5 Click a device on the map, and then you can view video, cancel alarms, view longitude and

latitude, and more.

Related Operations

There might be differences between the actions supported by different devices and map types.

Hide Device Name

Only display the icons of devices.

Satellite Map

View the satellite map.

View live video

Click Pane, select devices on the map, and then click to view videos in batches; or click

on the map, and then select to view videos.

Playback

Click Pane, select devices on the map, and then click to view videos in batches; or click

on the map, and then select to view videos.

Cancel alarms

Click a device on the map, and then select E

Show devices

¢ On araster map, you can select to display video channels, access control channels, alarm
input channels, lift control channels, and defense zone alarms.

¢ OnaGIS map, you can select to display video channels, alarm input channels, radar channel,
lift control channels, MPT channels, and defense zone alarms.

Visual area (available on GIS maps)

If a device supports visual area, click Visual Area and double-click a device on the map to show

its monitoring area.

Initial angle (available on GIS maps)

208



@hua .
fEcHNoLoGY User's Manual

If a device supports initial angle, click Initial Angle and double-click a device on the map to show
the initial angle.

o C(lear
To clear all markings on the map, click Clear.

e Measure distance (available on GIS maps)
Select Box > Length, connect two points with a line on the map (double-click to finish drawing),
and then the distance between the points is shown.

e Measure area (available on GIS maps)
Select Box > Area, select a region on the map (double-click to finish drawing), and then the area
is measured.

e Add marks
Select Box > Add Mark, and then mark information on the map.

® Reset
Select Box > Reset to restore the map to its initial position and zoom level.

e Click [ to view the information of the sub map.

e Double-click [, and then the platform will go to the sub map, where you can view the
resources on it.

5.1.5 Video Wall

A video wall, which consists of multiple video screens, is used for displaying videos on the wall,
instead of small PC displays.
Complete video wall settings before you can view videos on the wall.

5.1.5.1 Configuring Video Wall

5.1.5.1.1 Page Description

Before using the video wall function, you should get familiar with what you can do on the video wall
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page.
Figure 5-45 Video wall
Video source has not been bound
Table 5-9 Page description

No. Function Description
If you have selected Device and Channel in Local Settings >
General, the device tree will display all devices and their channels.
Otherwise, it will only display all channels.

1 Device tree Click to view channels that you have saved to favorites.
You can enter keywords in _ to
search for the channels you want.

2 Live view View live videos from channels.

View the channel information in a screen of the video wall.

e C(lick E and view the live video of the channel in Live View
on the lower-left corner. This can be helpful when you need to
make sure whether it is the channel you want.

3 Detailed o C(lick m to adjust the order of channels.

information e C(lick E to delete the channel from the screen.

e (lick Stay Duration (sec) or E to define the for how long the
live video of the channel will be displayed during each tour.

e C(Click Stream or E to change the video stream of the channel.

4 Window split Select how you want the window to split.

5 Clear screen Clear all the screens.

Stopping or
6 starting all Stop or start all tours.
tours
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No. Function Description
If multiple screens in a video wall are configured to be a combined
7 Lock window screen, then you can perform video roaming on the window that
has been locked.
Display the real-time video, or a snapshot of the real-time video
. every 10 minutes of the bound channel in the screen.
8 Display mode . . . .
If nothing happens after operation, you can just click another screen,
then click the screen you want, and then it should work properly.
9 Turning on or Turn on or off the screens configured for the currently selected
off screens video wall.
Decoding to
yvall . When a task has been configured, the platform will immediately
10 immediately .
decode channels to the video wall.
after
configuration
11 \I?VzchOdmg to Manually decode channels to the video wall.
12 Video wall Click to view the layout of the current video wall.
layout
13 V!deo wall The display area for video walls.
display area
14 Screen Includes stopping tour for the screen, muting, pasting, maximizing
operations or restoring the screen, and closing the screen,
15 Video wall olan Configure a timed or tour plan for the video wall. For detailed
P procedures, see "5.1.5.1.5 Configuring Video Wall Plans".
16 Vldeo'wall Select the video wall you want to configure.
selection
17 Display task Add, save, and delete tasks.
management

5.1.5.1.2 Preparations

To display video on the wall, make sure that:

e Cameras, decoders and video wall are well deployed. For details, see the corresponding user's

manuals.

e Basic configurations of the platform have been finished. For details, see "3 Basic Configurations".

During configuration, make sure that:

¢ When adding a camera, select Encoder from Device Category.

¢ When adding a decoder, select Video Wall Control from Device Category.

5.1.5.1.3 Adding Video Wall

Add a video wall layout on the platform.

Step 1
Step 2
Step 3

Log in to the DSS Client, and on the Home page, select Monitoring Center > .
From the Video Wall drop-down list, select Add New Video Wall.
Enter Video Wall Name, and then select a window splicing mode.
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e Select a splicing mode fromamong 1 x 1,2 x 2,3 X 3,4 X 4 or set a custom mode by
clicking [4].

e A multi-screen splicing mode is a combined screen by default. You can perform video
roaming on it. For example, with a 2x2 combined screen, if you close 3 of them, the
other one will be spread out on the combined screen. To cancel combination, click the
combined screen, and then click E

e To create a combined screen, press and hold Ctrl, select multiple screens, and then click
0

e To clear the created screen, click .

Figure 5-46 Add a video wall

Add Video Wall

1. Select layout 1. Select layou2. Bind channel

Basic Info

Video Wall Plan Name:

Remarks:

i

Cancel

Step4  Click Next Step.

Step5 Select the encoders which need to be bound in the device tree, and drag it to the
corresponding screen.

|

e You can set whether to show ID in the screen, E
disabled; click the icon and it becomes
enabled.

means that the screen ID is

e, which means that screen ID is

e FEach screen in a combined screen must be bound with a decoding channel.
Step6  Click Finish.

5.1.5.1.4 Configuring Video Wall Display Tasks

Display videos on the wall manually or in accordance with the pre-defined configuration.
Step1 Login to the DSS Client, and on the Home page, select Monitoring Center > .
Step2 Inthe Task drop-down list, select Add.
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Figure 5-47 Add a video wall task

2 video sources have been bound

View details in the list below

i el a B

Step 4

Step 5

Step 6

From the device tree, select a camera, and then drag it to a screen, or select a window, drag
the camera to the Detail section.

If you do not close video wall display in advance, this action will delete the bound camera
and play the selected camera on the wall.

Click E
L]

If you have selected an existing task in the Task drop-down list, after dragging the video

channel to the window, click to save it as a new task, which will be played on the wall

immediately.

Name the task, and then click OK.

e During video wall display of a task, if you have rebound the video channel, click @ to
start video wall display manual.

e During video wall display, click or @ to stop or start tour display.

Click n to start video wall display.

5.1.5.1.5 Configuring Video Wall Plans

Configuring Timed Plans

Step 1
Step 2
Step 3

Log in to the DSS Client, and on the Home page, select Monitoring Center > .
Click on the upper-right corner.

Hover over ., and then select .
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Figure 5-48 Set timed plan

Timed Plan-jhhjhh

Plan Name:

Start Time: End Time:

00:00:00 23:59:59

Task Name Start Time End Time Operation

7 0 00 99 o) o
25 00:00:00 23:59:59 [ ]

Enable this Timed Plan in Remaining ... Cancel

Step4  Enter the plan name.

Step5  Select avideo task, set start time and end time, and then click Add.
Repeat this step to add more tasks. The start time and the end time of tasks cannot be
repeated.

|

Select the Enable This Timed Plan in Remaining Time check box, and then set the task.
The video wall displays the selected task during the remaining period.
Step6 Click Save.

Step7  Click - to start the plan.
[1]

You cannot display multiple plans on the wall at the same time. When a plan is enabled,
the previous plan on the wall is automatically terminated.

Figure 5-49 Enable timed plan

Video Wall Plan-51

Plan 1

e Modify plan: E]

e Delete plan: E
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Configuring Tour Plans

After setting video wall tasks, you can configure the sequence and interval of tasks so that they can
automatically play in turn on the wall.
Step1 Login to the DSS Client, and on the Home page, select Monitoring Center > .

Step2  Click on the upper-right corner.
Step3  Hover over ., and then select .

Figure 5-50 Tour plan
Tour Plan-51

Stay Time:

20 Minute

Task Name Stay Time(min) Operation

Task 1 + ¥+ B

Task 2 + + B

- Cancel
Step4  Enter task name, select a video task and then set stay time. Click Add.
Repeat this step to add more tasks.

1]
Click to adjust task sequence; click E to delete a task.

Figure 5-51 Tour information

Step5 Click Save.
Step6  Click - to start the tour plan.
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You cannot display multiple plans on the wall at the same time. When a plan is enabled,

the previous plan on the wall is automatically terminated.

Figure 5-52 Enable tour plan

Video Wall Plan-51

e Modify plan: Click E]
e Delete plan: Click a

5.1.5.2 Video Wall Applications
(1]

Ll

Make sure that decoder video ports are connected to the video wall screens.

5.1.5.2.1 Instant Display

Drag a camera to the video wall screen for instant display on the wall.
The video wall display task is configured. For details, see "5.1.5.1.4 Configuring Video Wall Display

Tasks"

Step1 Loginto the DSS Client, and on the Home page, select Monitoring Center > .

Step2 Inthe Video Wall drop-down list, select a video wall.

Step3 Click BN to start video wall display.

Step4 Drag a camera from the device tree to a screen, or select a window and drag the camera to

the Detail section.
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e A window can be bound to multiple video channels.

e The binding mode, which includes Tour, Tile, and Inquiry, can be set in Local
Settings > Video Wall. For details, see "8.3.3 Configuring Video Wall Settings".

e For afisheye camera, right-click it to select the installation mode for fisheye dewarping.

Figure 5-53 Bind video channel

3 video sources have been

bound Video channel not bound
View details in the list below

Video channel not bound Video channel not bound

/] a A
‘Window Channel Stay Time(s) s Stream s Preset Point
ChannelOasfdfdas... 1 Main Stream
IP PTZ Camera

10001

Step5 Select a screen, and then click Detail to view detailed information about the screen and
channel, including stream type, preset and display sequence.
e C(lick ﬁ to view live video of the current channel on the lower left.
e C(lick m to adjust sequence.

e Click E to delete the video channel on the current window.

5.1.5.2.2 Video Wall Task Display

Display a pre-defined task on video wall.
Step1 Login tothe DSS Client, and on the Home page, select Tools > Video Wall.

N

Step In the Task drop-down list, select a task.

(O8]

Step Operations available.
e After changing the video channel that is being displayed, click @ at the lower-right
corner before you can see the effect on video wall.

o Click /@ to pause or stop.
e Select a screen, and then click Detail to view detailed information about the screen and
channel, including stream type, preset and display sequence.
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5.1.5.2.3 Video Wall Plan Display

Display a pre-defined plan on video wall.

[

Make sure that there are pre-defined plans. For details, see "5.1.5.1.5 Configuring Video Wall Plans".
The video wall automatically works as the plans have been configured. To stop the current plan, click
on the upper-right corner of the Video Wall page, and then it changes to . Click @ to start
displaying video on wall again.

Figure 5-54 Display video wall plan

4 video sources have been

bound Video channel not bound
View details in the list below

? Detail = ==
No.

Window Channel Stay Time(s) Stream . Preset Point Operation

5.2 Event Center

When alarms are triggered, you will receive notifications on real-time alarms. You can view their
details, such as snapshots and recordings, and process them. If you miss alarms occurred during a
certain period, or want to check certain alarms, such as high priority alarms occurred in the past day
or all alarms that have not been processed in the past week, you can set the search conditions
accordingly and search for these alarms. Based on all the alarms that were triggered, the platform
will generate statistics ready for your review. This can be helpful for how you can optimize your
security measures.

Make sure you have configured and enabled alarm events. To configure, see "4.1 Configuring
Events".

5.2.1 Real-time Alarms

View and process real-time alarms.

Step1 Loginto the DSS Client. On the Home page, click E, and then select Event Center.
Step2  Click Y.
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The alarm list is refreshed in real time. To stop refreshing, click Pause Refresh. To continue
receive alarms, click Start Refresh.

Figure 5-55 Real-time alarms

Alarm Source Priority Processed by Operation

High »

Step3  Click /Y to claim an alarm.
After an alarm has been claimed, the username of your account will be displayed under the
Processed by column.

Step4  Process alarms.

You can use the up and down arrow keys on the keyboard to quickly select other alarms.
1. Click &) or double-click the alarm.

Figure 5-56 Alarm details

Soft Trigger-222

2. The middle area displays the time when the alarm was triggered, name and location of
the alarm source, alarm type, and the live video images of linked channels, alarm
videos, and alarm snapshots.

Double-click a window to view them in larger size. Click to go back.
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Figure 5-57 Alarm linkage media

3. On theright side, select how to process the alarm from Resolved, Ignore, or Forward.
Enter comments, and then click OK.
Forward allows you to forward the alarm to another user who will process it.

4. (Optional) Click @ to disarm the alarm. This alarm will not be triggered within the
defined period.

5. (Optional) Click @ to send the alarm information to other users as a prompt or an
email.

Figure 5-58 Send email

Send Email

Select All Address:

Subject:

Body:

Event Time Event Type EventSource

Cancel

5.2.2 History Alarms

Search for and process history alarms.

Step1 Login to the DSS Client. On the Home page, click E, and then select Event Center.
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Step2  Click [
Step3  Set search conditions, and then click Search.

Figure 5-59 history alarms

% Alarm Category  Alarm Type Alarm Source Alarm Status

Fl
g

1 IPC 4894698464, Pending

»
3
»
»
¥
»
»
¥
»
¥
»
3
»
»
»
¥
¥
»
»
¥

Step4 Claim and process alarms, see "5.2.1 Real-time Alarms".

You can use the up and down arrow keys on the keyboard to quickly select other alarms.

5.2.3 Event Overview

With alarms being triggered and processed, statistics are generated to give you a clear picture of
what is happening in your area, such as the number of alarms that were processed, and the type of
alarms that are triggered most frequently.

Log in to the DSS Client. On the Home page, click FH, and then select Event Center.

e To view event overview, click [,
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Figure 5-60 Alarm overview

Table 5-10 Alarm overview description

No.

Parameter

Description

Search
conditions

To view real-time alarm overview, click Real Time, select a
site (if any), an organization, and refresh frequency.

To view daily alarm overview, click Daily, configure the
time, select a site, an organization, and then click Search.
To view weekly alarm overview, click Weekly, configure
the time, select a site, an organization, and then click
Search.

To view monthly alarm overview, click Monthly, configure
the time, select a site, an organization, and then click
Search.

(L]

If the time zone of the server is not the same as the DSS
client, statistics will be generated based on the time zone
of the server. For example, daily statistics will be generated
from 00:00 to 24:00 based on the time zone of the server.

Alarm
Overview

Statistics is generated based on the alarms that the current
user has access to. The number and proportion of alarm events
that are pending, processed, or not processed are displayed.

The data will only refresh in real-time when you are viewing
daily statistics.
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No. Parameter Description
Statistics is generated based on the events that the current
user has access to. The number of alarms of all priorities are
displayed.
The data will only refresh in real-time when you are viewing
o daily statistics.
3 Alarm Priority
©=n
You can click high, medium, or low to not include the number
of certain alarms. For example, if you click High, the number of
the alarms in this priority will not be counted.
Top 10 alarm sources that the current user has access to are
sorted by the number of alarms.
The data will only refresh in real-time when you are viewing
daily statistics.
4 Top 10 Alarm
Sources O
You can click high, medium, or low to not include the number
of certain alarms. For example, if you click High, the number of
the alarms in this priority will not be counted.
Top 10 alarm types that the current user has access to are
s Top 10 Alarm sorted by the number of alarms.
Types The data will only refresh in real-time when you are viewing
daily statistics.
6 Alarm Trend Displays trend of alarms of all priorities.

e To view and process alarms, click

e To view and process alarms, click

5.2.4 Alarm Controller

Al
(-2

You can monitor and manage alarms controllers.

Prerequisites

Alarm controllers are added to the platform. See "3.2.2 Managing Device".

Procedure

Step 1
Step
Step

w N

Log in to the DSS Client. On the Home page, click FH, and then select Event Center.

Click =,

In the device tree, click an organization.

All alarm controllers under this organization will be displayed on the right. You can select

one or more alarm controllers, and then click Arm or Disarm to arm or disarm the alarm

controllers you selected.
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If arming failed, you can click Force Arm on the prompt window to arm again.

Figure 5-61 Alarm controller organization

Alarm Controller

E Operation

§ 8 8 8 8 8 85§88 888#8858@§§

e @€ @€ @6 @ @ @ @ @ @ @ @ @ @ & o
% % %2 2 2 2 % % % % % 2 2 2 2 2

Step4 Inthe device tree, click an alarm controller.
All subsystems under this alarm controller will be displayed on the right.

You can right-click an alarm controller, and then click Update Alarm Controller to update
its information.

Figure 5-62 Subsystems

Alarm Controller ARC9016C-zhu

Subsystem Name Arming Status Alarm Status v  Operation
Normal ]
Normal
Normal

Normal

A

Normal

€

¢ ¢

[/ ¢

[/ €

Normal ] €
L/ €

¢ ¢

4 G

Normal

o R Operate on one systems.

L]

e See the user manual of the alarm controller for detailed description on each function.
e If arming failed, you can click Force Arm on the prompt window to arm again.

Step6 Inthe device tree, click a subsystem of the alarm controller.
All zones under this subsystem will be displayed on the right.
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Figure 5-63 Zone

Alarm Controller Subsystem_1

Bypass Status ~  Realtime Status

lormal

Step7 Bypass, isolate, or unbypass zones.

° ICEEER (| NENEEROMIRIAEEES: Operate on multiple zones.
o BuBlI[BTE: Operate on one zone.
[L]

e See the user manual of the alarm controller for detailed description on each function.
e If arming failed, you can click Force Arm on the prompt window to arm again.

5.3 DeepXplore

You can set multiple search conditions to view records of people, vehicle snapshots, access, POS,
and MPT.

5.3.1 Searching for Records

In this section, you can view integrated records of people, vehicle, access, POS, and MPT.
Step1 Login to the DSS Client. On the Home page, click E, and then select DeepXplore.
Step2 click [@4 and then select Record.
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Figure 5-64 Record search

Record

MNon-Motor Vehicle Captu Ie- .-I

LN

Person POS Records

Vehicle

Step3  Set the search object, channel and time, and then click Search.

Figure 5-65 Search result

| el = =i
EJ o o o 3

)

For the search result, you can perform following operations.

e (lick next to the record to add it to temporary records.

e For face capture records, you can hover the mouse over the small image on the right,
and then click i8] to search for images similar to this one. For details, see "5.3.2
Searching for People".

e C(lick E next to the record to delete it one by one.

Access records and POS records cannot be deleted.
e Click Export to export records to the local storage.
Step4  Select arecord, and on the right side, you can see the details. Click on the video image to
view the linked recording.
click at the upper-right corner to view all records added to temporary records. Inside
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it, you can click . to generate target track, and click . to remove the record form the
bank.

5.3.2 Searching for People

Based on the defined search conditions, you can view records of people face, body and related
information from corresponding database.
Step1 Login to the DSS Client. On the Home page, click E, and then select DeepXplore.

Step2 click ., and then select Person.

Figure 5-66 Person search

Record

Face Capture Body Capture Person Archive

Person

Vehicle

e Search object
¢ Face Capture: Search for records in face capture database.
¢ Body Capture: Search for records in body capture database.
¢ Person Archive: Search for records in person information database.
e Search type
o Search by Feature: Search for records by the defined features such as age, gender,
clothes color, ID and more.
¢ Search by Image: Search for records by the uploaded image, and only records
above the set Similarity will be displayed.

Only new versions of IVSS devices support displaying similarity.
¢ Search channel: Select device channels of the records by clicking Selected Channel.
o Search time: Select time period of the records from Today, Yesterday and This
Week.
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Only available for face and body capture records.
e Search conditions: Set search conditions such as age, gender, top color, ID, name and
more to search for specific records.
Step3  Set the search object, type and conditions, and then click Search.

Figure 5-67 Search result

For the search result, you can perform following operations.
e (lick next to Search to change search conditions.

o C(lick MEERISES to change records arrangement.
e C(lick g8] next to the record to add it to temporary records.
e Click E next to the record to delete it one by one, or you can select records, and then
click Delete to delete them in batches.

e Click Export to export records to the local storage.

Step4  Select arecord, and on the right side, you can see the details. Click the video image to view
the linked recording.
Click at the upper-right corner to view all records added to temporary records. Inside
it, you can click [ to view the target track, and click B to remove the record form the
bank.

Step5 Go backto Step2, and then click Person Archive.

Step6  Enter the ID, name or card number of the person you want to search for.

Step7  Double-click the record.
You can see the face capture, vehicle capture, access records and other information of the
corresponding person.
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Figure 5-68 Person information

5.3.3 Searching for Vehicles
Step1 Loginto the DSS Client. On the Home page, click E, and then select DeepXplore.
Step2  click , and then select Vehicle.

Figure 5-69 Vehicle search

Record
Vehicle Capture Vehicle Archive

Person 0] d Channel(0)

Plate No.:

ﬁ Full Plate No.

Vehicle

e Search object

o Vehicle Capture: Search for records in vehicle capture database.
¢ Vehicle Archive: Search for records in vehicle information database.
e Search type
¢ Search channel: Select device channels of the records by clicking Selected Channel.
¢ Search time: Select time period of the records from Today, Yesterday and This
Week.
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Step 3

Step 4

|

Only available for vehicle capture records.

e Search conditions: Set search conditions such as plate number (full plate number

optional), vehicle brands, owner name and more to search for specific records.
Set the search object, type, channel and time, and then click Search.
For the search result, you can perform following operations.
e C(lick next to Search to change search conditions.
o Click ith3
e C(lick next to the record to add it to temporary records.

to change records arrangement.

e C(lick E next to the record to delete it one by one, or you can select records, and then
click Delete to delete them in batches.

e Click Export to export records to the local storage.

Select a record, and on the right side, you can see the details. Click on the video image to

view the linked recording.

click at the upper-right corner to view all records added to temporary records. Inside
it, you can click . to generate target track, and click . to remove the record form the
bank.

5.3.4 Searching for POS Transaction

You can search for POS transactions by keywords and POS fields.

Step 1

Step 2

Log in to the DSS Client. On the Home page, select E > DeepXplore > DeepXplore >
POS Transaction.
Configure POS field.
1) Click POS Field Config.
2) Configure a POS field for its receipt field, and then click [l to enable it.
3) Click OK.
Configure the search conditions.
1) Configure the information you want to search for.
e POS Info: Keywords in the transaction information. This can be used with one or
more POS fields at the same time.
e POS fields: The POS fields you have configured in step 2 will be used to search for
certain information in the transactions. For example, the POS field for total price is
TTL, then the platform will obtain the number for TTL and return the results.
2) Select POS channels, configure the period, and then click Search.
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Figure 5-70 Search results

- POS Record Details

post-Ift
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1
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Step4 Manage the search results.

e View details.

Select a transaction, and then you can view the detailed information and video at the

time of transaction on the right.
[1]

If you need video at the time of transaction, you must bind POS channels with video

channels, and configure recording plans for the video channels. For details, see "3.2.3

Binding Resources" and "3.2.4 Adding Recording Plan".

e Addtoacase.

1.
2.
3.

Click of a transaction to add it to the temporary library.
Click on the upper-right corner.

Select one or more transactions, and then click Add to Case.
Select a case, and then click OK.

(@zC
In the temporary library, select one or more transactions, and then click H to

remove them. This operation will only remove them from the temporary library, but
not delete them.

o View track.

1.
2.

3.

Click of a transaction to add it to the temporary library.
Click on the upper-right corner.

Select transactions, and then click . The platform will open a page and display

the track based on the transactions you select.
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If you need to view tracks, you must mark POS channels on the map first. For details,
see "4.2.3 Marking Devices".

5.3.5 Adding Case Bank

Inside the case bank, you can integrate the records of face, plate, access and more into one complete
case, and configure details of it for future investigation. The platform supports storing up to 10,000
cases.

Prerequisites
The case files can only be stored in Incident File disk. Make sure that you have configured such disk
type in advance.
Users with access to Case Bank:
e Super administrator: View, edit and delete incident files.
e Administrator:
¢ View incident files created by themselves and common users. No access to incident files of
other administrators.
¢ Edit and delete files opened.
o Cannot edit or delete files closed.
e Common user:
o Can only view files created by themselves.
¢ Edit and delete files opened.
¢ Cannot edit or delete files closed.

Procedure
Step1 Loginto the DSS Client. On the Home page, click E, and then select DeepXplore.
Step2 click B
Step3 Click Add to add a new case.
Step4 Inthe Case lcon section, click one of the 5 small squares, drag the image file to the big

square on the left, or hover the mouse over the big square, click ., and then upload

the image file.
The image you select will be displayed on the upper-left corner of the case you export.
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Step 5

Figure 5-71 Select an image for the case

Case Icon

.

Select an image from the right side of the Case Icon section, which will be located at the
upper-left corner of the case file generated. You can change the icon by dragging the
image from the right side to the left side image area.

Only one icon can be added onto the case file.

Enter the basic information of the case.

e Case Type: Used for categorize cases. You can click the drop-down list to select type or
create new ones.

e Status: Select the case status from Open and Close. The Platform integrates cases
under each status category.

Add records, including face capture, body capture, ANPR, access record and more.

Records of other categories are added in the same way. In this section, we take Face

Capture as an example.

1. Click Add under Face Capture.

2. Select channels and time, and then click Search. You can click the record to view its
details.
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Figure 5-72 Add face capture record

9 Face Capture

Image Time Channel Name Operation @ irc

2021-04-12 09:32:18 %

3. Click next to the record to add it to the case.

4. Click to go back to the case adding page, you can add other type of records

related to the case.

Step8  Scroll down and click Add under Attachment to upload images and videos related to the

case.

e The platform supports uploading up to 20 videos, and each video cannot exceed 300

MB. Format includes dav, mp4, avi, flv and asf.

e Up to 20 images can be uploaded. Image format includes png, jpg and jpeg.

The number of all video files and images cannot be more than 20.

Step9  Click OK.

Related Operations
e Delete or replace anicon

Hover the mouse over a small square, and then click E to delete it; click a small square, and

then drag an image file to the big square on the left, or hover the mouse over the big square,

click ., and then upload the image file to replace it.

e Enter case name in the search box at the upper-right corner, and then press Enter or click @ to

search for cases.

e (lick under a temporary case to view the case details. If you need to edit the details, click Edit

and change the information as needed.

e Click [E under a temporary case to download it, or you can click Download in the case details

page. Click Download Progress at the lower-left corner to check the download progress.

e Click B under a case to delete it one by one, or you can select cases, and then click Delete to

delete them in batches.
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5.3.6 Viewing Track of MPT Devices

Search for and view the track of an MPT device on the map within the defined period.

Prerequisites
e Configure the vector map. For details, see "4.2.2.1 Adding Vector Map".
e Add MPT devices to the platform. For details, see "3.2.2.4 Adding Devices".
e MPT devices upload their GPS information to the platform. For details, see their user's manuals.

Procedure
Step1 Login tothe DSS Client. On the Home page, click E, and then select DeepXplore > MPT
Track.
Step2  Select an MPT device, configure the time, and then click Search.
The track of the MPT device will be displayed on the map.

[

You can only search for up to 24 hours of track in the same day. For example, 00:00 to
23:59:59, or 3:00 to 23:59:59.

5.4 Access Management

On the Access Management page, you can do operations on access control, lift control, attendance,

video intercom, and visitor.

5.4.1 Access Control Application

You can unlock and lock doors, view details of bound videos and event, and the access control logs.
Make sure that you have finished the access control configuration before application. For details, see
to go to the access control configuration

"4.5 Access Control". You can also click | el

page.

5.4.1.1 Viewing Videos

If you have already bound a video channel to the access control channel, you can view the real-time
videos of the channels on the console. To bind video channels, see "3.2.3 Binding Resources".

Log in to the DSS Client. On the Home page, select E > Access Management > > Access
Control Console, and then view the linked real-time videos by the following two methods.
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e On theright side of the console page, click m in the access control channel list.

Figure 5-73 Viewing video (1)
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Control

e C(lick on the console page. The video page is displayed. Drag the access control channel on

the left side of the screen to the live view page on the right side. The system displays videos in

236



@hua .
fEcHNoLoGY User's Manual

real time.

Figure 5-74 Viewing video (2)
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5.4.1.2 Unlocking Door

In addition to Always Open or linked unlock in specified periods, the console also supports
unlocking by manually controlling the access control channel. After unlock, the door automatically
locks up after a specified period (5 s by default, and 10 s in this example) set up in Door Config.

[

This section introduces the unlocking operations on DSS client. For unlocking by fingerprint, card,
and face recognition, you can operate on devices. If advance functions are configured, unlock doors
according to the requirements of advance functions.

There are the following ways to unlock door:

e On the left side of the page, right-click an access control channel in the device list, and select
Remote Unlock in the pop-up menu. After unlocking, the door status in the access control
channel list on the right side of the page changes to open, as [ll.

e C(lick Eu of a door channel on the right to unlock the door.

e When viewing videos bound to the channel, click [E on the video page to unlock the door.
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Figure 5-75 Unlock door

Resources

13 Door1

» M Main Map

N

?Evgmt Informa... B i & Alarm B Abnormal @ Normal

Time Locati... Perso... ID Room No. Event Event.. O

16:25:.. Doorl Piatio..  [NCHEE ©
6:16 Platio..  [NCHEE ©

Global Control oor Piatio..  [NCHEE ©

2:.. Doorl Platio..  [NCHEE ©
Doorl stio.. [ NCHE ©

e Temporary Always Open of multiple doors

Select door channels through global control, and then you can set the door to be Always Open.

Step1  Click n on the lower left of the console page of the Access Control Console module.

Step2  Select an access control channel to be set to Always Open through global control, and click
OK.

Step3  Click n on the lower-left corner of the page.

Step4  Click OK.
All the doors of the selected access control channels are set to Always Open.
Click to restore the door from the Always Open or Always Closed status before the
scheduled door control or face-recognition access control takes effect.

5.4.1.3 Locking Door

In addition to Always Close or linked lock in specified periods, the console also supports locking by

manually controlling the access control channel. You can lock the door in the following ways:

e On the left side of the page, right-click an access control channel in the device list, and select

Remote Lock in the pop-up menu. After locking, the door status in the access control channel list

on the right side of the page changes to closed, as [H.

e (lick E of a door channel on the right to unlock the door.

e When viewing videos bound to the channel, click |E on the video page to lock the door.

e Temporary Always Close of multiple doors
Select a door channel through global control and you can set the door to be Always Close.
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Step1  Click E on the lower left of the console page of the Access Control Console module.
Step2  Select an access control channel to be set to Always Close via global control, and click OK.
e

Step3 Click D at lower-left of the page, and then click OK.
L]

Ll

Click to restore the door from the Always Open or Always Closed status before the

scheduled door control or face-recognition access control takes effect.

5.4.1.4 Viewing Event Details

View details of the events reported on door locking and unlocking, including event information, live
view, snapshot, and recording.

[

e Live view is only available when a video channel is bound to the access control channel. To bind
video channels, see "3.2.3 Binding Resources".

e To see snapshots and videos of access control, you need to configure video linkage action for the
access control channels. For details, see "4.1 Configuring Events".

e Details except locking door are displayed on the console, such as unlocking door, entry with the
duress card, and no right.

Step1 Inthe event list below the console page, click [8] next to the event records.
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|

For a face recognition controller, the face snapshots will be displayed in the records; for
other controllers, the records display the captured image and person profile.

Figure 5-76 Event information

Resources

Table 5-11 More operations

No. Description

You can choose to view the events of certain event types. For instance, if you select
Normal, the list only displays normal events.

e C(lick m to stop displaying reported event information. In this case, the page no
longer displays the reported new events. After clicking, the button changes to u

2 e C(lick u to start refreshing reported event information. The page does not
display events during the stopping period. After clicking, the button changes to

3 Clear the events from the current event list without removing them from the log.

4 Click to view access control records.

Step2  Click the corresponding tab to view the live view, snapshots, and video recordings of the
linked video channel.
5.4.1.5 Viewing Access Control Records
You can view access control records on the platform or directly on a device. For records on a device,
see "8.1 Managing Logs".
5.4.1.5.1 Online Records

The access control records stored on the platform.
Step1 Loginto the DSS Client. On the Home page, clickEH > Access Management > @ >

Access Control Record.
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Step2 Set search conditions, and then click Search.

Figure 5-77 Search result

Room No. Card No. Ve Person Name Status Operation

(o]
(o]
®
(o]
(o]
(o]
(o]
(o]
(o]
(o]

Step3  Manage event records.
e Click 8 and you can view live view, snapshot and recording, and person information
access control events.
e Click Export at the upper-left corner of the page, and then export records as the screen

instructs.

5.4.1.5.2 Offline Records

The access control records stored in the device when it was disconnected from the platform. After
the device gets reconnected to the platform, you can retrieve the records generated during the
disconnection.

Step1 Loginto the DSS Client. On the Home page, click E > Access Management > Eﬂ >

Access Control Record.

Step2 Click _ at the upper-left corner.
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Figure 5-78 Extract records during disconnection
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Step3  Enter the login password for verification.
Step4  Click E] to set period, select Card-swiping Records or Alarm Log, and then select

device.
1]

® You can select up to one week.

e The types of logs supported include door not closed in time alarms, intrusion alarms,
anti-passback alarms, duress alarms, device temper alarms, blocklist alarms, too many
attempts on invalid passwords and cards alarms.

Step5 Click OK.

5.4.2 Lift Control Application

You can control lifts, view linked real-time videos and event details, and the lift control records.
Before using these functions, you must:
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e Add lift control devices to the platform. For details, see "3.2.2 Managing Device".
e Assign lift control permissions to people. For details, see "4.3.1.2.1 Adding a Person".

5.4.2.1 Viewing Videos

If a lift control channel has been linked to a video channel, you can view its real-time video in the lift
control console so that you can monitor what is happening near the lift. For how to link a lift control
channel to a video channel, see "3.2.3 Binding Resources".

Log in to the DSS Client. On the Home page, select FH > Access Management > Lift Control > Lift
Control Console, and then view the linked real-time videos in the following two methods.

e Click HH, and then click m of a lift control channel.

e Click , and then drag a lift control channel to a window on the right, or select a window on
the right, and then double-click a lift control channel.

5.4.2.2 Global Control

You can select multiple lift control channels, and then set them to the no authentication mode,

authentication mode or lock mode.

e No authentication mode: All people will have permissions to use the selected lift control
channels.

e Authentication mode: All people will need to verify if they have permissions to use the selected
lift control channels.

Lock mode: No person will have permissions to use the selected lift control channels.
tep1 Login tothe DSS Client. On the Home page, select B > Access Management > Lift

:

Control > Lift Control Console.

Step2 Click n next to Global Control.
Step3  Select multiple lift control channels, and then click OK.
Step4  Click , H or ﬂ to set them to no authentication mode, authentication mode

or lock mode.

5.4.2.3 Viewing Event Details

View details of the events reported when someone used a lift, including event information, live
video, snapshots, and record videos.

B

e Live videos are only available when a lift control channel has been linked to a video channel. For
details, see "3.2.3 Binding Resources".
e To view snapshots and videos in an event, you need to configure the event for the lift control
channels. For details, see "4.1 Configuring Events".
Step1 Log in to the DSS Client. On the Home page, select FH > Access Management > Lift
Control > Lift Control Console.
Step2 Inthe event list on the bottom of the page, double-click an event to view its details.
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Table 5-12 More operations

Icon Description

You can choose to view only certain types of event. For
@ B Normal example, if you select Normal, the list only displays normal
events.

e (lick m to stop displaying reported event information. In
this case, the page no longer displays the reported new
events. After clicking, the button changes to u Click it so
that new events can be reported again.

e Click E to clear all events in the list, but it will not delete

them from the lift control records.
e Click to go to the lift control records page.

Clear the events from the current event list without removing
them from the log.

Click to view access control records.

Step3  Click the corresponding tab to view the live video, snapshots, and recorded videos.

5.4.2.4 Viewing Lift Control Records

Step1 Login to the DSS Client. On the Home page, select B > Access Management > Lift
Control > Lift Control Records.
Step2 Configure the search conditions, and then click Search.
Step3  Manage the records.
e Click 8] to view the information, real-time video, snapshots, and recorded video of
an event.
e Click Export on the upper-right corner, and then follow the on-screen instructions to

export records to your computer.

5.4.3 Video Intercom Application

e You can call, answer, release information and view video intercom records.
e Make sure that you have configured the video intercom configuration before application. For

details, see "4.6 Video Intercom”. You can also click LEGIESEEEE to go to the video intercom

configuration page.

5.4.3.1 Call Center

The platform, VTOs, VTHSs, second-generation door station access controllers, and second-generation

fence station access controllers can call each other.

Step1 Login tothe DSS Client. On the Home page, click E > Access Management > (&3 >
Call Center.
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Figure 5-79 Call center

Step2  You can call different devices.
e Call from the platform to VTO
Select VTO in the device list; click u corresponding of VTO or dial a number on the
dial pad to call the VTO. The system pops out call page. The following operations are
supported during call.
o E; If VTO is connected to lock, click this icon to unlock.
o [[BI: Click this icon to capture picture, the snapshot is saved into the default
directory. To change the path, see "8.3.5 Configure File Storage Settings".
o [0 Click this icon to start record, click again to stop record. The video is saved in

default path. To change the path, see "8.3.5 Configure File Storage Settings".
o B Click this icon to hang up.

Figure 5-80 Call

Calling building 1

e (all from the platform to VTH
Select VTH from the device list, click on the VTH or dial corresponding VTH on the
right (such as 1#1#101). The system pops up the dialog box of Calling now, please
wait.... There are two modes for answering the call.

o Answer by VTH, bidirectional talk between client and VTH. Press ISl to hang up
when you answer the call.
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o If VTH fails to answer over 30 s, hangs up directly or is busy, then it means the call is
busy.

Figure 5-81 Calling

Calling room

00:01

room

Being called ...

e (Call from the platform to an access control device that supports video intercom
Select a device from the device list, click on it or dial its number on the right (such

as 1#1#101). The system pops up the dialog box of Calling now, please wait.... There

are two modes for answering the call.

o Answer by the device, bidirectional talk between client and the device. Press [
to hang up when you answer the call.

o If the device fails to answer over 30 s, busy or hang up directly, then it means the
callis busy.

Figure 5-82 Calling

Calling

A a8 @O W [P J—

e (Call from VTO to the platform
VTO calls Pro, client pops up the dialog box of VTO calling.
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o E: If VTO is connected to lock, click this icon to unlock the door.

o [IE: Click this icon to answer VTO, realize mutual call after connected.
o I Click this icon to hang up.

Figure 5-83 VTO Call

2nd is calling you

e When VTH is calling the platform
The client pops out the dialog box of VTH calling. Click to talk with VTH.
o Click to answer VTO, realize mutual call after connected.
o Click [IEM to hang up.
e When an access control device that supports video intercom is calling the platform
The client pops out the dialog box. Click to talk with the device.
Click I to hang up.

Figure 5-84 Call from an access control device that supports video intercom
ASC101 is calling you

e Call through call records
All the call records are displayed in the Call Record at the lower-right corner of the
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page of Video Intercom. Click the record to call back.

Figure 5-85 Call records
O
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5.4.3.2 Releasing Messages

Send message to VTHs.
tep1 Login to the DSS Client. On the Home page, click E > Access Management > Video

:

Intercom > Information Release.

Step2 Click Add New Message, select one or more VTHs, and then configure the information you
want to send.

Step3  (Optional) Enable Schedule Release, and then configure the time.

Step4  Send the message.

e If no scheduled release time is configured, click Instant Release, or click Save, and then
click to send the message immediately.

e If a scheduled release time is configured, click Save, and then the message will be sent
on the defined time.

5.4.3.3 Video Intercom Records

View log records and you can trace recorded calls.

Step1 Loginto the DSS Client. On the Home page, click E > Access Management > (&4 >
Video Intercom Record.

Step2  Set conditions, and then click Search.
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Figure 5-86 Video intercom records

Call Type

Step3  Click Export and the records will be saved locally according to system prompt.

5.4.4 Viewing Attendance Data

View attendance data, displayed in the form of report, including card swiping record table,
attendance report, abnormality table, overtime table and away table. This section takes Card-
swiping Record as an example.

Prerequisites

You have configured the attendance configuration before application. For details, see "4.7

Attendance Management". You can also click [ BEEERRSREeE] to go to the attendance

configuration page.

Procedure
Step1 Login to the DSS Client. On the Home page, click FH > Access Management > >
Attendance.
Step2 Click corresponding tab, set search condition, and then click Search.
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Figure 5-87 Attendance

Attendance Report Exception Overtime

Person Group Card Swiping Time Attendance Terminal  Event Operation

Step3  Manage search results.
e (lick Export at the upper-left corner of the page, and then export records as the screen
instructs.
e When card swiping records are displayed in list, click [8] to view the details of the
corresponding user.

Related Operations
When viewing attendance report, you can manually synchronize attendance records from devices.
Click Sync Offline Records, configure the time and channels, and then click OK to synchronize the
records from the channels you selected to the platform. The attendance report will be updated

accordingly. To automatically synchronize attendance records, see "4.7.4 Synchronizing Attendance
Records".

5.4.5 Visitor Application

After appointment is made on platform, and visitor information is registered, the visitor can have
access permission. Access permission is disabled after the visitor leaves.

5.4.5.1 Preparations

e You have configured the deployment of the video intercom devices, access control devices and
entrance and exit device. For details, see the corresponding user's manual.

e You have configured the basic configuration of the platform. For details, see "3 Basic
Configurations".

e Make sure that you have configured the visitor configuration before application. For details, see

"4.8 Visitor Management". You can also click [-REEree to go to the video intercom
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configuration page.

5.4.5.2 Visitor Appointment

Register visitor information on the platform.
Step1 Login to the DSS Client. On the Home page, click B > Access Management > [B] >

Visitor Management.

Step2 Click Visitor Registration.
Step3 Click the Visitor Details tab, enter the information of the visitor and the one to be visited.

Figure 5-88 Visitor details

|

Click in the appointment list to enter the Visitor Details tab.

Step4  (Optional) Click the Authentication tab, select the room number to be visited, and then
click Generate to generate the QR code of the pass.
You can click to download the QR code, and click £l to send it to the visitor by email.
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Figure 5-89 Authentication

Visitor Pass

Visitor Pass

PhaoneMo.:

Plate Mo.:

1D Mo.:

Remarks: Welcome!

Step5 Click OK.

5.4.5.3 Checking In

When a visitor with an appointment arrives, you need to confirm their information and give them
access permission. On-site registration is supported when there is a walk-in visitor. Visitors can get
access by card swipe or face recognition.

Procedure
Step1 Logintothe DSS Client. On the Home page, click Eﬂ > Access Management > E >
Visitor Management.
Step2  Enter the information of the visitor.
1) Go to the visit registration information page.
e If avisitor has an appointment, find their visitor information, and then click =
e [f avisitor does not have an appointment, click Visit Registration.
2) Confirm or enter visitor information.
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Figure 5-90 Visitor information

Step3  (Optional) Click the Authentication tab, and then set authorization information.

1) Select the room number.

2) lIssue cards.
You can issue cards by entering card number manually or by using a card reader. A card
number is 8-16 numbers. Only second-generation access control devices support 16-
digit card numbers. When a card number is less than 8 numbers, the system will
automatically add zeros prior to the number to make it 8 digits. For example, if the
provided number is 8004, it will become 00008004. If there are 9-16 numbers, the
system will not add zero to it.
e Issue cards by entering card numbers manually

Click Add next to Card, enter the card number, and then click OK.

Figure 5-91 Issue card

Card L+

ssue Card

Card Number:

e Issue card by using a card reader
Click E, select a card reader or device, and then click OK. Swipe card through the

reader or device, and then a new card will be issued.
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Figure 5-92 Reader manager

Card Add IE

Reader Manager

Card Reader:

3) Set face picture. Position your face in the snapshot area, and click Upload Picture to

select a picture or click Snapshot to take a photo.

Figure 5-93 Take a face photo

r

Upload Picture

Snaphot

4) Click Generate to generate a QR code for the pass.
You can click to download the QR code, and click &l to send it to the visitor by
email.
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Figure 5-94 Authentication

Visitor Pass

Visitor Pass

Ben’
Phone Mo.:
Plate Mo.:
1D Mo.:

Remarks: Welcome!

Step4  Click the Authorize tab, and then select access permissions for the visitor.
(1]

If you want to set video intercom devices and entrance and exit permissions, you must set
host room number and number plate for the visitor.

Figure 5-95 Authorize

Entrance and Exit

Step5  Click OK.

Related Operations
e End visit.
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Click E to end a visit.
e View card swiping records.
Click the Card-swiping Record tab, or click in visitor record to view visitor card swiping

records.

e (Cancel appointment.

Click E!] and cancel the appointment as the screen instructs.

5.4.5.4 Checking Out

When visitors are leaving, remove their access permissions.

Step 1

N

Step
Step

w

Log in to the DSS Client. On the Home page, click B > Access Management > [E] >
Visitor Management.

Find the appointment record of the visitor, and then click [&.

Click OK to remove access permission.

If you have issued a card to a visitor, make sure the visitor returns the card before leaving.

5.4.5.5 Searching for Visit Records

Search for visit records, and view visitor details and card swiping records.

Step 1

Step 2

Step 3

Log in to the DSS Client. On the Home page, click B > Access Management > [E] >
Visitor Record.

Set search conditions, and then click Search.

The results are displayed.

[

In addition to entering the card number, you can also click [, select a card reader and
then get the card number by swiping card.
Click [B] to view visitor details and card swiping records.

5.5 Parking Lot

You can monitor vehicles that enter and exit in real time, view vehicle information, and search for

on-site vehicle, exit vehicle and snapshot records, and manage parking lots intuitively through their

different layers.

5.5.1 Entrance and Exit Monitoring

Step 1

Step 2
Step 3

Log in to the DSS Client. On the Home page, click E > Parking Lot > Entrance and Exit
Monitoring.

Select the number of windows you want from EIEIEIENS].

Click Please click to select the entrance and exit., select an entrance or exit point, and
then click OK.

The real-time video of that point will be opened in the window.
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Figure 5-96 Monitor entrances and exits

Table 5-13 Page description

No. Description

Select the number of windows you want. Each window can display the real-time
video of one entrance or exit point.

The real-time video of an entrance or exit point.
o C(lick G' to open the real-time video of another entrance or exit point in the
window.
e C(lick to open the barrier for vehicles.

¢ Open without Recording Plate Info: Open the barrier for vehicles
without recording their plate numbers. If you select Count Parking

2 Spaces at the same time, the number available parking spaces in the

parking lot will decrease or increase depending on whether the vehicles

are entering or leaving. This operation will not generate an enter or leave

record.

o Open and Record Plate Info: This is applicable to when the ANPR
cameras cannot recognize the number plates. You can manually enter the
number plate, and a snapshot will be taken, and then the platform will
generate an entrance or exit record.

Displays records of barriers not opened.

3 e C(lick uto open the barrier for the vehicle.

e If the plate number is incorrect, you can click to manually edit it.
o C(lick to view the recorded video from the corresponding channel.

All entrance and exit records.
4 ° u@: Pause or resume refreshing the entrance and exit records.
° : View the details and recorded video of a record.
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5.5.2 Searching for Records

Search for entry and exit records, forced exit records, parking records, and snapshot records.

Log in to the DSS Client. On the Home page, click HH, and then select Vehicle Entrance and Exit.

Click B

to go to the entrance and exit configuration page.

5.5.2.1 Searching for Entrance Records

Step 1
Step 2
Step 3

Log in to the DSS Client. On the Home page, click B > Parking Lot > Info Search.
Click the Entrance Records tab.
Configure the search conditions, and then click Search.

[

Click Show More and you can search by vehicle owner, company, person group, and more.

Manage the records.

e C(Click the image, and then a bigger one will be displayed.

e Double-click a record or click , and the detailed information is displayed on the
right. Click the play icon to play the recorded video, and then click g to download it.
Click to modify the information of the vehicle, such as the plate number, brand
and color.

For the dual camera mode, click each channel to view the information it captured.

o C(lick Layer Info to view the location of the channel that captured the vehicle on the
layer.

e Forced exit.

If No is displayed under Already Exited when the vehicle has exited, click [ to
change the status to Yes.

e Export records.

Select the records to be exported, click Export, and then export them according to the
on-screen instructions. You can also click Export, and the then export all records
according to the on-screen instructions.

e C(lick and then select the items to be displayed.

5.5.2.2 Searching for Exit Records

Step 1
Step 2
Step 3

Step 4

Log in to the DSS Client. On the Home page, click B > Parking Lot > Info Search.
Click the Exit Records tab.
Configure the search conditions, and then click Search.

[

Click Show More and you can search by vehicle owner, company, person group, and more.
Manage the records.

e C(Click the image, and then a bigger one will be displayed.

e Double-click a record or click , and the detailed information is displayed on the

right. Click the play icon to play the recorded video, and then click g to download it.
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Click to modify the information of the vehicle, such as the plate number, brand
and color.
For the dual camera mode, click each channel to view the information it captured.

e Click Layer Info to view the location of the channel that captured the vehicle on the
layer.

e Export records.
Select the records to be exported, click Export, and then export them according to the
on-screen instructions. You can also click Export, and the then export all records
according to the on-screen instructions.

e C(lick and then select the items to be displayed.

5.5.2.3 Searching for Forced Exit Records

Step 1
Step 2
Step 3

Step 4

Log in to the DSS Client. On the Home page, click B > Parking Lot > Info Search.
Click the Forced Exit Records tab.
Configure the search conditions, and then click Search.

|

Click Show More and you can search by vehicle owner, company, person group, and more.

Manage the records.

e C(lick the image, and then a bigger one will be displayed.

e Double-click a record or click , and the detailed information is displayed on the
right. Click the play icon to play the recorded video, and then click g to download it.

Click to modify the information of the vehicle, such as the plate number, brand
and color.
For the dual camera mode, click each channel to view the information it captured.

e Click Layer Info to view the location of the channel that captured the vehicle on the
layer.

e Export records.
Select the records to be exported, click Export, and then export them according to the
on-screen instructions. You can also click Export, and the then export all records
according to the on-screen instructions.

e C(lick and then select the items to be displayed.

5.5.2.4 Searching for Parking Records

Step 1
Step 2
Step 3

Step 4

Log in to the DSS Client. On the Home page, click B > Parking Lot > Info Search.
Click the Parking Records tab.
Configure the search conditions, and then click Search.

|

Click Show More and you can search by vehicle owner, company, person group, and more.
Manage the records.
e C(lick the image, and then a bigger one will be displayed.
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Double-click a record or click , and the detailed information is displayed on the
right, including entry and exit records. Click the play icon to play the recorded video,
and then click g to download it.

For the dual camera mode, click each channel to view the information it captured.
Click Layer Info to view the location of the channel that captured the vehicle on the
layer.

Export records.

Select the records to be exported, click Export, and then export them according to the
on-screen instructions. You can also click Export, and the then export all records
according to the on-screen instructions.

Click and then select the items to be displayed.

5.5.2.5 Searching for Capture Records

Step1 Login to the DSS Client. On the Home page, click B > Parking Lot > Info Search.

Step2  Click the Capture Records tab.

Step3  Configure the search conditions, and then click Search.

[

Click Show More and you can search by vehicle owner, company, person group, and more.

Step4 Mange records.

Click the image, and then a bigger one will be displayed.

Double-click a record or click , and the detailed information is displayed on the
right. Click the play icon to play the recorded video, and then click g to download it.
Click to modify the information of the vehicle, such as the plate number, brand
and color.

For the dual camera mode, click each channel to view the information it captured.
Restore entry

If Yes is displayed under Exited when the vehicle is still in the parking lot, click @ to
change the status to No.

Export records.

Select the records to be exported, click Export, and then export them according to the
on-screen instructions. You can also click Export, and the then export all records
according to the on-screen instructions.

Click and then select the items to be displayed.

5.5.3 Visualized Parking Lot

Quickly understand your parking lot by viewing the information on the layers.

Step1 Login to the DSS Client. On the Home page, click E > Parking Lot > Visualized

Parking Lot.
Step2  Select a parking lot, and then double-click a layer.
Step3  View the information on the layer.
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Table 5-14 Operation description

Icon/Parameter Description

E View the total and available parking spaces on the layer.
@ View all the resources on the layer.

Zoom in and out on the layer.

Display Selected Layers | Select which resources you want to display on the layer.

Click and hold on the layer to select multiple devices. After you select
multiple devices, you can perform the following operations:

° Ez View the capture records from the selected devices.
° Ez View the entrance records from the selected devices.
e [T view the exit records from the selected devices.

° E: View the parking records from the selected devices.

Pane ] ) ] )

° @: Open a video player and you can view the real-time video of
each device you selected. If you are viewing the real-time video
from an entrance or exit point, you can click ﬁ to open the
barrier.

° : Open a video player and you can search for and view the
recorded videos from the devices you selected.

Reset Reset the layer to its default size and position.

If reserved parking spaces have been configured on the layer, you can
Hide Plate No. hide partial information of the number plates displayed on the
parking spaces.

5.6 Intelligent Analysis

View real-time and history people counting data, heat maps, and number of people in an area.
5.6.1 People Counting

5.6.1.1 Real-time Count

Step1 Login tothe DSS Client. On the Home page, click E > Intelligent Analysis > >
Real-time Count.
Step2 Double-click a group or drag it to a window on the right to display its real-time data.
e Occupancy: The number of people currently inside this group, which will be reset to
the defined value at the defined calibration time.
e Entered: The number of people entered this group, which will be reset to zero at the
defined calibration time.
e Exited: The number of people who left this group, which will be reset to zero at the
defined calibration time.
e (Color of the light:

261



@/hua

User's Manual

o Red light: Occupancy= red light threshold.
o Yellow light: Yellow light threshold< occupancy < red light threshold.
¢ Green light: Occupancy < yellow light threshold.

Figure 5-97 Real-time count

group30
Occupancy 4

Available 14

Entered 1 Exited

Occupancy limitis about to be reached.

Step3  Hover you mouse on the window displaying real-time data, and then click H.
Step4  You can enter a number of people to overwrite the current data, and customize the
content to be displayed for green, yellow and red light.

Figure 5-98 Edit the content and data

“ounting Group Name: umb eople Inside:

Prompt:

Red Light Yellow Light

A B IT U =

Step5 Click OK.
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5.6.1.2 Historical Count

Procedure

Step1 Loginto the DSS Client. On the Home page, click E > Intelligent Analysis > >
Historical Count.

N

Step Select the groups you want in Groups, or select the channels in Resources.
Step Configure the search settings, and then click Search.

w

e Groups: Groups are people counting groups, which allow you to combine and
calculate the people flow data from multiple rules across different devices and
channels. You can search for historical people flow data from one or more people
counting groups.

e Resources: Search for historical people flow data from one or more channels. The data
from all the rules of a channel will be included.

Figure 5-99 Historical people counting data

Daily Report 2021-07-14

People Enter and Exit

1

Numbei
1

r ion =
=] 0 0 0 1200 14 18 c:0

o N Change the display format of the data.
L]

Only weekly report supports will display the number of retention.

Related Operations

e Export: Export the data into a .zip file to your computer.

5.6.2 Heat Maps

View heat maps generated by devices. A heat map shows the distribution of people flow by different
colors, such as red for many people have visited an area and blue for only a few people have visited
an area. The platform supports generating general heat maps and advanced heat maps. Only fisheye
cameras support advanced heat maps.

Configure the channel feature for either type of heat maps. For details, see "3.2.2.5.2 Modifying
Device Information".
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e General heat map: Select the General Heat Map from the channel features.

e Advanced heat map: Select the Advanced Heat Map from the channel features.

Step1 Login to the DSS Client. On the Home page, click FH > Intelligent Analysis > [&].
Step2  Select a channel, and then generate a heat map.

You can generate a heat map with data from up to one week.
e Generate a general heat map.
Configure the time, and then click Search.
e Generate an advanced heat map.
1) Select how you want to generate the heat map, Number of People or Time.
2) Configure the threshold.

e When you select Number of People, the area with the closest number of people to
the threshold will be in red.
e When you select Time, the area where people stay for a duration closest to the
threshold will be in red.
3) Set the time, and then click Search.
Step3  Click Export on the upper-right corner to export the heat map to your PC.

5.6.3 In-area People Counting

View the in-area people number statistics of one or more channels.

Procedure
Step1 Loginto the DSS Client. On the Home page, click E > Intelligent Analysis > E.
Step2 Select a channel and configure the search settings, and then click Search.
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Figure 5-100 In-area people number statistics

Resources Daily Report 2021-07-13

Related Operations
o R Change the display format of the data.
e Export: Export the data to your PC.

5.7 Maintenance Center

You can view the overall running status of the platform, including server, channel, and device. Clear
view of fault information allows you to locate the fault source and type, and then fix it in time. You
can also update the programs of devices.

5.7.1 Viewing System Status

Step1 Login to the DSS Client. On the Home page, click E, and then select Maintenance

Center.

Step2  View system status.

e C(lick Overview to view the overall running status of the platform, including the online
status of channels and devices, storage, server status, and faults. You can export the
current information as a PDF file to your PC, and change the refresh frequency on the
upper-right corner.

e C(lick Channel Status to view the online status, video duration, video integrity, and
more for each channel. Click [&] of a channel and you will be directed to the Fault
page, where you can search for faults related to that channel.

e C(lick Device Status to view the online status, running status, manufacturer, and more
for each device. Click [ of a device and you will be directed to the Fault page, where
you can search for faults related to that device.

e C(lick Server Status to view the information and running status for each server. Click

of a server and you will be directed to the Fault page, where you can search for
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faults related to that server.

e C(Click Disk Status to view the disk status and RAID information of storage devices.

e Click Fault to view faults that occurred with the defined period. You can only search for
faults occurred within 7 days.

Related Operations
e On the left of each page, you can configure the search conditions to only display the content you
want.

e For channel and device status, click to filter what information to be displayed.

e Click Export and follow the onscreen instructions to export information to your PC.

5.7.2 Updating Device Program

Add a plan to update the programs of selected devices in batches.
Step1 Loginto the DSS Client. On the Home page, click E, and then select Maintenance
Center.

Step2  Click [&].
Step3  Click Add.

Figure 5-101 Add an update plan

9 Add Update Plan

Basic Info

a
m

Device Model Program Version Operation

o 0 0O 0 0 0 O ©

Step4  Enter a name for the plan, and then select the device category, type, model, and program
version.
The platform will only display corresponding devices.
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|

You can only update the programs of IPCs and access control devices of Dahua access
protocol and added with an IP address.

Step5  Select the devices you want to update. Click E to cancel selecting all devices.
Step6  Configure when to update the devices.

e Now: Update the devices immediately after the plan is added.
e Custom: Update the devices at the defined time.

Step7 Click Upload File to upload the update program.

A\

e Make sure that the uploaded program matches the models and current program
versions of selected devices.

e Make sure that the network is stable and the power properly connected for all devices.
Otherwise, they might not work properly.

Step8 Click OK.

Related Operations

In the list of update plans, you can view the information of each plan, including name, update
program, update start time, and update status.

Click H to delete a plan one by one; select multiple plans, and then click Delete to delete them

in batches.

Click E} to view the update status of the devices in a plan.

o Click H to remove a device from the plan; select multiple devices, click Delete to remove
them in batches.

o If one or more devices failed to update, click E] to update a device again one by one, or

select multiple devices, and then click Update Again to update them in batches.
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6 General Application

This chapter introduces the general businesses, including target detection, face recognition, and
ANPR.

6.1 Target Detection

View and search for the metadata of people, vehicle, and non-motor vehicle.
[11
Target detection can be done by video metadata cameras + a platform, or IPCs + IVSSs + platform.

6.1.1 Typical Topology

Figure 6-1 Typical topology

o i —
Cable

|DSS

Switch

&

IPC Panoramic + PTZ
Camera

e General cameras record videos.

e Video metadata cameras such as panoramic + PTZ camera record videos and analyze people, and
motor and non-motor vehicles.

e |VSS manages cameras and analyzes people, and motor and non-motor vehicles.

e The platform centrally manages IVSS and cameras, receives analysis results from cameras and
displays the reports.

6.1.2 Preparations

Make sure the following preparations have been completed:

e (Cameras and IVSS are correctly deployed, and video metadata is enabled on them. For details,
see corresponding user’s manuals.

e Basic configurations of the platform have been finished. To configure the parameters, see "3 Basic
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Configurations".
¢ When adding a camera or IVSS, select Encoder for device category.
¢ After adding the camera or IVSS to the platform, select Target Detection from Features of

the device.

6.1.3 Live Target Detection

Step1 Loginto the DSS Client. On the Home page, click Eﬂ and then select Monitoring

Center > Monitor.
Step2  Select a window, double-click the channel or drag the channel to the window.

Figure 6-2 Live view

Resources

L
=
-
e
e

PRIz Eamera

Step3  Click E] and then click E to view live metadata events.
Step4  View live video, and human body, vehicle, and non-motor vehicle information.
e C(Click an event record to view the event snapshot. You can play back the video of the
event. Different events support different operations.

e When playing back video, click to download the video to a designated path.
e Click to play back the video before and after the snapshot.
e C(lick E to delete event information.

e (lick E to view the most recent events.

6.1.4 Searching for Metadata Snapshots

Search for metadata snapshots by setting search criteria or uploading images.
Step1 Login tothe DSS Client. On the Home page, click E, and then select DeepXplore.

step2  Click [@Y
Step Set search criteria.

w N

You can search for metadata snapshots in the Record, Person or Vehicle section. For
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details, see "5.3 DeepXplore".

6.2 ANPR

View automatic number plate recognition in real time or search for records. You can view the
moving track of a vehicle. This is useful for road monitoring.
e Automatic number plate recognition
The platform displays vehicle snapshots and ANPR results in real time.
e Vehicle records
Search for vehicle records according to the filtering conditions you have set.
e Vehicle track
According to the ANPR camera locations that a vehicle has passed through, the platform displays
the driving track of the vehicle on the map.

6.2.1 Typical Topology

Figure 6-3 Typical topology

| Dss

iy g™

Switch

Network
Cable

ITC TC ITC ITC

o ANPR cameras (ITC camera) capture and recognize vehicles.
e DSS centrally manages ANPR cameras, receives and displays vehicle snapshots and information
uploaded from the cameras.

6.2.2 Preparations

Make sure that the following preparations have been made:

e ANPR cameras are added to the platform, and the ANPR function is configured. For details, see
corresponding user’'s manuals.

e Basic configurations of the platform have been finished. To configure, see "3 Basic
Configurations".
o When adding an ITC camera, select ANPR for device category, and then select ANPR Device

for Device Type.

¢ ANPR snapshots are only stored on ANPR Picture disks. On the Storage page, configure at
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least one ANPR Picture disk. Otherwise vehicle pictures cannot be viewed.

6.2.3 Live ANPR

View ANPR live video and plate snapshots.

Step1  Log in to the DSS Client. On the Home page, click FH, and then select Monitor Center >
Monitor.

Step2  Select a window, double-click the channel or drag the channel to the window.

Figure 6-4 Live view

Step3  Click E] and then click EX.
Step4  View live ANPR events.
e C(lick an event record to view event snapshots. You can also play back the video of the
event. Different events support different operations.

e When playing back a video, click to download the video to a designated path.
e Click to play back the video before and after the snapshot.
o C(Click E to delete event information.

e C(lick ﬁ to view the most recent events.

6.2.4 Searching for Vehicle Snapshot Records

Step1 Loginto the DSS Client. On the Home page, click E, and then select DeepXplore.
step2  Click [@Y
Step3  Configure the search conditions.

You can search for vehicle snapshots in the Record or Vehicle section. For details, see "5.3
DeepXplore".

6.3 Face Recognition

Configure face recognition settings on the device and the platform before you can view face
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6.3.1 Typical Topology

The face recognition feature is available on select models of NVR, IVSS and FR cameras.
e Face recognition by NVR/IVSS

Figure 6-5 Typical topology (NVR/IVSS)

Network Cable

DSS NVR/IVSS
v Switch
B M o 0
IPC IPC Speed Speed
Dome Dome

¢ Cameras record videos.
o NVR/IVSS is used for face recognition and storage.

o DSS centrally manages cameras, NVRs, and the face database, and provides live view and face
search.

e Face recognition by camera

Figure 6-6 Typical topology (camera)

——y
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DSS
‘ Switch ‘ |
IPC IPC IPC IPC

o Cameras record face videos, and detect and recognize faces.

o DSS centrally manages cameras, NVRs, and the face database, and provides live view and face
search.

6.3.2 Preparations

Make sure that the following preparations have been made:
e Face recognition devices are correctly configured. For details, see corresponding user’'s manuals.

e Basic configurations of the platform have been finished. To configure, see "3 Basic
Configurations".

¢ When adding face recognition devices, select Encoder for device category.
o After adding a face recognition NVR or IVSS, select Face Recognition for Features of the
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corresponding channels.

¢ After adding face recognition cameras or face detection cameras, select Face Recognition or
Face Detection for Features.

¢ Face snapshots are stored in the Face/Alarm and Other Pictures disk. Configure at least one
local disk for picture storage. Otherwise, the platform cannot display snapshots.

6.3.3 Arming Faces

Before arming faces, you need to add the persons to face recognition group. For details, see "4.4.1
Face Watch List".

6.3.4 Live Face Recognition

Step1  Login to the DSS Client. On the Home page, click FH, and then select Monitor Center >
Monitor.
Step2  Select a window, double-click the channel or drag the channel to the window.

Figure 6-7 Live view

Step3  Click E] and then click E to view live face recognition information.
Step4  View live video, and human body, vehicle, and non-motor vehicle information.
e C(Click an event record to view event snapshots. You can play back the video of the
event. Different events support different operations.

e When playing back video, click to download the video to designated path.
e (lick to play back the video before and after the snapshot.

e Click [ to refresh events; click to pause refreshing.

e Click E to delete event information.

o C(lick ﬁ to view the most recent events.
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6.3.5 Searching for Face Snapshots

Search for face snapshots by setting search criteria or uploading images.

Step1 Loginto the DSS Client. On the Home page, click E, and then select DeepXplore.

step2  Click [@Y
Step3  Configure the search conditions.

You can search for vehicle snapshots in the Record or Person section. For details, see "5.3

DeepXplore".

6.4 POS

View POS live video and records.

Live view

View live POS video and the transaction details overlapped on the video.

Playback

Search for POS transaction records and play the recorded video. The POS video clip can start 10
seconds before or after the POS receipt printing.

6.4.1 Typical Topology

Figure 6-8 Typical topology
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Cameras record videos of each POS transaction.

NVRs are connected with cameras and POS machines, and store videos.

POS machines record transaction details and generate receipts. They connect to the platform
through NVRs.

The platform centrally manages NVRs and cameras, and provides live videos and POS transaction
video records.

6.4.2 Preparations

Make sure that the following preparations have been made:
e Cameras, NVRs and POS machines are correctly configured. For details, see the corresponding
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user’'s manuals.
e Basic configurations of the platform have been finished. To configure, see "3 Basic
Configurations".
¢ When adding an NVR, select Encoder for device category.
o At least one POS channel is connected to NVR.
¢ On the Bind Resource page, bind video channels to the POS channels. See "3.2.3 Binding
Resources".

6.4.3 Setting POS End Sign

Step1 Login to the DSS Client. On the Home page, click EY, and then in the System Config
section, select System Parameter.

Step2  Click the POS End Sign tab.

Step3  Setthe end line of POS receipt.

Step4  Click OK.

6.4.4 POS Live View

View real-time POS transaction video and details.

Make sure that the POS channel has been bound to video channel. For details, see "6.4.4 POS Live

View".

Step1 Login to the DSS Client. On the Home page, click F, and then select Monitor Center >
Monitor.

Step2 Inthe POS list in the Resources section, select a channel, device or organization, double-
click or drag it to the window.

Figure 6-9 POS video

Resources
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| Pca214

Step3  (Optional) Set POS information style.
1) Right-click and select Set POS Style.
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Figure 6-10 POS style setting

POS Style Setting

Cancel

2) Set Overlap Pattern, Font Size, Background Transparency and Font Color.

3) Point to POS information overlay area, press mouse left button and move it to adjust
POS information overlay position.

4) Click OK.

6.4.5 Searching for POS Receipts

Search for POS receipt to view related video of receipt. You can search for the video half an hour
before and half an hour after the time when POS receipt is printed, and you can start to play video 30
s before the time when POS receipt is printed.

Step1 Login to the DSS Client. On the Home page, click FH, and then select DeepXplore.
Step2  Click [E

Step3  Select channel and time, select POS Record, and then click Search.

Step4  Double-click a POS record to view related snapshot and video. For more operations, see

"5.3.1 Searching for Records".
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7 System Configurations

This chapter introduces system parameters configuration, license, service management and backup

and, restore.

7.1 System Deployment

The platform supports managing server information and adjusting the upper-level server of a server
or device.

7.1.1 Distributed Deployment

Set the server type, and assign devices to different servers.
Step1 Login to the DSS Client. On the Home page, click , and then in the System Config
section, select System Deployment.
Step2  Click [&.
Step3  Manage servers.
o Click [@]to view server details.
e C(lick E corresponding to a server to define the server type. A server can be set to
sub server or standby server when it is not in use.
o Click B to enable the server. B means the server is enabled.
e C(lick E to delete the server.

Figure 7-1 Servers
o Refresh 43k

Server Name IP Address Server Status Operation

18I 192.16¢ 192.168. Server = Running ]

= Running

Step4  Assign devices to different servers.
e Manually
Click Allocate Resources, and then select devices or channels on the left side, and drag
them to the server on the right. The number of corresponding devices in the target
server increases, and the devices in the original server reduces.
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o Click Default, the servers are sorted in the order in which they were added.
¢ Click Sort By Device Quantity, the servers will be sorted by the number of devices.

Figure 7-2 Resource allocation

9 Allocate Resources

All Device

e Automatic allocation
Allocate the same type of devices evenly to different servers.
1. Click Auto Distribution.
. Select Device Type. Multiple types are supported.

2
3. Select the server to which the devices belong. Multiple servers can be selected.
4. Click OK.
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Figure 7-3 Auto allocation

.’_', Auto Distribution C} Default 1L Sort By Device Quantity

Auto Distribution

Device Type| | Encoder, ANPR DeviceAccess,

Server Name
192.168.

192.168.

Distribute devices evenly to selected server.

7.1.2 Cascade Deployment

Cascade deployment allows you to add a lower-level platform to an upper-level platform. After
cascading, you can view the live video and recorded video of the lower-level platform from the
upper-level platform. Also, you can display the videos on the lower-level platform on wall from the
upper-level platform. 3 levels can be added at most.

Prerequisites
Make sure that the deployment of all relevant platforms has been completed.
e You need to configure the lower-level platform information on the upper-level platform.
e Supports adding DSS Express to lower-level platform.

Procedure
Step1 Login to client of the upper-level DSS platform. On the Home page, click EY, and then in
the System Config section, select System Deployment.
Step2 Click Bl
Step3  Click Add, and then configure parameters.
Step4  After configuration, click OK.
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Figure 7-4 Add cascade

9 Add Cascade

MName: Organization:

IP Address | Domain:

Username: Password:

Remarks:

Table 7-1 Description of cascade parameters

Parameter Description

Name The name that identifies the platform to be added.

The organization that the added (lower-level) platform belongs to. The
Organization devices and channels of the added platform can be viewed on the upper-
level platform from the organization that you have defined.

IP Address/Domain | The |P address or domain name, and the port of the added (lower-level)
Port platform.

Username The username and password for logging in to the added (lower-level)

Password platform.

7.2 License

The system controls channel and function availability through the license. User can buy a license
according to the channels and functions as needed.

L]
The platform is unlicensed by default after being deployed.

License Types

e Trial
A trial license is limited in capacity and expires in 90 days.

e Paid
To acquire full control of the features and permanent use, you need to buy a formal license. After
activating the first paid license, if you want to increase your license capacity, you can buy more
license codes. For example, if you have 500 channels currently, you can buy another 500
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channels. After activating the new 500 channels, you will have 1,000 channels in total.
e Unlicensed
Lack permissions to use the system. This occurs after deactivating.

I_-._.-_l

For expired trial version and unlicensed version, all modules are displayed as unauthorized, except
for the resources, license, tools, and management modules.

Activation Methods

e Normal online activation
When the platform server is connected to the Internet, it can connect to the license server, which
supports online license activation by verifying the activation code.
e Normal offline activation
When the platform server is on a local area network, it cannot connect to the license server. You
need to obtain the license file from a computer with Internet access, and then import the license
file to the platform to activate it.
e Upgrade from DSS Express to DSS Pro
¢ Online activation
When the platform is upgraded from Express to DSS Pro, and the original Express has a
purchased license, and the platform server has Internet access, you can activate through
verifying the new activation code and Express activation code (or importing Express
deactivation file).
o Offline activation
When the platform is upgraded from Express to DSS Pro, and the original Express has a
purchased license, the platform server cannot visit the license server. You can activate
through verifying the new activation code and Express activation code (or importing Express
deactivation file) and then importing the license obtained from a computer with Internet

access.

7.2.1 Activating License

You can get the desired features or number of channels only after you load the corresponding
license.
For details about activating a license, see "2.1.6.2 Activating License".

7.2.2 Deactivating License

After deactivation, the platform will be unauthorized. A deactivated license can be activated again
on other servers, allowing users to change servers. The license can be deactivated with online and
offline deactivation. If the server is connected to the network, use online deactivation. Otherwise use
offline deactivation.
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e You can only deactivate the license 3 times.
e After you deactivate the license, the system returns to the inactive state.
e Deactivated license can be used again. Keep it properly.

7.2.2.1 Online Deactivation

Background Information
Select this method if your platform sever is connected to a network.

Procedure
Step1 Login to the DSS Client. On the Home page, click EY, and then in the System Config
section, select License.
Step2 Inthe Deactivate License section, click Online Deactivate License.

The license is reusable. We recommend copying the license code by clicking and then
saving it locally.
Step3 Click Deactivate Now, and then follow the onscreen instructions to finish deactivation.

Figure 7-5 Online deactivation

D Deactivate License

7.2.2.2 Offline Deactivation

Background Information

Select this method if your platform server has no Internet access.

Procedure
Step1 Login to the DSS Client. On the Home page, click EY, and then in the System Config
section, select License.
Step2 Inthe Deactivate License section, click Offline Deactivate License.

282



@hua .
TechNoLoaY User's Manual

Figure 7-6 Offline deactivation

9 Deactivate License

Step3  Click Export to export and save the license deactivation file locally.

A

After the license deactivation file is exported, the platform will become unauthorized, and
you cannot use any function.

Step4  Move the request file to a computer with Internet access. On that computer, open the
system email that contains your license, and then click the attached URL go to the license
management page.

Step5 Select DSS > Deactivate License.

Step6 Upload the license request file obtained from Step3, and then follow on-screen
instructions to finish the process.

7.3 System Parameters

Configure security parameters, storage retention duration, email server, time sync, remote log, login
method, and more.

7.3.1 Configuring Security Parameters

e HTTPS (Hyper Text Transfer Protocol over Secure Socket Layer) is a safe HTTP transmission
protocol. It is safe and stable, and guarantees the security of user information and devices. When
HTTPS certificate is configured, you can log in to the platform through HTTPS protocol to ensure
transmission security.

e Protect your data by verifying login password when download or export information, and
encrypting the export files.

o After the firewall of the server is enabled, you need to add the IP address of the computer where
the DSS Client is installed to the HTTP allowlist so that it can access the server.

o After the firewall of the server is enabled, only the IP addresses in the RSTP allowlist can request
video stream through the media gateway service. The IP addresses of decoders will be added
automatically. If there are other IP addresses that need to request video stream through media
gateway service, you need to manually add them to the RSTP allowlist.

Step1 Login to the DSS Client. On the Home page, click £Y, and then in the System Config

section, select System Parameter > Security Parameter.

Step2 Click E] to upload the SSL certificate and private key, and then click Save.
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Step 3

Step 4

Enable File Export or Download Password Authentication and Encrypt Exported File,

and then click Save.

o File Export or Download Password Authentication:
¢ You need to enter the password of the current account to export or download files.
o For all users that log in to the platform, they do not need to enter the password

when exporting or downloading files.

e Encrypt Exported File: When you use the exported file, you need to verify the
password.

Add IP addresses to the HTTP and RSTP allowlist.

7.3.2 Configuring Retention Period of System Data

Set the retention periods for logs, alarm messages, face recognition records, vehicle passing records,

access snapshot records, video communication records, visitor records, POS messages, and more.

Records beyond the defined retention period will be automatically deleted.

tep 1

:

U [N
~+ |+
FF
w N

Log in to the DSS Client. On the Home page, click EY, and then in the System Config
section, select System Parameter.

Click Message Retention Period.

Double-click a number to change its value.

Click Save.

7.3.3 Time Synchronization

Synchronize the system time of all connected devices, PC client, and the server. Otherwise the

system might malfunction. For example, video search might fail. The platform supports

synchronizing the time of multiple devices, which have the same time zone as the platform. You can

synchronize the time manually or automatically.

Step 1

Step 2

Log in to the DSS Client. On the Home page, click EY, and then in the System Config
section, select System Parameter.
Click the Time Sync tab. Enable the sync methods, and then set parameters.
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Figure 7-7 Enable time synchronization

Time Sync

Start Time:

nes Online:

Sync Time Now

e Scheduled Time Sync: Enable the function, enter the start time in time sync for each
day, and the interval.
e Sync Time When Device Comes Online: Syncs device time when the device goes online.
e NTP Time Sync: If there is an NTP server in the system, you can enable this function to
let the system enable time with the NTP server.
Step3  Click Save.
Step4  (Optional) Enable time synchronization on DSS Client.
1) Log in to the DSS Client, and then in the Management section, click Local Settings.
2) Click the General tab, select the check box next to Time Sync, and then click Save.
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The system immediately synchronizes the time after you restart the client to keep the
time of the server and the PC client the same.

Figure 7-8 Enable time sync

General

Display

Default Client Size

e in client and ew

d Channel

. Display humbnails whe| Ver r channels on the device tree

Start and Login

3) Restart the client for the configuration to take effect.

7.3.4 Configuring Email Server

Step1 Login to the DSS Client. On the Home page, click EY, and then in the System Config
section, select System Parameter.
Step2 Click the Email Server tab, enable Email Server, and then configure parameters as

required.
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Figure 7-9 Set email server

Email Server —®

Sender Email Address:

Encryption Method:
TLS

Test Recipient:

Email Test

Table 7-2 Description of email server parameters

Parameter Description

SMTPServerType | e Vahoo, Gl Hotmal and Userpefined.
Sender Email Address The sender displayed when an email is sent from DSS.

SMTP Server

Password IP address, password, and port number of the SMTP server.

Port

Encryption Method Supports no encryption, TLS encryption, and SSL encryption.
Test Recipient Set the recipient, and then click Email Test to test whether the
Email Test mailbox is available.

Step3  Click Save.

7.3.5 Configuring Device Login Mode

To ensure that you can use the device safely, we recommend using the security mode (if the device

supports this mode. Otherwise, select compatibility mode).

Step1 Login to the DSS Client. On the Home page, click EY, and then in the System Config
section, select System Parameter.

Step2  Click the Login Mode tab.

Step3  Selecta mode.
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Figure 7-10 Select a login mode

Login Mode

®) Security Mode Compatibility Mode

@ After Compatibility Mode is enabled, there might be security risks.

If security mode is supported, it is recommended to login to the in this mode.

Step4  Click Save.

7.3.6 Customizing POS End Sign

Configure the sign that prompts the end of a POS receipt.

Step1 Login to the DSS Client. On the Home page, click EY, and then in the System Config
section, select System Parameter.

Step2  Click the POS End Sign tab.

Step3  Enter the POS end sign, and then click OK.

Figure 7-11 POS end sign
POS End Sign

POS End Sign:

| Thank You!

7.3.7 Remote Log

To ensure safe use of the platform, the system sends administrator and operator logs to the log

server for backup at 3 A.M. every day.

Step1 Login to the DSS Client. On the Home page, click EY, and then in the System Config
section, select System Parameter.

Step2  Click the Remote Log tab.

(O8]

Step Enable the function, and then set parameters as required.
The Platform No. must be the same on the remote server and the platform.
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Figure 7-12 Enable remote log

Remote Log —®

IP Address:
127.0.0.1

Platform No.:

2

Step4  Click Save.

7.3.8 Configuring Active Directory

When domain is deployed, and domain users are DSS platform users, you can import users quickly
with this function.

Step1 Login to the DSS Client. On the Home page, click EY, and then in the System Config
section, select System Parameter.

Click the Active Directory tab.

Click - to enable the function, and then configure the parameters.

N
—~+ |
FF
w N

1) Enter domain information, including domain name, IP address, port, username, and
password, and then click Get DN to automatically get basic DN information.

2) Click Test to check whether the domain information works.

3) Click Save.
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Figure 7-13 Active directory

Active Directory  —®

SSL Private Key:

Domain Name:

HOOOC0O0LCom

Password:

DC =, DC =3

Get DN

Step4 Import domain users.
1) Log in to the DSS Client. On the Home page, click EY, and then in the Basic Config
section, select User.
2) Click the User tab.
3) Click Import Domain User.

4) Select the users to be imported, or search for and select the users, and then click Next
Step.

5) Select role, and set permissions for the users.

6) Click OK.
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Figure 7-14 Add domain users

+ Add Flp Userl Q) Sync Domain User

Import Domain User

1. Import domain users ? 1. Import domain users | 2

Domain User Username

7.3.9 Configuring Independent Database

The platform supports connecting to an independent database and storing data in it, including face
images, video metadata, events, and ANPR information. But when you search for related data, the
data in both the independent database and the platform database will be searched. Only official
licenses support this function.

Prerequisites

You have prepared a ready-to-run database.

Procedure

Step1  Log in to the DSS Client. On the Home page, click Y, and then in the System Config
section, select System Parameter.

N

Step Click the Independent Database Deployment tab.

w

Step Click - to enable the function, and then configure the parameters.
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Figure 7-15 Configure the independent database

Independent Database Deployment —@

IP Address:

Username:

Table 7-3 Parameter description

Parameter Description

Database Type Only supports MySQL.

IP Address Enter the IP address of the database.

Port Enter the port of the database.

Username/Password Enter the username and password used to log in to the database.

Step4  Click Save.

|

An independent database can only connect to one platform.

7.4 Backup and Restore

The platform supports backing up configuration information and saving it to a computer or server,
so that you can use the backup file for restoring settings.

7.4.1 System Backup

Use the data backup function to ensure the security of user information. Data can be manually or
automatically backed up.
e Manual backup: Manually back up the data, and the DSS platform will save it locally.
e Automatic backup: The DSS platform automatically backs up the data at a defined time, and
saves it to the installation path of the platform server.
Step1 Login to the DSS Client. On the Home page, click EY, and then in the System Config
section, select Backup and Restore.

N

Step Click the Backup tab.

w

Step Back up data.
e Manual backup: In the Manual Backup section, select the data saving path, click

292



@hua .
TechNoLoaY User's Manual

Backup Now. The Login Password is the same as the system user's. Create an
Encryption Password to protect data.

Figure 7-16 Manual backup

Auto Backup

Jackup Files:

Backup Confirmation

Time:

0
Confirm Encryption
Manual Backup

Backup Path:

e Auto backup: In the Auto Backup section, configure backup parameters, and then click

Desktop
Cancel

OK. The Login Password is the same as the system user's. Create an Encryption
Password to protect the data. The platform automatically backs up data according to
the defined time and period. The backup path is the installation path of the platform
server by default.
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Max Number of Backup Files means you can only save defined number of backup files
in the backup path.

Figure 7-17 Auto backup

Auto Backup

Backup Confirmation

Encryptiol

Manual Backup Confirm Encryptic

Backup P;

ent/BackupCfgFiles

7.4.2 System Restore

Restore the data of the most recent backup when the database becomes abnormal. It can quickly
restore your DSS system and reduce loss.

e | ocal Restore: Import the backup file locally.

e Server Restore: Select the backup file from the server.

A\

e Stop users from using the platform before performing system restore.
e Restoring the system will change system data. Please be advised.
Step1 Login tothe DSS Client. On the Home page, click , and then in the System Config

section, select Backup and Restore.

N

Step Click the Restore tab.

w

Step3  Restore data.

e Restore from local backup file: In the Restore from Local Backup File section, select
the backup file path, click Restore Now, and then enter the passwords (the Password
is the same as the system user's. The Encryption Password is the one created when
the file was backed up).
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Figure 7-18 Local restore

|£Lntal Restore

Restore from Local Backup File

d cance

e Restore from backup file on the server: In the Restore from Backup File on the Server

section, click , enter the passwords (the Password is the same as the system user's.
The Encryption Password is the one created when the file was backed up), and then
click OK. After restoration, the platform will automatically restart.

Figure 7-19 Restore from backup files on the server

Restore from Backup File on the Server

Backup Time File Size(kb) Operation

2021-04-10 15:00:29 577.74 =&

Restore from Local Backup File

to enter the correspondi rd to restore the

You can click to download the backup file.
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8 Management

8.1 Managing Logs

View and export operator logs, device logs and system logs, and enable the service log debug mode
for troubleshooting.

8.1.1 Operator Log

Step1 Login to the DSS Client. On the Home page, select Management > Logs.
Step2  Click [Bl
Step3  Click [3 select one or more types of log you want to search for, specify the time and
keywords, and then click Search.
Step4  To export the logs, click Export.
8.1.2 Device Log
Step1 Login to the DSS Client. On the Home page, select Management > Logs.
Step2  Click [BM.
Step3  Select a device and time, and then click Search.
Step4  To export the logs, click Export.
8.1.3 System Log
Step1 Login to the DSS Client. On the Home page, select Management > Logs.

Click [E3.

Click :] and then select one or more types of logs you want to search for.

wnv N
~+ |+
D |D

Configure the time and enter keywords, and then click Search.

%)

—+
F

IS

(Optional) Click Export.

(%]

—+
F

[0}

Follow the onscreen instruction to export logs to your computer.

8.1.4 Service Log Debug

Enable the debug mode of a service, and then it generates logs that are more detailed for
troubleshooting.

Step1 Loginto the DSS Client. On the Home page, select Management > Logs.
Step2 Click (B

Step3  Enable the debug mode of one or more services.
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After the debug mode of a service is enabled, the service will generate a large amount of
logs that occupy more disk space. We recommend you disable the debug mode after you
have finish troubleshooting.

8.2 Downloading Videos

You can download videos stored on the server or the device. They can be saved in are in .avi, . mp4,

or .asf formats. Three ways to download videos are:

e Download a portion of a video by selecting a duration on the timeline.

e Download videos by files. The system will generate files every 30 minutes from the time the video
starts. If the video does not start on the hour or the half hour, the first file will start from the

earliest start time to the half hour or the hour. For example, if a video starts from 4:15, the first file
will be from 4:15 to 4:30.
e Download a period before and after a tag.

Step 1
Step
Step

w N

Step 4

Step 5

Log in to the DSS Client. On the Home page, select Management > Download Center.
Configure the search conditions, and then click Search.
Download videos.

[

You need to verify your password by default before download. You can configure whether

to verify the password. For details, see "7.3.1 Configuring Security Parameters".

e Download a video by selecting a duration on the timeline.
Click the Timeline tab, and then select a period on the timeline.
You can also click Select All on the upper-left corner, and then you can select and
download the same period of all videos at the same time.

e Download a video by file.
Click the File tab, and then click g of afile.
You can also select multiple files, and then click Download Selected File on the upper-
left corner to download them at the same time.

e Download a period of a video before and after a tag.
Click the Tag tab, click g of the file you want to download.
You can also select multiple tags, and then click Download Selected Tagged File to
configure and download them at the same time.

(Optional) Click S, select the format of the video, and then click OK.

e Timeline: You can further adjust the start and end time of the duration.

e File: If you download multiple files at the same time, you cannot configure the formats
of the videos you want to save.

e Tag: You can configure how many seconds or minutes before and after the tag you
want to download.

(@2l
After download, you can click E to delete the tag.

When downloading clipped videos, in the Download Recorded Video dialogue box,
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confirm the time span, and then, if necessary, click [l to select a video format. Click OK.

Related Operations

e You can pause, resume, and delete a download task.

Figure 8-1 Download progress

e After download completes, click to go to the path where the video is saved to, or click E]
in the prompt on the upper-right corner to play the video directly in Local Video. For details, see
"8.4 Playing Local Videos".

8.3 Configuring Local Settings

After logging in to the client for the first time, you need to configure the following fields under
system parameters: Basic settings, video parameters, record playback, snapshot, recording, alarm,
video wall, security settings and shortcut keys.

8.3.1 Configuring General Settings

Configure client language, client size, time, and more.
Step1 Login to the DSS Client. On the Home page, select Management > Local Settings.
Step2 Click General, and then configure the parameters.
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General

Display

Figure 8-2 General parameters

Display time zone in client and event records

Node Info Display

e and Channel

Display

humbnai channels on the

Start and Login

Auto run at startup

Auto Login

CPU Alarm Threshold

CPU Alarm Threshold

Table 8-1 Parameter description

Parameters

Description

Default Client Size

Select a proper resolution for the client according to PC display screen.

Display time zone in
client and event
records

When selected, the client and the time of alarms will show both the
time and time zone.

Device Node Info
Display

Select that the device tree displays devices and their channels or only
channels.

Display live view
thumbnails when
hovering over
channels on the device
tree

When selected, you can hover the mouse over a channel in the device
tree in Monitoring Center and a snapshot of its live video image will
be displayed.
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Parameters Description

If enabled, the client starts to synchronize network time with the server

Time Sync . L
! y to complete time synchronization.

o |f Remember Password has been selected on the Login page,
select Auto restart after reboot, and the system will skip the login
page and directly open the homepage after you restart the PC next

Auto run at startup time.

e If Remember Password is not selected on the Login page, select
Auto restart after reboot, the client login page will appear after
you restart the PC.

Enable the system to skip the login page and directly open the
homepage when logging in next time.

e |f Remember Password and Auto Login have been selected on
the Login page, the function is already enabled.

o |f Remember Password has been selected while Auto Login is not

Auto Login selected on the Login page, select Auto Login on the Basic page
to enable this function.

e [f neither Remember Password nor Auto Login has been selected
on the Login page, select Auto Login on the Basic page and you
then to enter the password when logging in next time to enable
the function.

The user will be asked to confirm whether to open one more video

CPU Alarm Threshold when the CPU usage exceeds the defined threshold.

Audio and video
transmission Encrypt all audio and video to ensure information security.
encryption

The client will be locked after the defined period and you cannot
perform any operation. Click Click to Unlock Client and verify the
password of the current account to unlock the client.

You can configure up to 60 minutes.

Auto Lock Client

Self-adaptive audio If enabled, the system automatically adapts to the device sampling
talk parameters frequency, sampling bit, and audio format for audio talk.

Step3  Click Save.

8.3.2 Configuring Video Settings

Configure window split, display mode, stream type and play mode of live view, and instant playback
length.

Step1 Loginto the DSS Client. On the Home page, select Management > Local Settings.
Step2 Click Video, and then configure the parameters.
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Figure 8-3 Video parameters

Live View

Switching Rule

Double-click on t aximize h to main stream

Play

Display the previ r restart

Clo being played after a long 1 of inactivity

Table 8-2 Parameter description

Parameters Description
Default Window Split Set split mode of the video window.
Window Display Scale Select from Original Scale and Full Screen.

stream type.

When the number of window splits is greater than the defined
Stream Switching Rule value, the live video will switch from the main stream type to sub

Acquisition Mode

clients by the platform.

Select the one according to your situation. If you select Acquire
directly from the device, clients will acquire video streams
directly from the channel. If direct acquisition fails, the platform
will forward the video streams to clients.

Real-time Stream When the device and clients are properly connected to the
network, direct acquisition can reduce the use of the platform's
forwarding bandwidth. If too many clients are acquiring video
streams from a channel, acquisition might fail due to insufficient
performance of the device. Video streams will be forwarded to

Double-click on the video to
maximize the window and

switch to main stream
to sub stream.

If selected, you can double-click a video window to maximize it
and switch from sub stream to main stream. Double-click again to
restore the window size, and then the system will switch it back
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Parameters Description

e Real-time Priority

The system might lower the image quality to avoid video lag.
® Fluency Priority
The system might lower the image quality and allow for lag
to ensure video fluency. The higher the image quality, the
lower the video fluency will be.
Play Mode e Balance Priority
The system balances real-time priority and fluency priority
according to the actual server and network performance.
e Custom
The system adjusts video buffering and lowers the impact on
video quality caused by unstable network. The bigger the
value, the more stable the video quality will be.

Decoding Mode e Software Decoding by CPU: All videos will be decoded by

the CPU. When you are viewing live videos from large
amount of channels, it will take up too much resources of the
CPU that affects other functions.

e Software Decoding by GPU: All videos will be decoded by
the GPU. The GPU is better at concurrent operation than the

CPU Threshold CPU. This configuration will free up resources of the CPU
significantly.

e Performance Mode (CPU First): All videos will be decoded
by the CPU first. When the resources of the CPU is taken up to

the defined threshold, the platform will use the GPU to
decode videos.

Display previous live view If selected, the system displays the last live view automatically
after restart after you restart the client.

Close videos being played

'after‘lo.ng period of The system closes live view automatically after inactivity for a pre-
Inactivity defined period of time. Supports up to 30 minutes.

Inactivity Time

Click [2] on the live view page to play the video of the previous
period. The period can be user-defined. For example, if you set 30
seconds, the system will play the video of the previous 30
seconds.

Instant Playback Time

Select a default stream type when you play back recordings from

a device.
Search Type of Device Video I-!-!-l
Stream If Only Sub Stream 2 is selected, but the device does not

support sub stream 2, then recordings of sub stream 1 will be
played.
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Parameters Description

If selected, when the playback stream is big due to high

Extract frames when playing definition, certain frames will be skipped to guarantee fluency

back HD videos and lower the pressure on decoding, bandwidth and forwarding.
Continuous Snapshot Set the number and interval between each snapshot.
Interval For example, if the Continuous Snapshot Interval is 10 seconds

and the Number of Continuous Snapshots is 4, when you right-
click on the live/playback video and select Snapshot, 4 images
will be taken every 10 seconds.

Number of Continuous
Snapshots

Step3  Click Save.

8.3.3 Configuring Video Wall Settings

Configure the default binding mode and stream type of video wall.
Step1 Login to the DSS Client. On the Home page, select Management > Local Settings.
Step2 Click Video Wall, and then configure the parameters.

Figure 8-4 Configure video wall settings

Video Wall

Double-click on the video to maximize the window and switch to main stream

Video Source Play Duration

15

Maode of Video Decoding to Wall

Tour

Table 8-3 Parameter description

Parameter Description

Default Stream Select Main Stream, Sub Stream 1, Sub Stream 2 or Local Signal as the
Type default stream type for video wall display.

Stream When the number of window splits is greater than the defined value, the live
Switching Rule video will switch from the main stream type to sub stream type.
Double-click on

the video to

maximize the Double-click the video to maximize the window, and then its stream type
window and will switch to main stream.

switch to main

stream
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Parameter

Description

Video Source

Set the default time interval between the channels for tour display.
For example, if 5 seconds is configured and you are touring 3 video

Decoding to Wall

Play Duration channels, the live video image of each channel will be played 5 seconds
before switching to the next channel.
e Tour: Multiple video channels switch to decode in one window by
. default.
Mode of Video

e Tile: Video channels are displayed in the windows by tile by default.

e Ask Every Time: When dragging a channel to the window, the system
will ask you to select tour or tile mode.

Step3  Click Save.

8.3.4 Configuring Alarm Settings

Configure alarm sound and alarm display method on the client.

Step1 Login to the DSS Client. On the Home page, select Management > Local Settings.

Step2  Click Alarm, and then configure the parameters.

Figure 8-5 Configure alarm settings

Alarm Sound

® Default Custom

All Event Source Types

Mode of Opening Alarm Linkage Videos

. Open alarm lin o when alarm occurs

Map Flashes

. Device on the map fla /hen alarm occurs

Alarm Type

Table 8-4 Parameter description

Parameters Description
Default All types of alarms will use the same default alarm sound when triggered.
Click Modify Alarm Sound, and then you can change the alarm sound and
Custom .
its play mode of each type of alarm.
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when alarm occurs

Open Alarm
Linkage Video

Parameters Description
Open alarm If selected, the platform will automatically open linked video(s) when an
linkage video alarm occurs.

e As Pop Up: The alarm video will be played in a pop-up window.
e Openin Live View: The alarm video will be played in a window in

Monitoring Center.

[

For this function to work properly, you must enable When an alarm is
triggered, display camera live view on client when configuring an
event. For details, see "4.1 Configuring Events".

Device on the map
flashes when
alarm occurs

Set one or more alarm types for alarm notification on the map. When an
alarm occurs, the corresponding device will flash on the map.

Step3  Click Save.

8.3.5 Configure File Storage Settings

Configure the storage path, naming rule, file size, and format of recordings and snapshots.

Step1 Login tothe DSS Client. On the Home page, select Management > Local Settings.

Step2 Click File Storage, and then configure the parameters.
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Figure 8-6 Configure file storage settings

File Storage

Video Storage

Video Naming Rule

Time_Channel No.

Video Stora;

C:\Users\Public\D55 Client\Record',
Video File Size

1024

Image Storage

Image Format

age Path

WPublic\D55 Client\Picture,

Table 8-5 Parameter description

Parameters Description

\R/:Jdlgo Naming Select a naming rule for manual recordings.

Video Storage Set a storage path of manual recordings during live view or playback. The
Path default path is C:\Users\Public\DSS Client\Record.

Video File Size Configure the maximum size of a single recording file.

Image Format

Select a format for snapshots.

Image Naming
Rule

Select a naming rule for snapshots.

Image Storage
Path

Set a storage path for snapshots. The default path is C:\Users\Public\DSS
Client\Picture.

Step3  Click Save.

8.3.6 Viewing Shortcut Keys

View shortcut keys for operating the client quickly.

Step1 Login to the DSS Client. On the Home page, select Management > Local Settings.
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Step2  Click Shortcut Key to view shortcut keys of the PC keyboard and USB joystick.

Figure 8-7 View shortcut keys

Shortcut Keys

Joystick USB Keyboard

Function Shortcut Keys

Move Up

Insert

Delete

Home

End

PgUp

PgDn

Enter

Enter

Ctri+F

Esc

Ctri+T

Lock Client Ctri+L

8.4 Playing Local Videos

You can play local videos directly on the platform.
Step1 Login to the DSS Client. On the Home page, select Management > Local Video.

Figure 8-8 Local video

Step2 Click @ to select one or more files, or m to open all files in a folder.
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Figure 8-9 Play list

Step3  Drag afile to the window on the right or right click it to play.

Related Operations

Table 8-6 Interface operation

Icon/Function

Description

Right-click menu

e Continuous Snapshot: Take snapshots of the current image (three
snapshots each time by default). The snapshots are saved
to ..\DSS\DSS Client\Picture by default. To change the snapshot saving
path, see "8.3.5 Configure File Storage Settings".

e Video Adjustment: Adjust the brightness, contrast, saturation, and
chroma of the video for video enhancement.

e Digital Zoom: Click it, and then double-click the video image to
zoom in the image. Double-click the image again to exit zooming in.

Close all playing videos.

Split the window into multiple ones and play a video in full screen.

Take a snapshot of the current image and save it locally. The path is

[ C:\DSS\DSS Client\Picture\ by default.

E Close the window.

[ Stop/pause the video.

Fast/slow playback. Max. supports 64X or 1/64X.

a

al

Frame by frame playback/frame by frame backward.

5

Capture the target in the playback window. Click to select the
search method, and then the system goes to the page with search results.
More operations:

e &¥: Move the selection area.
° ﬁ: Adjust the size of the selection area.
e Right-click to exit search by snapshot.

8.5 Quick Commands

Customize HTTP commands and execute them quickly. Request methods of GET, POST, PUT and

DELETE are supported.

Step1 Login to the DSS Client. On the Home page, select Management > Quick Commands.
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Figure 8-10 Quick commands

£ Quick Command Config

1

Step2 Click B
Step3  Click Add.

Figure 8-11 Add a quick command

Quick Command Config

9 Add Quick Command

“ommand Name:

Request Method:

GET

HTTP URL:

http://ad

Cancel

Step4  Configure the parameters, and then click OK.
Figure 8-12 Execute a quick command
€ Quick Command Config

1

Step5  Click the name of a quick command to execute it.
If successful, a prompt message will appear at the upper-right corner.
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Appendix 1 Service Module Introduction

Appendix Table 1-1 Service module introduction

Service Name Function Description
Access Service NGINX Reverses user reqL{ests to distributed system
management services.
System . . .
Management SMC Manages services and provides access to various
. pages.
Service
Device Discovery HRS Broadcasts platform information to discover
Service devices.
Data Cache Service | REDIS Stored temporary business data from the
platform.
Database MySQL Stores platform business data.
Mes;age Queue MQ Transfers messages between platforms.
Service
Configuration Manages disks, such as read-and-write
. CFGS :
Service operations.
Alarm Dispatch Sends alarm information to different objects
. ADS . '
Service according to defined plans.
Media Transmission Gets audio/video bit streams from front-end
. MTS devices and then transfers the data to DSS, the
Service .
client and decoders.
Media Gateway MGW Sends MTS address to decoders.
Storage Service SS Stores, searches for and plays back recordings.
Object Storage 0SS Manages storage of face snapshots and
Service intelligent alarm pictures.
Object Storage Mainly manages storage evidence recordings
. SubOSS .
Service and pictures.
Plctgre Transfer PTS Manages picture transmission.
Service
File Resource Node .
Management FNODE Man‘ages the file resource node management
. service.
Service
File Resources FILERESOURCE Manag.es files from MPT devices and related
Node Service operations.
Dew;e Search SOSO Searches for device information.
Service
Device . .
Registers encoders, receives alarms, transfers
Management DMS .
. alarms, and sends out the sync time command.
Service
Auto Register Listens, logs in, or gets bit streams to send to
. ARS
Service MTS.
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Service Name

Function Description

ProxyList control

Logs in to ONVIF device, and then gets the

Proxy Service PCPS stream and transfers the data to MTS.
Access Control Manages access control and other related

. ACDG .
Service operations.
Access Con'FroIIer MCDDOOR Manag'es access controller access and related
Access Service operations.
External LED Device Manages LED access and other related

. MCDLED :

Access Service operations.
External Alarm
Controller Access MCDALARM Manages aIarm controller access and other

. related operations.
Service
Power Environment PES Manages access of dynamic environment
Server monitoring devices.
Video Matrix VMS Logs in to the decoder and sends tasks to the
Service decoder to output on the TV wall.
Video Intercom SC Manages PC client and App client login as SIP
Switch Center client, and also forwards audio-talk streams.
DeVIF e Update UPDATE Updates devices.
Service
Group Talk Service POC Manages the group talk functions and related

devices.
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Appendix 2 Cybersecurity Recommendations

Security Statement

If you connect the product to the Internet, you need to bear the risks, including but not limited to
the possibility of network attacks, hacker attacks, virus infections, etc., please strengthen the
protection of the network, platform data and personal information, and take the necessary
measures to ensure the cyber security of platform, including but not limited to use complex
passwords, regularly change passwords, and timely update platform products to the latest
version, etc. Dahua does not assume any responsibility for the product abnormality, information
leakage and other problems caused by this, but will provide product-related security
maintenance.

Where applicable laws are not expressly prohibited, for any profit, income, sales loss, data loss
caused by the use or inability to use this product or service, or the cost, property damage,
personal injury, service interruption, business information loss of purchasing alternative goods or
services, or any special, direct, indirect, incidental, economic, covering, punitive, special or
ancillary damage, regardless of the theory of liability (contract, tort, negligence, or other) , Dahua
and its employees, licensors or affiliates are not liable for compensation, even if they have been
notified of the possibility of such damage. Some jurisdictions do not allow limitation of liability
for personal injury, incidental or consequential damages, etc., so this limitation may not apply to
you.

Dahua's total liability for all your damages (except for the case of personal injury or death due to
the company's negligence, subject to applicable laws and regulations) shall not exceed the price
you paid for the products.

Security Recommendations

The necessary measures to ensure the basic cyber security of the platform:

1.

Use Strong Passwords

Please refer to the following suggestions to set passwords:

e The length should not be less than 8 characters.

e Include at least two types of characters; character types include upper and lower case letters,
numbers and symbols.

e Do not contain the account name or the account name in reverse order.

e Do not use continuous characters, such as 123, abc, etc.

e Do not use overlapped characters, such as 111, aaa, etc.

Customize the Answer to the Security Question

The security question setting should ensure the difference of answers, choose different questions
and customize different answers (all questions are prohibited from being set to the same answer)
to reduce the risk of security question being guessed or cracked.

Recommendation measures to enhance platform cyber security:

1.

Enable Account Binding IP/MAC
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It is recommended to enable the account binding IP/MAC mechanism, and configure the IP/MAC
of the terminal where the commonly used client is located as an allowlist to further improve
access security.
2. Change Passwords Regularly
We suggest that you change passwords regularly to reduce the risk of being guessed or cracked.
3. Turn On Account Lock Mechanism
The account lock function is enabled by default at the factory, and it is recommended to keep it
on to protect the security of your account. After the attacker has failed multiple password
attempts, the corresponding account and source IP will be locked.
4. Reasonable Allocation of Accounts and Permissions
According to business and management needs, reasonably add new users, and reasonably
allocate a minimum set of permissions for them.
5. Close Non-essential Services and Restrict the Open Form of Essential Services
If not needed, it is recommended to turn off NetBIOS (port 137, 138, 139), SMB (port 445), remote
desktop (port 3389) and other services under Windows, and Telnet (port 23) and SSH (port 22)
under Linux. At the same time, close the database port to the outside or only open to a specific IP
address, such as MySQL (port 3306), to reduce the risks faced by the platform.
6. Patch the Operating System/Third Party Components
It is recommended to regularly detect security vulnerabilities in the operating system and third-
party components, and apply official patches in time.
7. Security Audit
e Check online users: It is recommended to check online users irregularly to identify whether
there areillegal users logging in.
e View the platform log: By viewing the log, you can get the IP information of the attempt to
log in to the platform and the key operation information of the logged-in user.
8. The Establishment of a secure Network Environment
In order to better protect the security of the platform and reduce cyber security risks, it is
recommended that:
e Follow the principle of minimization, restrict the ports that the platform maps externally by
firewalls or routers, and only map ports that are necessary for services.
e Based on actual network requirements, separate networks: if there is no communication
requirement between the two subnets, it is recommended to use VLAN, gatekeeper, etc. to
divide the network to achieve the effect of network isolation.

More information

Please visit Dahua official website security emergency response center for security announcements
and the latest security recommendations.
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